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In This Manual
This document is the self-paced training manual to help you to understand what is Agilent 
B1500A, what functions the B1500A has, how to use the B1500A, and what applications 
the B1500A contributes to.

CAUTION The test setup data described in this manual are only examples. If these example data 
damage your devices, Agilent is NOT LIABLE for the damage.

• Module 1. Introduction 

This module explains the product concept and the key features of the B1500A/ 
EasyEXPERT. You will learn about what is the B1500A.

• Module 2. Getting Started

This module explains the basic operations of the B1500A. You will learn about how to 
launch B1500A/EasyEXPERT and how to perform application test and quick test.

• Module 3. Data Display and Management

This module explains the data display and analysis capabilities of the EasyEXPERT 
software. You will learn how to use analysis tools, how to change display setup, and 
how to print/export test result data.

• Module 4. Classic Test Environment

This module explains the classic test mode of the EasyEXPERT. You will learn how to 
create the classic test setup in the course exercises.

• Module 5. Basic Measurement 

This module explains the basic I-V sweep measurement function and the cabling and 
fixturing issues. You will learn how to measure I-V curves in the course exercises.

• Module 6. Low Current Measurement 

This module explains the low current measurement technique. You will learn how to 
measure the low current in the course exercises.

• Module 7. Measurement Functions

This module explains the measurement functions available with the B1500A. You will 
learn how to use various measurement functions in the course exercises.

• Module 8. Capacitance Measurement

This module explains the capacitance measurement function. You will learn how to 
measure the capacitance in a course exercise.

• Module 9. Modifying Application Test Definitions

This module explains a modification example of an application test definition. You will 
learn how to modify the definition in a course exercise.

• Module 10. Creating Your Test Definitions

This module explains about the application test definition. You will learn how to create 
your application test definition in a course exercise.



• Module 11. Advanced Definitions and Operations

This module explains how to control external GPIB devices, how to call an execution 
file, how to perform a repeat measurement, and how to use the prober control script.

• Module 12. Miscellaneous Operations

This module explains what is the status indicator, what is the automatic data export 
function and the automatic data record function, how to perform selftest and 
calibration, how to perform SMU zero offset cancel, and such.

EasyEXPERT is a trademark of Agilent Technologies. All other trademarks are the 
property of their respective owners.



Class Exercises 
Class exercises use the test setup listed below. The test setup data are only examples and 
included in the Demo.xpg file stored in the Manual CD-ROM.

Module Exercise Device Test setup/definition/data Page 

Module 1 no exercise

Module 2 Id-Vd measurement MOSFET CMOS: Id-Vd 2-19, 27

Id-Vg, gm-Vg measurement MOSFET CMOS: Vth gmMax 2-19, 27

B2200 switch control - - 2-32

Module 3 Id-Vg, gm-Vg measurement MOSFET GMMAX.xtr 3-28

Using Preview window - - 3-31

Module 4 Id-Vd measurement MOSFET Trng Id-Vd 4-25

Multi Channel I/V Sweep 
Measurement

Bipolar Tr 
LED

Trng Multi 4-37

I/V List Sweep Measurement MOSFET Trng List 4-51

I/V-t sampling measurement 0.1 μF Trng Sampilng 4-64

C-V sweep measurement MOSFET Trng CV 4-76

B2200 switch control - Trng Switch 4-81

Direct Control (C-f measurement) 0.1 μF Trng C-f 4-88

Module 5 Id-Vd measurement MOSFET IDVD, Id-Vd 5-7

SMU series connection 511 kohm IRVR 5-24

SMU parallel connection 1 ohm Parallel 5-28

Re measurement, kelvin connection Bipolar Tr REKELV 5-38

Module 6 Leak current measurement - Zero-check 6-9

Ultra low current measurement - Zero-check-ASU 6-19

Id-Vg measurement MOSFET IDVG 6-20

Gummel plot Bipolar Tr GUMMEL 6-25

Module 7 SMU pulse mode MOSFET IDVD-Pulse 7-8

RC measurement 0.1 μF and 
511 kohm

RC-sampling-log 7-16

Negative hold time 511 kohm R-sampl-neg-hold 7-22

Auto analysis MOSFET GMMAX 7-28

Bias hold function LED LED 7-35

SMU series resistor 0.5 Mohm IV-res 7-43



NOTE Demo.xpg file

Demo.xpg file is required to create the Demo preset group which contains the test setup 
data used by the class exercises. And it is stored in the \data folder on the Agilent B1500A 
Manual CD-ROM, Edition 4 or later.

The Demo preset group should be created before starting the class exercise. To create the 
preset group, launch EasyEXPERT and import the file by using the Preset Group Import 
dialog box opened by clicking My Favorite Setup > Preset Group > Import Preset Group. 
The test setup data are only examples for the class exercises.

NOTE .xtd files

The \data folder on the Manual CD-ROM stores some .xtd files. They are the application 
test definitions used by some class exercises. To use the definition file, import the file by 
using the Test Definition Import dialog box opened by clicking Library > Import Test 
Definition. The test definition data are only examples for the class exercises.

NOTE .xtr files

The \data folder on the Manual CD-ROM stores some .xtr files. They are the sample test 
results created by executing the test setup which has the same name as the result data. To 
display these sample test results, import the files by using the Test Result Import dialog 
box opened by clicking Results > Transport Data > Import.

Module 8 C-V sweep measurement MOSFET CV-1MHz 8-6

Module 9 Modifying application test 
definition

MOSFET Trng IdVd Vth.xtd 9-14

Trng idvd idvg2.xtd 9-32

Trng idvd idvg3.xtd 9-35

Using vector data MOSFET Trng Cgg-Vg 9-37

Module 10 Creating application test definition MOSFET Trng idvd idvg.xtd 10-17

Module 11 no exercise

Module 12 no exercise

Module Exercise Device Test setup/definition/data Page 



Test Setup for Class Exercises
The Demo preset group contains the following test setup. The setup data are only examples 
for the class exercises. The following table lists the test setup name in alphabetical order.

Test Setup Name Description 

CV-1MHz MOSFET Cgs-Vg measurement

Fowler-Nordheim Fowler-Nordheim (FN) plot

GMMAX MOSFET sqrt_Id-Vg, PEAK-Vg measurement

GUMMEL Bipolar transistor gummel plot

IDVD MOSFET Id-Vd measurement

IDVD-Pulse MOSFET pulsed Id-Vd measurement

Id-Vd MOSFET Id-Vd measurement, Application Test

IDVG MOSFET Id-Vg measurement

IRVR 511 kohm I-V measurement

IV-res 511 kohm I-V measurement with SMU series resistor

LED LED I-V measurement

Parallel 1 ohm I-V measurement, voltage force and current measurement

RC-sampling-log RC sampling measurement, log sampling

REKELV Bipolar transistor Re measurement

R-sampl-neg-hold 511 kohm sampling measurement with negative hold time

Subthreshold MOSFET subthreshold measurement

Trng C-f Direct Control (C-f measurement)

Trng Cgg-Vg Modifying application test definition using vector data

Trng CV MOSFET C-V measurement

Trng Id-Vd MOSFET Id-Vd measurement

Trng List MOSFET Vth-gmmax measurement using I/V List Sweep

Trng Multi Multi Channel I/V Sweep (Bipolar transistor and LED)

Trng Sampling 0.1 μF sampling measurement

Trng Switch B2200 switch setup, Input 1-3-5-7 to Output 1-3-5-7

Zero-check SMU open measurement

Zero-check-ASU SMU open measurement with ASU



Required Devices for Class Exercises
To perform the class exercises, you need the device set (Agilent part number 04156-87001) 
which contains the following devices.

Description Quantity

N-channel MOSFET 2 ea.

NPN Bipolar Transistor 1 ea.

Red Miniature LED 1 ea.

0.1 μF Capacitor 50 V 1 ea.

1.0 Ω Resistor 1/8 W 1 ea.

1.1 kΩ Resistor 1/8 W 1 ea.

511 kΩ Resistor 1/8 W 1 ea.

NPN bipolar TransistorN-ch MOSFET LED

1 ohm Resistor

Brown
Black
Black
Silver

1.1 kohm Resistor

Brown
Brown
Black
Brown

511 kohm Resistor

Green
Brown
Brown
Orange

0.1 uF Capacitor



Required Accessories for Class Exercises
To perform the class exercises, you need the following accessories. Prepare the accessories 
shown below.

Designation Description Model No. Qty. 

1 Test Fixture 16442A/B a

a. The 16058A Test Fixture for the 4145A/B may be substituted for the 
16442A/B Test Fixture. If you use the 16058A, you also need the 16435A 
Interlock Adapter.

1 ea.

28 pin socket module 1 ea.

Connection wire 6 ea.

2 Triaxial Cable 16494A 4 ea.

3 Interlock Cable 16493J 1 ea.

4 Kelvin Triaxial Cable, for Module 5 16493K 1 ea.

5 CMU Cable, for Module 8 N1300A 1 ea.

6 Atto Sense/Switch Unit, for Module 6 E5288A 1 ea.

ASU control cable, triax cable, for Module 6 16493M 1 ea.

16442A/B Test Fixture (1ea.)

Triaxial Cable (4ea.)

INTLK Cable (1ea.)

Connection Wire (6ea.)

28 pin DIP Socket Module (1ea.)

2

3

1

4

5 CMU Cable (1ea.)

6

E5288A ASU (1ea.)

Triaxial Cable (1ea.)

Control Cable (1ea.)

Kelvin Triaxial Cable (1ea.)



Contents

Contents-1

Module 1. Introduction

• New Features

• EasyEXPERT

• To Perform Easy Application Test

• User Interface

• Modular Mainframe

• SCUU/GSWU

• ASU

• B2200 Switch Control

• Desktop EasyEXPERT

Module 2. Getting Started

• To Turn on/off B1500A

• To Launch EasyEXPERT

• To Specify/Create Workspace

• To Perform Application Test

• To Save/Recall Your Test Setup

• To Export/Import Your Preset Group

• To Export/Import Test Record

• To Perform Quick Test

• To Control B2200 Switching Matrix

• To Manage Data Display Window



Contents

Contents-2

Module 3. Data Display and Management

• Data Display window

• Graph Analysis Tools

• Data Status

• To Change Graph/List/Display Setup

• To See Print Preview

• To Print Display Data

• To Copy Graph Plot/List Data

• To Save Analysis Result

• To Use Preview Window

Module 4. Classic Test Environment

• Classic Test Execution Mode

• I/V Sweep Measurement

• Multi Channel I/V Sweep Measurement

• I/V List Sweep Measurement

• I/V-t Sampling Measurement

• C-V Sweep Measurement

• Switching Matrix Control

• Direct Control



Contents

Contents-3

Module 5. Basic Measurement

• SMU Fundamentals

• Classic Test Environment

• SMUs Connected in Series or Parallel

• Cabling and Fixture Issues

• Kelvin and Driven Guard

• Probes and Prober Connections

• Triax and Coax Adapters

• Safety Interlock Issues

Module 6. Low Current Measurement

• Low-Current Measurement Challenges

• Calibration and Zero Cancel

• Effect of Cable Movement

• ASU for Ultra Low-Current Measurement

• Low-Current Subthreshold

• Trade-Off Speed Vs Accuracy

• Low-Current Gummel Plot

• Low-Current Gate Oxide Leakage



Contents

Contents-4

Module 7. Measurement Functions

• SMU Pulsed Sweep Measurement

• I/V-t Sampling Measurement

• Negative Hold Time for High Speed Sampling

• Auto Analysis

• Bias Hold Function

• SMU Filter

• SMU Series Resistor

• Standby Function

Module 8. Capacitance Measurement

• CMU Fundamentals

• Classic Test Environment

• CMU Calibration

• SCUU for IV/CV Switching 

• GSWU for Accurate Capacitance Measurement

• ASU for IV/CV Switching



Contents

Contents-5

Module 9. Modifying Application Test Definitions

• To Open Application Test Definition 

• To Modify Test Definition 

• To Use Debug Tools

• To Use Built-in Functions

• To Add Data Display

• To Use Auto Analysis 

• To Define Test Output

• To Use Test Setup Internal Variables

• To Use Vector Data to Modify Test Definition

Module 10. Creating Your Test Definitions

• What is Test Definition

• What is Test Contents

• To Open Test Definition Editor

• To Define Test Specification

• To Define Test Contents

• Available Elements

• Available Variables



Contents

Contents-6

Module 11. Advanced Definitions and Operations

• To Control External GPIB Devices

• To Call Execution Files

• To Perform Repeat Measurements

• Prober Control Script

Module 12. Miscellaneous Operations

• Function Status Indicator

• Automatic Data Export and Data Record

• Data Record ON/OFF

• Calibration

• Configuration

• XSLT Samples

• To Enable System Controller

• To Start Desktop EasyEXPERT

• To Use 415x Setup File Converter



1 Introduction



Introduction

Module 1

1-2

In This Module

• New Features

• EasyEXPERT

• To Perform Easy Application Test

• User Interface

• Modular Mainframe

• SCUU/GSWU

• ASU

• B2200 Switch Control

• Desktop EasyEXPERT

Note:
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Comprehensive 

application 

library

Revolutionary 

EasyEXPERT 

environment

Semi-auto prober 

control

10 Slots variable 

module 

configuration

SCUU/GSWU 

for IV/CV 

combination

Touch-screen 

w/optional USB 

keyboard & 

mouse

Agilent B1500A Semiconductor Device Analyzer

B2200 switch 

control

415x setup file 

converter

ASU for 

100 aA 

The B1500A has many exciting new features and capabilities.



Introduction

Module 1

1-4

New Features

• EasyEXPERT software

• Application test environment (> 150 algorithms)

• Classic test environment – 415x like setup

• Quick test environment – multiple test execution

• Semi-auto prober control and B2200 switch control

• Modular mainframe 

• MFCMU for C-V sweep, C-f sweep

• HPSMU, HRSMU, MPSMU for I/V Sweep, Multi Channel I/V Sweep, I/V 
List Sweep, I/V-t Sampling

• SMU CMU Unify Unit (SCUU)/Guard Switch Unit (GSWU)

• switching effortlessly between  IV and CV measurement

• Atto Sense/Switch Unit (ASU)

• 100 aA level low current measurement

• Touch-screen, knob, and softkeys

• optional USB keyboard, mouse, and stylus pen

The EasyEXPERT software 

•Task-oriented, “top-down” approach to device characterization

•Multiple test execution

•Automatic measurement, auto-analysis functions

•Test sequencing without programming

Application Library (>150 algorithms)

•Categorized and organized 

•Easy-to-use

415x control by Desktop EasyEXPERT software.

Versatile Modular Mainframe

•Flexible & Expandable   (10 slots)

•Multiple SMU types

•Atto-sense and Switch Unit (ASU)

•Multi-Frequency CMU

•SMU CMU Unify Unit for IV/CV Probing

•4.2 Amp Ground Unit

Convenient User Interface 

•Touch screen operation (with optional stylus pen)

•Contextual softkeys & knob control

•Optional USB keyboard & mouse
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EasyEXPERT

MeasurementMeasurement

resourcesresources

V/I on terminalsV/I on terminals

Device parametersDevice parameters

Device typeDevice type

Technology Technology 

classificationsclassifications

Vth Idon Idoff gm Igleak Rg

Vg Vd Vs Vsub

Ig Id Is Isub

SMU1 SMU2 SMU3 SMU4

Mode

V

I

Mode

V

I

Mode

V

I

Mode

V

I

GaAs WLR
Nano-

tech

CMU

Mode

AC V

range

MOS

FET
Res. Cap.

Bipolar

Tr

CMOS

Instead of setting up the instrument hardware, the EasyEXPERT software focuses on the real task at 

hand for the engineer ---device characterization.  All that you need to do is to connect the instrument 

to the device terminals as shown in the EasyEXPERT test parameters area.

The EasyEXPERT software also provides the classic test mode that allows the 4155/4156 like 

measurement setup operation.
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To Perform Easy Application Test

List of test record

Step 1: Click Application Test tab.

Step 2: Select one or more technology categories, and select a desired test from the list of tests 

associated with the selected technology categories.

Step 3: Change the setup parameters (Device parameters and Test parameters) if you want.

Step 4: Connect DUT, and click the Start button.  The B1500A starts the selected test.

Step 5: Analyze the measurement result data displayed on the Data Display window automatically 

opened after the test.

The measurement result record is automatically stored in the internal hard disk drive when the Auto 

Recode mode is ON.
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User Interface

• Touch panel

• Stylus pen (option)

• Rotary knob

• Softkeys

• USB keyboard (option)

• USB mouse (option)
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Modular Mainframe

10 module slots

B1510A HPSMU

GNDU: 4.2 A

N1301A-100 SCUU 

N1301A-200 GSWU

E5288A ASU

B1517A HRSMU

B1511A MPSMU

B1520A CMU

The following modules and accessories are available for the B1500A:

•B1520A CMU: 1 kHz to 5 MHz CV capability (1 slot)

•B1511A MPSMU: 100 mA/100 V force capability,  10 fA/0.5 mV measurement resolution (1 slot)

•B1517A HRSMU: 100 mA/100 V force capability,  1 fA/0.5 mV measurement resolution (1 slot)

•B1510A HPSMU: 1 A/200 V force capability,      10 fA/2 mV measurement resolution (2 slots)

•N1301A-100/102: SMU CMU unify unit (SCUU) & cable assembly

•N1301A-200/201/202: Guard switch unit (GSWU) & cable assembly

•E5288A ASU: 0.1 fA/0.5 mV measurement resolution with support for IV/CV switching

The ASU  (Atto sense/switch unit) can be used with the HRSMU calibrated with it.

The SCUU can be used with the CMU (slot N), SMU (slot N-1), and SMU (slot N-2).

The GSWU can be used with the SCUU.
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SCUU

CMU

SMU CMU Unify Unit 
(SCUU)

SCUU cable

Simple direct connection

between SMU/CMU and 

manipulators (positioners)

SMU

SMU

GSWU

Force1 or CMUH

Force2 or CMUL

Sense1

Sense2

You have a very hard time switching between CV and IV measurements (you may actually devote 

separate probe stations to CV and IV just to avoid having to change cables).  In addition, great care 

has to be taken when cabling to a capacitance meter to insure that all of the capacitance 

measurements are properly compensated.  The SCUU removes all of these worries and makes 

connection simple and easy.  In addition, the B1500A software automatically takes care of the 

multiplexing based upon the type of algorithm selected from the front panel.

To install the SCUU near the manipulators/positioners, use the N1301A-102 SCUU cable. 

To realize accurate capacitance measurement, use the N1301A-200/201/202 GSWU & cable. 
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GSWU

GSWU

SCUU

The GSWU must be connected to the outer conductors of the manipulators/positioners connected to 

the Force1/CMUH and Force2/CMUL connectors of the SCUU. And the GSWU control cable must 

be connected between the GSWU and the SCUU.

When the SMU paths are available for the manipulators/positioners, the GSWU opens between the 

outer conductors. However, when the MFCMU paths are available, the GSWU shorts them together 

to make the return path of measurement current. This will reduce the signal path impedance. And this 

is effective for the accurate capacitance measurement.

By using the EasyEXPERT software, cable length between the CMU and the SCUU is automatically 

detected, and the GSWU switch control is automatically performed.  Also, capacitance error 

compensation is also automatically performed if the compensation data are available.

The GSWU is effective for
•reducing the residual inductance of the measurement cable
•stabilizing the residual inductance when measurement cable distance is changed (moved)
It’s roughly 1/10 to 1/30 when used with two 80 cm cable.

Note:

When the SMU paths are available for the manipulators/positioners, the connection between the 

outer conductors must be broken because they are connected to the SMU guard terminals separately 

and the guard terminals must be opened at the end of the extension.
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ASU

• 100 aA level sensing

• Channel switching

• C measurements

• PG for charge pumping

To CMU Hpot/Hcur

ASU 2

ASU 1
To HRSMU 1

CMUH or Force

CMUL or

Force

Sense

Sense

CMU return path

To CMU Lpot/Lcur

To HRSMU 2

The high-resolution SMU (HRSMU) has an innate 1 fA & 0.5 mV measurement resolution. The 

optional ASU extends the HRSMU measurement resolution to 0.1 fA.

The ASU has another feature, built-in switching capability. It can switch between the SMU and an 

auxiliary input (AUX input, two BNC). 

If the CMU is connected to the AUX inputs, the ASU can switch between the low current and CV 

measurements. Then connect a wire between the CMU return terminals of ASUs to make the return 

path of measurement current.  This is effective for accurate capacitance measurement.  However, you 

need to perform capacitance compensation by yourself. 



Introduction

Module 1

1-12

B2200 Switch Control

• Allows use of a probe card to facilitate probing of standardized device 

modules (usually 24-pin configuration)

• Enables easy multiplexing between the triaxial outputs of SMUs and 

the coaxial outputs of other (BNC-based) instruments and modules

Switching Matrix 

Wafer Prober

Device Analyzer

8

6

12 - 48

Triaxial 

(SMU) Triaxial

Coaxial 

(CMU, other)

GPIB cable GPIB cable

Agilent B2200A/B2201A switching matrix can be controlled by B1500A/EasyEXPERT via GPIB.  

EasyEXPERT provides the Switching Matrix Operation Panel for interactive control of B2200 

independent from the test execution mode of B1500.  And switch setup can be saved to a classic test 

setup data.  In the classic test, the switch setup is sent to B2200 when a measurement start button is 

clicked. 

B1500A/EasyEXPERT also provides the semi-auto prober control script.  The semi-auto prober can 

be controlled without programming.  The prober control script supports the die move operation by 

using the following first three procedures in the repeat measurement setup and adds the subsite move 

operation by using the Subsite procedure in the quick test setup. 

Prober control script:

•Start procedure

•Iteration procedure

•Final procedure

•Subsite procedure
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Desktop EasyEXPERT Software

The Desktop EasyEXPERT software provides the following additional advantages to the B1500A, 

allowing you to minimize the amount of offline tasks performed on B1500A and increase the 

working ratio for measurements.

•Allows B1500A to be controlled from an external computer via GPIB while online.

•Allows test setup to be created on an external computer while offline.

•Allows data analysis to be performed on an external computer while offline.

•Allows 415X to be controlled from an external computer via GPIB while online. 

To start Desktop EasyEXPERT, see Module 12.
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2 Getting Started



Module 2
Getting Started

2-2

In This Module

• To Turn on/off B1500A
• To Launch EasyEXPERT
• To Specify/Create Workspace
• To Perform Application Test
• To Save/Recall Your Test Setup
• To Export/Import Your Preset Group
• To Export/Import Test Record
• To Perform Quick Test
• To Control B2200 Switching Matrix
• To Manage Data Display Window

This section explains the above tasks.  You will understand how to launch B1500A/EasyEXPERT, 
how to perform application test and quick test, and how to create your test setups and preset groups.
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To Turn on/off B1500A

The Standby button works to turn on the B1500A when it is turned off. When the B1500A is turned 
on, the Standby button works to terminate the EasyEXPERT software, Windows, and turn off the 
B1500A.
After the B1500A is turned on, log on Windows.
The default user is Agilent B1500 User with no password.
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To Launch EasyEXPERT

Start EasyEXPERT button/window

Start EasyEXPERT icon

After logging on, click Start EasyEXPERT button to launch the EasyEXPERT software.
If you do not see the Start EasyEXPERT button, double click the Start EasyEXPERT icon to open 
the Start EasyEXPERT window.

This window has the File menu and the Option menu.  The File menu is used to close this window.  
The Option menu provides the following functions.
Backup EasyEXPERT Database: Used to make backup of the EasyEXPERT database.
Restore EasyEXPERT Database: Used to restore the EasyEXPERT database.

Note:
Desktop EasyEXPERT provides the following additional functions in the Option menu.
Execution Mode: Used to change the software execution mode.
Move EasyEXPERT Database: Used to move the EasyEXPERT database.
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To Specify Workspace

Case 1

Case 2 Case 3

After launching the EasyEXPERT, you will see one of the above screens.
Case 1: If this is the first time to launch the EasyEXPERT
The LCD displays the EasyEXPERT main screen.
Case 2: If the B1500A has one workspace only
Select Yes, and click OK if you use the existing workspace.
The EasyEXPERT main screen is displayed.
Select No, and click Next if you want to create a new workspace.
See next slide.
Case 3: If the B1500A has some workspaces (more than one)
Select workspace you want to use, and click Continue.
The EasyEXPERT main screen is displayed.
If you create workspace, check the Create a new Workspace radio button, and click Continue.
To create a public workspace, check the Allow other users to access this workspace box.  The public 
workspace can be used by all users.
To create a private workspace, delete the check from the Allow other users to access this workspace
box.
Workspace is the space created in the Agilent B1500A’s internal hard disk drive, and is used to store 
the test setup, measurement result data, and so on.  The workspace can be created and allocated for 
each  user.
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To Create Workspace

1: New workspace name to create

Check this box for
Public workspace

2: New workspace name to rename

1

2

Enter the workspace name and click OK to create/rename the workspace.
If you want to create a public workspace, check the Allow other users to access this workspace box.
The public workspace can be used by all users.
If you want to create a private workspace, delete the check from the Allow other users to access this 
workspace box.
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Online Help

Online Help is available for the B1500A and EasyEXPERT.  Select Help > Agilent EasyEXPERT 
Help menu to display the online help window.  The online help provides the following information.
•Introduction describes overview, front view, rear view, and measurement units of the Agilent 
B1500A.
•Using EasyEXPERT provides the reference information of the Agilent EasyEXPERT software.
•Function Details explains the measurement functions of the B1500A with EasyEXPERT.
•Built-in Programming Tool provides the reference information of the built-in function, read out 
functions, and script programming statements.
•If You Have a Problem describes the problem solving information, the B1500A system maintenance 
information, and the error messages.
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Application Test Description

To know about the application test, click the ( i ) icon.  This icon displays the message box that 
explains the application test definition.  This function will help you to know what is and how to use 
the application test.
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Typical Value Selection

Right clicking 
this field 
displays the 
menu.

The values are 
defined as 
typical values 
in the Test 
Definition.

You do not need to hit the keyboard.

When you set a test condition of application test, you do not need to use keyboard.  You can select 
the value from the typical values as shown below.
•Click the entry field of a setup parameter by using the touch screen or the mouse.  This displays the 
typical values for the specified parameter on the softkeys.
•Select one of the softkeys.
Also you can use the following manner.
•Point the entry field of a setup parameter by using the mouse. 
•Right click the mouse to display the popup menu.
•Click the Select menu to display the typical values for the specified parameter.
•Select one from the typical values.
Note:
The typical values are defined in the test definition.  And you can change the values by using the 
Define typical values window opened by clicking the Typical Values button on the Test Specification 
screen of the Test Definition window.  For the Test Definition window, see Module 9.
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Screen Keyboard

When you need to enter numeric characters in an entry field, you will see the icon at the right side of 
the entry field.  This icon opens the Numeric KeyPad.  You can use this screen keypad instead of the 
USB keyboard.
When you need to enter alphabetic characters in an entry field, you will see the icon at the right side 
of the entry field.  This icon opens the On Screen Keyboard.  You can use this screen keyboard 
instead of the USB keyboard.
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To Perform Application Test

Test Record List area

Step 1: Click Application Test tab.
Step 2: Select one or more technology categories, and select a desired test from the list of tests 
associated with the selected technology categories.
Step 3: Change the setup parameters (Device parameters and Test parameters) if you want.
Step 4: Connect DUT, and click the Single button.  The B1500A starts the selected test.
After the test, the test result data is displayed on the Data Display window.  And the Test Result 
Editor is also displayed on the lower left area of the B1500 screen.  See the next page.
Step 5: Analyze the measurement result data.

The measurement result record is automatically stored in the internal hard disk drive. 
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Test Result Editor

• Save/Delete

• ! Important

• # Valid

• ? Questionable

• Remarks

• OK

The Test Result Editor provides the following GUI to set a flag and remarks to the test result record.  
Set the flag and remarks to the test record.
•Save button and Delete button
Divides test records into groups, Save and Delete.
Test records in Save-group are always listed in the lower area of the EasyEXPERT main screen.
Test records in Delete-group can be listed when Results > Filter > Show Deleted Data is checked.
•Flags buttons
The following buttons are available.  You can set one of the following flags.
•Important ! Button
Sets the important flag (!) to the test result record.
•Valid # button
Sets the valid flag (#) to the test result record.
•Questionable ? Button
Sets the questionable flag (?) to the test result record.
•Remarks field
You can enter characters into this field.  The characters will be recorded as the Remarks value of the 
test result record.
•OK button
Applies the setup on the Test Result Editor, and closes this dialog box.
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Test Record List Area

Flag Setup Name
Vth gmMax
Vth gmMax

Vth gmMax
Vth gmMax

ID-VD1
ID-VD1
ID-VD1
ID-VD1
Vth gmMax
Vth gmMax

ID-VD1

#
#
?
?

!
!

A
A
S
S
A
A
S

*Flag Setup Name
Vth gmMax
Vth gmMax

ID-VD1
ID-VD1
Vth gmMax
Vth gmMax

ID-VD1

#
#

!
!

…
…
…

*

Flag Setup Name
Vth gmMax
ID-VD1
ID-VD1
Vth gmMax
ID-VD1

#

!

…
…

*

Results > Filter > Show Deleted Data

Show All Append Data

Expand Application Test Results

The test result records are listed in the test record list area. The area also lists the following data.
•Append measurement data marked with …
•Deleted data marked with * if Results > Filter > Show Deleted Data is checked
•Test name defined in the application test definition if Results > Filter > Expand Application Test 
Results is checked
If Results > Filter > Show All Append Data is checked, all append data will be listed and the symbol 
will be changed to A for the data obtained by the Append measurement or S for the data obtained by 
the Single measurement.
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Single/Append/Repeat measurement

Single
RepeatAppend

The EasyEXPERT provides three execution modes, Single, Append, and Repeat. 
Single button triggers a single measurement.
Append button triggers an append measurement. The measurement results will be appended to the 
Data Display window that shows the previous measurement results. The Data Display window can 
have maximum 10 layers for displaying measurement results.
Repeat button opens the Repeat Measurement Setup dialog box used to set the repeat measurement 
condition.  To perform the repeat measurement, see Module 11.

To abort measurement, click Stop button that appears instead of the Single button.
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To Save/Recall Your Test Setup

Preset Group name.
Use this field to select 
preset group.

My Favorite Setup button

The test setups you create or modify MUST be saved in a preset group (My Favorite Setup).
To save the setup, click the Save button.
To recall the setup, click the Recall button.
You can organize the setups by using the My Favorite Setup button. 
To select the available preset group, use the field below the My Favorite Setup button.  In the above 
example, the Demo group is selected and listed in the My Favorite Setup list.
To rename, duplicate, or delete the setups, and to add, rename, duplicate, delete, import, or export the 
preset group, use the function of the My Favorite Setup button menu or the Organize Preset Group 
dialog box shown in the next page.
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To organize preset group for test setup 
My Favorite Setup   button

This dialog box is opened by selecting the Organize Preset Group function of the My Favorite Setup 
button menu, and is used to organize the preset group.
•Preset Group List
Lists the preset groups saved in the workspace.  The Add, Rename, Duplicate, Delete, Import, and 
Export buttons are available to organize the preset groups.
•Copy 
Sets the operation of the >> button and the << button. They work as Copy when this check box is 
checked, and as Move when this check box is blank.
•>> 
Copies or moves the preset setup selected in the left Preset Group box to the right Preset Group box.
•<< 
Copies or moves the preset setup selected in the right Preset Group box to the left Preset Group box.
•Close 
Closes the Organize Preset Group dialog box.
•Preset Group 
Lists the preset setups saved in the preset group.  The Select All, Unselect All, Rename, Duplicate, 
and Delete buttons are available to select or organize the setups saved in the preset group.
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To Export/Import Your Preset Group

My Favorite Setup
button

You can export/import your preset group.
To export the present preset group, click the My Favorite Setup button, select Export, and specify the 
folder and the name of the preset group to export. 
To import the preset group, click the My Favorite Setup button, select Import, and specify the preset 
group to import. 
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To Export/Import Test Record

1. Select data record to export, and right click.
2. Select Transport Data > Export As xxxx.

To export multiple data, select Transport Data > Folder Export.

To export the test result record, specify the data records and select the Transport Data > Export As 
xxxx menu.
You can save the data records as an EasyEXPERT file, a CSV file, a XML spreadsheet file, or a 
XML file created by using the specified XML style sheet.  
You can import the data record exported as the EasyEXPERT file or the XML spreadsheet file.
To import the file, select the Transport Data > Import… Then the Test Result Import dialog box is 
opened.  On the dialog box, select the file to import. 
You can read by using a text editor or a spreadsheet software as shown above.  This example reads a 
test record exported to a CSV file. 

Note:
To export multiple test records, select Transport Data > Folder Export…, and specify the destination 
folder and file names automatically set.  Then the multiple test records can be exported to the 
specified folder.
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Class Exercise

Perform Application Test.

1. Connect device (MOSFET). See the following pages.

2. Open Id-Vd test definition in the CMOS library.

3. Change the setup (SMU, output value, etc.)

4. Create your preset group, and save your setup. 

5. Click                 button to start a single measurement.

6. Perform this exercise for the Vth gmMax test 
definition.

Note:
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SMU Triax Connection

Force Lines to Fixture 1,2,3,4 Ports

16442A/B Fixture

B1500A Rear View

SMU4
SMU3
SMU2

SMU1

CMU

GNDU

Force side Sense side

For the non-Kelvin connections, connect only the Force lines, leaving the Sense lines open.

Connect corresponding numbers.  On the 16442A/B fixture use the numbers labeled 1 - 6, not 1 - 3. 

Your B1500A may not match the SMU configuration shown in this figure.  Note that SMU1 is the 
module top of the GNDU (ground unit).  The SMU number become large from bottom to top as 
shown.

This is the SMU cable setup that will be used in the remainder of the class exercises.
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Jumper Leads - MOS transistor

16088-60002
Dual in line package
(28 pin)

1 2 3 4 5 6

7 8 9 10 11 12

13 14 15 16 17 18

2019 21 22 23 24

25

27

26

28

14

1528

1

F

G

3
F

G

4
F

G

5
F

G

6
F

G

2
F

G

1
SMU

21
VMU

21
VSU

F

S

GNDU

F
2

F
1

PGU

For all class exercises, you need the 28-pin dual in line socket which comes standard with the 4145 
fixture (16058A) or the newer fixture (16442A/B).  Either fixture works fine.

With the 16442A/B fixture, note that there are two SMU numbering schemes....3 SMUs with force 
and sense, or six SMUs with force only.   For this class example we will use the six (6) SMU scheme.  
On older fixtures, this scheme is shown in light blue lettering. In newer fixtures, this scheme is 
shown in white reverse background lettering.
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Device Orientation and Insertion

Insert the transistor last, 
AFTER connecting the 
cables and leads.  Remove 
the shorting wire after 
insertion in the socket.

14

15

1
1: Substrate
2: Source
3: Gate
4: Drain

23
G

S D
Sub

The MOS FET leads must be re-arranged into a straight line as shown.

IMPORTANT:
The MOS FET is highly sensitive to electrostatic damage.  Touching the bare leads can definitely 
destroy the device.  The device comes with a special shorting wire attached.  Bend the leads the way 
you want, insert the device in the socket, and then remove the shorting wire.  The wire has a tab.  Just 
grab the tab and pull straight out.  The wire will spiral out as you pull.  

Once the shorting wire is removed, you must use a wrist strap when handling the device.
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Setup Example

3. change

3. change

3. change

3. change

4. create

5. save
2. select

Test result data (record) is automatically saved after measurement.

1. check

1. Check the CMOS check box.
2. Select Id-Vd (or Vth gmMax) and click the Select button.
3. Change the SMU setting as follows.

Substrate: SMU1
Source: SMU2
Gate: SMU3
Drain: SMU4

4. Create your preset group (ex. Exercise).
5. Save the changed setup to your preset group.

After this class exercise, the Id-Vd setup and the Vth gmMax setup will be saved in your preset 
group.



Module 2
Getting Started

2-24

Result Example

This is the Id-Vd measurement result example of the following source setup.
Gate voltage: 0.5 V to 2 V, 0.5 V step
Drain voltage: 0 V to 2 V, 0.05 V step
Source voltage: 0 V
Substrate voltage: 0 V
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To Perform Quick Test

Softkeys
for single 
measurement

Step 1: Click Quick Test tab.
Step 2: Select the Preset Group.
Step 3: Mark (check) the test setups to be executed while the Quick Test is executed.
Step 4: Connect DUT, and click the Single button.  The B1500A starts the selected tests from top to 
bottom in the list.
After the test, the test result data is displayed on the Data Display window.  And the Test Result 
Editor is also displayed on the lower left area of the B1500 screen.
Step 5: Analyze the measurement result data.

The measurement result record is automatically stored in the internal hard disk drive. 

The softkeys placed right side of the LCD are used to trigger a single measurement of the associated 
test.
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To organize preset group for test setup 
My Favorite Setup banner

This dialog box is opened by selecting the Organize Preset Group function of the My Favorite Setup 
banner menu, and is used to organize the test preset group.
•Preset Group List
Lists the preset groups saved in the workspace.  The Add, Rename, Duplicate, Delete, Import, and 
Export buttons are available to organize the preset groups.
•Copy 
Sets the operation of the >> button and the << button. They work as Copy when this check box is 
checked, and as Move when this check box is blank.
•>> 
Copies or moves the preset setup selected in the left Preset Group box to the right Preset Group box.
•<< 
Copies or moves the preset setup selected in the right Preset Group box to the left Preset Group box.
•Close 
Closes the Organize Preset Group dialog box.
•Preset Group 
Lists the preset setups saved in the preset group.  The Select All, Unselect All, Rename, Duplicate, 
and Delete buttons are available to select or organize the setups saved in the preset group.
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Class Exercise

Perform Quick Test.

1. Use the device connection of the previous exercise. 

2. Open your preset group.

3. Edit your preset group as you want (changing the test 
execution order etc.).

4. Save your preset group. 

5. Perform Quick Test.

Note:
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Result Example

Note:
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To Control B2200 Switching Matrix

Step 1: Click Switching Matrix button to open the Switching Matrix Operation Panel.
Step 2: Enter the switch setup name.
Step 3: Define the switch setup by using the matrix on the operation panel window.  Label can be set 
to input ports and output channels.
Step 4: Click the Apply Switch Setup button to send the switch setup to the B2200 switching matrix.
Note: 
Before clicking this button, connect the B2200 to the B1500 via GPIB, and set the configuration.  To 
set the configuration, see Module 12.

The switch setups you create or modify MUST be saved in a preset group.
To save the setup, click the Save button.
To recall the setup, click the Recall button.
You can organize the setups by using the Preset List button. 
To select the available preset group, use the field below the Preset List button.  In the above example, 
the DemoSW group is selected and listed in the Preset List list.
To rename, duplicate, or delete the setups, and to add, rename, duplicate, or delete the preset group, 
use the function of the Preset List button menu or the Organize Preset Group dialog box shown in the 
next page.

Read Switch Setup: Read switch setup from B2200 via GP-IB and show it on the operation panel 
window.
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To organize preset group for switch setup 

Preset List     button

This dialog box is opened by selecting the Organize Preset Group function of the Preset List button 
menu, and is used to organize the switch preset group.
•Preset Group List
Lists the preset groups saved in the workspace.  The Add, Rename, Duplicate, and Delete buttons are 
available to organize the preset groups.
•Copy 
Sets the operation of the >> button and the << button. They work as Copy when this check box is 
checked, and as Move when this check box is blank.
•>> 
Copies or moves the preset setup selected in the left Preset Group box to the right Preset Group box.
•<< 
Copies or moves the preset setup selected in the right Preset Group box to the left Preset Group box.
•Close 
Closes the Organize Preset Group dialog box.
•Preset Group 
Lists the preset setups saved in the preset group.  The Select All, Unselect All, Rename, Duplicate, 
and Delete buttons are available to select or organize the setups saved in the preset group.
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To add switch setup to test preset group

Switch setups can be saved in the preset group for test setups.
Click the Export to Current My Favorite Group button.  The switch setup will be converted to a 
classic test setup and saved in the My Favorite Setup group opened in the main screen.
To select the available preset group, use the Preset Group field.  In the above example, the Demo 
group is selected and listed in the quick test setup list.
To duplicate, import, or export the preset group, use the function of the My Favorite Setup banner 
menu or the Organize Preset Group dialog box shown in the next page.
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Class Exercise

Add switch setup to test preset group.

1. Create a switch setup.

2. Create your switch preset group, and save your setup. 

3. Add the switch setup to your test preset group.

4. Save your test preset group. 

Note:
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To Manage Data Display Window
Data Display > Default Data Display Properties…

The Data Display Properties window is used to set the default setting of the Data Display window.  
This window is opened by selecting the Data Display > Default Data Display Properties... menu of 
the main screen.
The Effective Area is used to select the area effective when the Data Display window is opened, and 
provides the following check box.
•X-Y Graph: Check this box to enable the X-Y Graph area.
•Grid ON: Check this box to display the grid in the X-Y Graph.
•List Display: Check this box to enable the List Display area.
•Parameters: Check this box to enable the Parameters area.
The Graph Color area is used to set the color map for the Data Display window.  You can change the 
color of the background, text, graph grid, and line.  The color palette is opened by clicking the 
pattern of the item.
The Graph Trace Color area is used to set visibility, color, and thickness of the data traces Y1 to Y8 
plotted on the graph.
The Log Scale area is used to set the maximum number of decades to show the minor ticks for the 
log axis. If the number of graph decades is less than or equal to the entered value, the minor ticks are 
displayed. If it is greater than the entered value, the minor ticks are not displayed.

The Text Size area is used to set the font size for the graph. The available settings are Largest, Large, 
Medium, Small, Smallest, and Fixed. For settings other than Fixed, the appropriate size is 
automatically selected. For Fixed, a font size entry field is provided, and the specified font size is 
always applied.
•X/Y Axis Title: Font size for the axis title
•Scale: Font size for the X and Y coordinate values
•Legend: Font size for the graph legend
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To Manage Data Display Window
Data Display > Manage Data Display…

The Data Display Manager is used to control the appearances of the Data Display windows.  This 
window is opened by selecting the Data Display > Manage Data Display... menu of the main screen. 
The Data Display Window Order area lists the Setup Name of the Data Display windows opened.  
The list items from top to bottom correspond to the windows from front to back in the screen image. 
The Minimized Data Displays area lists the Setup Name of the Data Display windows minimized. 
The Data Display Window Configuration area provides the following radio buttons and a check box 
to change the appearances of the Data Display windows.  All functions are available for the opened 
windows.  See following slides for the display examples.
•Keep Setup: Keeps the present configuration of the Data Display windows.
•Tiling: Resize and collate the data display windows such that they fill up the entire screen.
•Stacking: Resize and collate the data display windows so that they overlap slightly with an offset.
•Overlaying: Resize, overlap, and make transparent the data display windows so that multiple graphs 
can be viewed and superimposed on one another.
The following check box must be checked to apply the same graph scale to all graphs.
•Apply same scale to all graph



Module 2
Getting Started

2-35

Tiling

This is a display example of Tiling.
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Stacking

This is a display example of Stacking.
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Overlaying

This is a display example of Overlaying.
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To tile/stack/overlay windows
Stacking

Tiling

Overlaying

When some Data Display windows are opened, the following Windows menu functions are useful.

Tiling
Tiles all Data Display windows on the screen.

Stacking
Stacks all Data Display windows on the screen.

Overlaying
Overlays all Data Display windows on the screen. Then the position, window size, and visibility of 
the most front window are applied to all windows on the screen.
The background of the X-Y Graph area is cleared except for the most back window.
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In This Module

• Data Display window

• Graph Analysis Tools

• Data Status

• To Change Graph/List/Display Setup

• To See Print Preview

• To Print Display Data

• To Copy Graph Plot/List Data

• To Save Analysis Result

• To Use Preview Window

This section describes the above topics.  You will understand how to use analysis tools, how to 
change display setup, and how to print/export test result data.
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Data Display window

X-Y Graph PLot Parameters

List Display

The Data Display window is opened after measurement automatically, or by clicking the Data 
Display button. And the window is used to display measurement data and analyze the data.

The Show X-Y Graph icon displays/hides the X-Y Graph Plot area.  This is the same as the View > 
X-Y Graph menu.
The Show List Display icon displays/hides the List Display area.  This is the same as the View > List 
Display menu.
The Show Parameters icon displays/hides the Parameters area.  This is the same as the View > 
Parameters menu.
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Graph Analysis Tools

active line (normal line)
active cursor

cursor

marker
line (tangent line)

marker

This bar indicates 
which axis is 
effective for 
marker control 
and auto scaling.

cursor/marker position
(X value, Y1 value, Yx value)

Y1 Yx      (x : 2 to 8)

The Data Display window provides marker, cursors, and lines for analyzing test result data.  Marker 
is used to read measurement data and draw a tangent line.  Cursors are used to read the cursor 
position and draw a normal line, gradient line, or regression line.  The cursor/marker position data is 
displayed top of the graph plot area.
Clicking Y axis can select the Y axis effective for the analysis tools.  On the graph, left axis is always 
Y1 axis.  And the right axis is selectable from Y2 to Y8 axes.
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Graph Analysis Tools

Pointer

Text

Text and pointer are the tools to decorate the X-Y Graph.
The text is used to leave notes on the graph.  The notes will be measurement conditions, device 
information, operator name, and so on. Up to 20 texts can be added to a graph.
The pointer is used to indicate the remarkable measurement point and show the X and Y coordinates 
like the marker.  The new pointer can be displayed on the marker point at first and can be moved on 
the measurement data curve by using the rotary knob or the mouse wheel.  Up to 30 pointers can be 
added to a graph.
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Graph Analysis Tools

Line Information:
Y1 intercept and 
gradient of 
active line

Line Information:
Yx intercept and 
gradient of 
active line

Line Information:
X intercept of active line

Show Graph Legend
Show Line Information

Graph Legend

When a line is displayed, the line information can be displayed in the graph plot area.  
The Show Line Information icon displays/hides the line information.  This is the same as the View > 
Line Information ON/OFF menu.
The Show Graph Legend icon displays/hides the graph legend.  This is the same as the View > Graph 
Legend ON/OFF menu.
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Graph Analysis Tools

Y1

Switch Display Mode

Hold this layer

Close this layer

Close All Displays

Layer selection tab.

This example has
three layers.

If the append measurement is performed, the data display layer is added to the Data Display window.  
In this example, the Data Display window has three layers.
Use the icons shown above to organize the data display layers. 

Switch Display Mode icon switches the mode, overwrite or append.
In the overwrite mode, the data is displayed in a new Data Display window.
In the append mode, the data is displayed on a new display layer in the present Data Display window.

The Data Display window can hold up to 10 display layers.  And the earliest layer over 10 will be 
automatically deleted.  The Hold this layer icon is available when the window holds at least two 
layers.  If this icon shows the standing pin, the layer will be held.  If this icon shows the laid pin, the 
layer can be deleted.  Double clicking the tab gives the same result as this icon.
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Graph Analysis Tools
Graph control

(X value, Y1 value, Yx value)

marker
line (tangent line)

marker

Graph control:
Auto Scale icon will change the graph scale automatically to fit the trace in the graph. The right 
arrow button opens the menu for enabling or disabling the run time auto scaling. This function is set 
independently for the X and Y axes.  If this function is enabled, the graph scale will be changed 
automatically to fit the trace in the graph during the measurement.  
Zoom In icon zooms the data graph in.  This enlarges the trace in the graph.  Then the center of 
zooming will be the cursor position.
Zoom Out icon zooms the data graph out.  This reduces the trace in the graph.
Graph Setup icon opens the Graph Setup dialog box used to change the graph axis setup.
Choose Active Y axis icon selects the Y axis that is effective for the analysis tools (marker control 
and auto scaling).
If multiple layers are opened on the Data Display window, the scale change is applied to the layers. 
This means that the X-Y graph scale will be shared by all display layers. The auto scaling is 
performed as follows.
1. Graph scale is optimized for the data on the selected layer (top layer).
2. The graph scale is applied to the graph in the all layers.
Note that auto scaling is performed independently for the left and right Y axes.
There is also a function for resetting the graph scale. Click View > Cancel Scaling > This Display or 
All Displays.  
This Display will reset the selected layer only. All Displays will reset all display layers.



Module 3
Data Display and Management

3-9

Graph Analysis Tools
Marker control

(X value, Y1 value, Yx value)

marker
line (tangent line)

marker

Marker control:
Marker ON/OFF icon enables or disables the marker.
Interpolation ON/OFF icon enables or disables the interpolation function of measurement data. You 
can read the interpolation data between two actual measurement points.
Marker Skip icon moves the marker to the next measurement curve that is added by the VAR2 
variable.
Marker Maximum icon moves the marker to the maximum measurement point.
Marker Minimum icon moves the marker to the minimum measurement point.
Marker Search icon opens the Direct Marker/Cursor dialog box used to specify the coordinate values 
to move the marker.
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Graph Analysis Tools
Line control

active line (normal line)
active cursor

cursor

marker
line (tangent line)

Line control:
Line 1 State icon enables or disables line 1 and its function: normal, gradient, tangent, or regression.
Line 2 State icon enables or disables line 2 and its function: normal, gradient, tangent, or regression.
Cursor to Marker icon moves the cursor to the marker position.
Adjust Gradient icon is available when a gradient line is active. Clicking this icon enables the rotary 
knob and the mouse wheel to increase/decrease the gradient of the line.  Clicking this icon again, 
clicking the rotary knob, or clicking the mouse wheel disables this function.
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To Enable Marker and Line
Marker > Marker ON/OFF Line > Line 1 ON/OFF

Line 2 ON/OFF

Marker ON/OFF

Line 1 & Line 2

To enable maker, click the Marker ON/OFF icon, or select the Marker > Marker ON/OFF menu.
To enable the Line 1, click Line 1 icon and select one of the line mode.  Or select the Line > Line 1 
ON/OFF menu and select one of the line mode.
To enable the Line 2, click Line 2 icon and select one of the line mode.  Or select the Line > Line 2 
ON/OFF menu and select one of the line mode.

If you enable the Normal line, two cursors are available.  The cursors specify the points that the line 
passes through.
If you enable the Gradient line, a cursor is available.  The cursor specifies the point that the line 
passes through.
If you enable the Regression line, two cursors are available.  The cursor specify the measured data 
used to draw the regression line.
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To Draw Normal Line

2 cursors line

Line N > Normal
Cursor To Marker

Enable the Normal line by clicking the Line 1 (or Line 2) icon and Normal. 

Move cursors to draw the line.  The line passes through the cursor points. 

To move the cursor, you can use the Cursor To Marker icon.  The cursor will move to the marker 
point.
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To Draw Gradient Line

1 cursor
line

gradient

Adjust Gradient

Line N > Gradient
Cursor To Marker

Enable the Gradient line by clicking the Line 1 (or Line 2) icon and Gradient. 

Move the cursor to specify the point that the line passes through.  And click the Adjust Gradient icon.
Use the rotary knob or the mouse scroll button to adjust the gradient of the line. 
To move the cursor, you can use the Cursor To Marker icon.  The cursor will move to the marker 
point. 
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To Set Gradient Value

This is another way to draw the gradient line.
Set the line 1 or 2 ON and select the gradient line mode.  Then click Line > Gradient… to open the 
Gradient Value dialog box. 
On the dialog box, enter the desired gradient value, and click OK to draw the gradient line.
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To Draw Tangent Line

marker
line

data curve

Line N > Tangent

Enable the Tangent line by clicking the Line 1 (or Line 2) icon and Tangent. 

Move marker to draw the line.  The tangent line will pass through the marker point.



Module 3
Data Display and Management

3-16

To Draw Regression Line

line
2 cursors

measured data

Cursor To Marker
Line N > Regression

Enable the Regression line by clicking the Line 1 (or Line 2) icon and Regression. 

Move cursors to specify the region of the measurement data used for the regression calculation.

To move the cursor, you can use the Cursor To Marker icon.  The cursor will move to the marker 
point.
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To Use Text 
Text > New

To add a text, click Text > New.  A text editor appears.  Then enter the text you desire. 
The following functions are available for the selected text(s) via the Text menu, the Text icons, or the 
right-click menu.
Clicking on a text will select the text. To select the multiple texts, click the text while holding down 
the Shift key on the keyboard. 
Edit Mode: Edits the selected text. 
Size: Sets the font size of the selected text(s). The available setting values are Largest, Large, 
Medium, Small, Smallest, and Fixed Point (6, 7, 8, 9, 10, 11, 12, 14, 16, 18, or 20). For settings other 
than Fixed Point, an appropriate size will automatically be applied. For Fixed Point, the specified 
font size will always be applied.
Font: Sets the font of the selected text(s).
Text Color: Sets the text color of the selected text(s).  Click Customize to open the color palette.
Background Color: Sets the background color of the selected text(s).  Click Customize to open the 
color palette. 
Hide Frame/Show Frame: Hides or shows the frame for the selected text(s).
Delete: Deletes the selected text(s).
Dragging a text moves this text.
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To Use Pointer

Pointer > New

To add a pointer, set Marker ON, click Pointer > New.  A pointer and description (pointer ID and X-
Y coordinate values) appear.  Then move the pointer you desire by using the rotary knob or the 
mouse wheel.

The following functions are available for the selected pointer(s) or description(s) via the Pointer 
menu, the Pointer icons, or the right-click menu. 
Clicking on a pointer will select the pointer. To select the multiple pointers, click the pointer while 
holding down the Shift key on the keyboard. 
Clicking on a description will select the description of a pointer. To select the multiple descriptions, 
click the description while holding down the Shift key on the keyboard. 
Shape: Sets the shape of the selected pointer(s).
Hide Description/Show Description: Hides or shows the description of the selected pointer(s).
Delete: Deletes the selected pointer(s).
The rotary knob or the mouse wheel can be used to move the selected pointer in the VAR1 direction.  
The pointer can not be moved in the VAR2 direction.
Dragging a description of pointer moves this description of pointer.
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Data Status

If measurement unit detects any status while measurement, the status code is recorded with the 
measurement data.  In this example, a SMU detected the compliance condition in the drain channel, 
so the status code C is put just before the Idrain value.

SMU status code:
• C: Compliance
• T: Other channel compliance
• X: Oscillation
• V: Overflow

MFCMU status code:
• U: Unbalance
• D: I/V amp saturation
• V: Overflow
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To Change Graph Properties

The Graph Properties dialog box is used to set the following setting of the selected Data Display 
window.  This dialog box is opened by clicking the Properties... button in the X-Y Graph Plot area or 
by selecting the Edit > Graph Properties... menu of the Data Display window.
The Grid ON check box in the Effective Area is used to display the grid in the X-Y Graph.
The Graph Color area is used to set the color map for the Data Display window. You can change the 
color of the background, text, graph grid, and line/cursor. The color palette is opened by clicking the 
pattern of the item.
The Graph Trace Color area is used to set visibility, color, and thickness of the data traces Y1 to Y8 
plotted on the graph.
The Log Scale area is used to set the maximum number of decades to show the minor ticks for the 
log axis. If the number of graph decades is less than or equal to the entered value, the minor ticks are 
displayed. If it is greater than the entered value, the minor ticks are not displayed.

The Text Size area is used to set the font size for the graph. The available settings are Largest, Large, 
Medium, Small, Smallest, and Fixed. For settings other than Fixed, the appropriate size is 
automatically selected. For Fixed, a font size entry field is provided, and the specified font size is 
always applied.

•X/Y Axis Title: Font size for the axis title
•Scale: Font size for the X and Y coordinate values
•Legend: Font size for the graph legend
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To Change List Display Properties
Edit > List Display Properties…

Example: -1.2345 mA
Example: -1.23456789012345E-003 A

Example: C -1.2345 V

Data Status
Physical Unit

This dialog box is used to set the data display format in the List Display area.  This dialog box is 
opened by clicking the Properties... button in the List Display area or by selecting Edit > List Display 
Properties... menu of the Data Display window. 
Display: 
Check the following check box to add the data status or the physical unit to data. Unchecking the box 
removes it.
•Data Status: Adds or removes the status code before data.
•Physical Unit: Adds or removes the physical unit after data.
Number Format:
Selects the data display format from the following formats.
• Engineering Format (with Unit Prefix):
Data display with arithmetic point, SI prefix, and unit.
Example: -1.2345 mA
• Scientific Notation:
Data display with arithmetic point, exponential part (E, +/- sign, and three-digit number), and unit.
Example: -1.23456789012345E-003 A
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To Change Display Setup
View > Display Setup…

This dialog box is used to change the graph scale and data to be displayed in the Data Display 
window.
The X-Y Graph area sets the X and Y1 to Y8 axes of the X-Y Graph Plot area.
Name: Specifies the parameter for the axis
•Sharing: Specifies the group for sharing the Y axis scale. Select from Group 1, Group 2, Group 3, 
Group 4, or None (no grouping). The Scale, Min, and Max values are shared by the Y axes in the 
same group. The scale set by Run Time Auto Scale, Auto Scale, Zoom in, and/or Zoom out are also 
shared. If another layer on the Data Display window contains an X-Y trace which has the same name 
for both its grouped Y parameter and its X parameter, the scaling will also be shared by this X-Y 
trace. 
•Scale: Scale of the axis, Linear or Log
•Min: Minimum value of the axis
•Max: Maximum value of the axis
The List Display area selects the variables to be listed in the List Display area.  Up to 20 variables 
can be set.
The Parameters area selects the variables to be listed in the Parameters area.  Up to 20 parameters 
can be set.
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To See Print Preview
File > Print Preview…

The Data Display window provides the File > Print Preview… function to show the print preview.  
This is an example of the print preview.
•Select the File > Print Preview menu to open the Print Preview dialog box.
•Set the Print Range, Data to print, and Scaling.
•Click Preview button.  The Print preview window is displayed.
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To Print Display Data

bmp, emf, gif, or png format

File > Print File > Save Image As…

The Data Display window provides the display image output capability to a printer or a file.
Before printing, connect a printer to the B1500A via the parallel interface or the LAN, and set up it 
by using the Add Printer Wizard of Windows.  After that, do following.
•Select the File > Print menu to open the Print dialog box.
•Set the Print Range, Data to print, and Scaling.
•Click Next button.
•Select the printer, and set the Properties.
•Click OK button.

You can export the display image to a file as shown below.
•Select the File > Save Image As… menu to open the Save Image As… dialog box.
•Select the format (file type) from Save As Type menu.
•Enter the file name.
•Click Save button.
The file can be imported by the graphics software that supports the exported file type.  The 
EasyEXPERT supports the following types.
•bmp: Bitmap image
•emf: Enhanced metafile
•gif: GIF image
•png: PNG image
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To Copy Graph Plot

Paste to WordPad

You can copy graph image to the clipboard, and paste it to a word processing software.  In the above 
example, the graph image is pasted to the WordPad.
This is an example of the copy and paste operation.
•Select the Edit > Copy Graph menu on the Data Display window.
•Select the Edit > Paste menu on the WordPad.
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To Copy List Data

Paste to Notepad

Open by a spreadsheet software

You can copy the data list to the clipboard, and paste it to a word processing software.  In the above 
example, the data list is pasted to the Notepad.
This is an example of the copy and paste operation.
•Select the Edit > Copy List menu on the Data Display window.
•Select the Edit > Paste menu on the Notepad.
You can save the data as a text file, and read it by using a spreadsheet software.  Data elements are 
separated by a tab.
Note:
As same as the Copy List function, the Copy Parameter function is used to copy the data in the 
Parameter area.
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To Save Analysis Result
Select File > Update Test Result
Select File > Save Image As…

Saves graph information to data record.

Saves graph image as a file.

To leave the graph modification information such as scaling, marker, cursor, and line on the graph, 
select the File > Update Test Result menu.
You can see the all information when you open the graph again.  Note that the modification 
information will be destroyed if you did not do it. 

To save the graph image as a file, select the File > Save Image As… menu.
You can save the image as a bmp, emf, gif, or png file.



Module 3
Data Display and Management

3-28

Class Exercise

Use the analysis tools.

1. Use your test setup (for example, GMMAX in the 
Demo preset group) and perform measurement .

2. Enable marker and draw line.  Try it for all line 
types.

3. Copy/paste/save data list, and open it by using a 
spreadsheet software (optional, if you can).

4. Save analysis condition.  Re-open the test record.

5. Export your test record.  And import it. 

Note:
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To Use Preview Window

The Data Display window provides the File > Print… function to print the graph image.  However, 
you may want to set the graph title and change the line style.  Then use the Preview window.  The 
Preview window is used to see and print the graph image you modified.
Select the View > Open Preview Window to open the Preview window and the Preview Settings 
dialog box.  And use the Preview Settings dialog box to set the title of graph, X axis, and Y axis, and 
change the line style.  To change the color and thickness, use the Color and Thickness dialog box 
opened by clicking the Color and Thickness… button.
Clicking OK button in the Preview Settings dialog box applies the modification to the Preview 
window and closes the dialog box.
Note:
The graph image in the Preview window cannot be saved.
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To Use Preview Window

This example is result of the changes shown in the previous page.
Line style was changed as shown above.  The titles are set as follows.
Graph title: ID-VG Characteristics
X axis title: Gate Voltage
Y1 axis title: Drain Current
Y2 axis title: Transconductance
Y3 axis title: Drain Current
Also color of line1 was changed to red, and thickness of trace was changed.

To change the setup again, open the Preview Settings dialog box by selecting the View > Preview 
Settings… menu.
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Class Exercise

Use the Preview window.

1. Use your test record used in the previous exercise.

2. Change the graph image as you want.
- Add graph title and change axis title.
- Change line style
- Change color and thickness

3. Print the graph image if a printer is available. 

Note:
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4 Classic Test Environment
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In This Module

• Classic Test Execution Mode

• I/V Sweep Measurement

• Multi Channel I/V Sweep Measurement

• I/V List Sweep Measurement

• I/V-t Sampling Measurement

• C-V Sweep Measurement

• Switching Matrix Control

• Direct Control

Note:
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Classic Test Execution Mode

• I/V Sweep
• Multi Channel I/V Sweep 
• I/V List Sweep
• I/V-t Sampling
• C-V Sweep
• Switching Matrix Control
• Direct Control

To use the classic test mode, click the Classic Test tab.  And select the execution mode.  The 
following modes are available.
•I/V Sweep: For X-Y characteristics measurement of I or V.
•Multi Channel I/V Sweep: For simultaneous multi channel (up to 10) sweep measurement of I or V.
•I/V List Sweep: For multi channel (up to 10) I/V sweep measurement using list data.
•I/V-t Sampling: For time-Y characteristics measurement of I or V.
•C-V Sweep: For DC bias-impedance characteristics measurement.
•Switching Matrix Control: For B2200 switching matrix control.
•Direct Control: For various measurements (e.g. C-f measurement, Quasi-Static C-V measurement) 
using Agilent FLEX commands.
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I/V Sweep Measurement

• To Define Source/Measurement Channels
• To Read Time Stamp Data and Data Index
• To Set Source Outputs (VAR1, VAR2, VAR1’, Pulse, CONST)
• To Set Timing Parameters
• To Set Sweep Abort Function
• Range, ADC/Integ, Advanced
• To Set User Functions
• To Set Analysis Functions
• To Set Auto Analysis Function
• To Set Display Parameters (X-Y Graph, Data List, Parameter)

This section explains how to perform I/V sweep measurement.  You will perform the above tasks to 
execute the I/V sweep measurement.
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Channel Setup

Channel Definition
-SMU
-V name/I name
-I/V/IPULSE/VPULSE/COMMON
-VAR1/VAR2/VAR1’/CONST

Setup Name

SMU1

SMU3

SMU4

SMU2

To Define Source/Measurement Channels

Click the I/V Sweep icon and open the setup editor.  Then click the Channel Definition tab to display 
the channel definition screen. 
•Enter the Setup Name for the test setup to be defined on the setup editor.
•List SMUs used for source output or measurement, and set the following parameters.

•Unit: SMU name or number
•V Name: Variable name for the voltage measurement or source data
•I Name: Variable name for the current measurement or source data
•Mode: Source output mode, V (voltage), I (current), VPULSE (voltage pulse), IPULSE (current 
pulse), or COMMON (ground)
•Function: Source output function, VAR1 (primary sweep), VAR2 (secondary sweep), VAR1’
(synchronous sweep), CONST (constant)

V Name and I Name are used to specify the parameters displayed on the Data Display window.  The 
display parameters are selected on the Display Setup tab screen.
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To Read Time Stamp Data and Index
Channel Setup

Variable name for time stamp data

Variable name for data index

You can read measurement data by using the Data Display window. Parameters displayed on the 
window are selected on the Display Setup tab screen.  If you enter the variable name in the V Name, 
I Name, Time Stamp Name, and/or Index Name entry fields, you can choose the variables as the 
display parameters.
•The time stamp is the time the measurement is started for each measurement point.
•The index is the index number for each measurement data.
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To Set Primary Sweep Source
Measurement Setup

Start

Stop
Step

VAR1

The Measurement Setup tab screen is used to set the source output value and timing parameters.  
At the VAR1 area, you set the primary sweep source output.
•Unit: SMU name or number
•Name: Variable name of source output
•Direction: Single (start to stop) or Double (start to stop to start)
•Linear/Log: Linear sweep or Log sweep
•Start: Source output start value
•Stop: Source output stop value
•Step: Source output incremental step value
•No of Step: Number of sweep steps
•Compliance: SMU compliance value
•Pwr Comp: SMU power compliance value
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To Set Secondary Sweep Source
Measurement Setup

VAR2

VAR1

At the VAR2 area, you set the secondary sweep source output.
•Unit: SMU name or number
•Name: Variable name of source output
•Start: Source output start value
•Stop: Source output stop value
•Step: Source output incremental step value
•No of Step: Number of sweep steps
•Compliance: SMU compliance value
•Pwr Comp: SMU power compliance value
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To Set Synchronous Sweep Source
Measurement Setup

VAR1’

VAR1

At the VAR1’ area, you set the synchronous sweep source output.
•Unit: SMU name or number
•Name: Variable name of source output
•Offset: B value of the above formula.
•Ratio: A value of the above formula.
•Compliance: SMU compliance value
•Pwr Comp: SMU power compliance value

The VAR1’ output is expressed by the following formula.
VAR1’ output = A × (VAR1 output) + B
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To Set Pulse Output
Measurement Setup

Period

Hold time

Width Width

Delay time cannot be set.

Trigger

Base

At the SMU Pulse area, you set the SMU pulse timing parameter and the pulse base value.
•Unit: SMU name or number
•Period: Pulse period
•Width: Pulse width
•Base: Pulse base value

Only a SMU can be set to the pulse source.
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To Set Constant Output
Measurement Setup

At the Constants area, you set the SMU constant output.
•Unit: SMU name or number
•V Name: Variable name for the voltage measurement or source data
•I Name: Variable name for the current measurement or source data
•Mode: Source output mode, V (voltage), I (current), VPULSE (voltage pulse), IPULSE (current 
pulse), or COMMON (ground)
•Source: SMU output value
•Compliance: SMU compliance value
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To Set Timing Parameters
Measurement Setup

Hold time
Delay time

Measurement time

Trigger

At the Timing area, you set the source output and measurement timing.
•Hold: Source output hold time. Time after the measurement trigger until starting delay time.
•Delay: Measurement start delay time. Time after the hold time until starting measurement.

When a SMU forces pulse, the delay time is ignored.  Source output and measurement timing will be 
controlled by the pulse width and pulse period.
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To Set Sweep Abort Function
Measurement Setup

CONTINUE AT ANY
STOP AT ANY ABNORMAL
-Range overflow
-SMU compliance
-SMU oscillation

This field sets the sweep abort function.
When this field is CONTINUE AT ANY, the sweep measurement is not aborted.
When this field is STOP AT ANY ABNORMAL, the sweep measurement will be aborted when one 
of the following conditions is detected.
•Measurement range overflow
•SMU compliance
•SMU oscillation
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To Set Ranging Mode
Measurement Setup

Not available when 
a pulse source is used

The Range button opens the SMU Range Setup dialog box.  The dialog box is used to set the 
measurement ranging mode.  This button is not available when a pulse source is used.
•Unit: SMU name or number
•Name: Variable name for the measurement data
•Mode: Ranging mode, AUTO, LIMITED, or FIXED
•Range: Range value
•Range Change Rule: BY FULL RANGE, GO UP AHEAD, or UP AND DOWN AHEAD
•Rate: Value used for range changing.  See the following formula.
For the AUTO or LIMITED, SMU automatically selects the minimum range that covers the 
measurement value, and performs the measurement by using the range.  For the limited auto ranging, 
the instrument does not use the range lower than the specified range value.  For example, if you 
select the 100 nA limited auto ranging, the instrument never uses the 10 nA range and below. 
BY FULL RANGE performs normal auto ranging operation.
For the GO UP AHEAD and UP AND DOWN AHEAD rules, specify the Rate value, 11 to 100, 
which fixes the boundary of the ranging. The ranging occurs when the measurement data goes across 
the boundary values shown below.
go up boundary = present measurement range × Rate / 100
go down boundary = present measurement range × Rate / 1000
The go down boundary is available only for the UP AND DOWN AHEAD rule.
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To Set ADC/Integration Time
Measurement Setup

Not available when 
a pulse source is used

The ADC/Integ button opens the A/D Converter & Integration Time Setup dialog box.  The dialog 
box is used to select the ADC for each SMU and set the integration time for each ADC (high 
resolution or high speed).  This button is not available when a pulse source is used.
A/D Converter:
•Unit: SMU name or number
•Name: Variable name of the measurement data
•ADC: ADC type, HR ADC (high resolution) or HS ADC (high speed)
Integration Time:
•Mode: AUTO, MANUAL, or PLC.  Rule to decide the integration time.  For details, see online help 
or User’s Guide.
•Factor: Coefficient for the reference value of the integration time.
•Auto Zero: Auto Zero function ON or OFF.  For HR ADC.
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Advanced Setup
Measurement Setup

The Advanced button opens the Advanced Setup dialog box.  The dialog box is used to set the SMU 
filter and SMU series resistor settings, and set the wait time.
Channel Settings:
•Unit: SMU name or number
•V Name: Variable name for the voltage measurement or source data
•I Name: Variable name for the current measurement or source data
•Series R: SMU series resistor NONE or 1MOHM (1000000 ohm)
•SMU Filter: SMU filter ON or OFF
Wait Time Control:
•Factor: Coefficient for the reference value of the wait time.  For details, see online help or User’s 
Guide.
After Measurement Settings:
•Bias Hold after Measurement: Bias hold function ON or OFF.
•Output Value after Measurement: Source output value after measurement.  START (sweep start 
value), STOP (sweep stop value), SOURCE (sampling output source value), or BASE (sampling 
output base value)
Note: Pulse channel output after measurement is always Base value.
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To Set User Functions
Function Setup

Data calculation
-Measurement data/source data
-Built-in function, etc.

Click the Function Setup tab to display the User Function/Analysis Function setup screen.  The user 
functions can be displayed on the X-Y Graph Plot, List Display, and Parameters area of the Data 
Display window.  Up to 20 functions can be set.
Name: Function name
Unit: Unit of the function
Definition: Definition of the function.  The following identifiers can be used.
-Variables for the measurement/output data used in this test
-Functions defined in the above lines
-Local variables passed from the application test that calls this test as a component
-Built-in functions and global variables
For details, see online help or User’s Guide.
Note:
The Apply button performs calculation of the definition in this screen. If this button is clicked when 
the Data Display window associated with this test has been opened, the display is also updated.  The 
associated Data Display window will be the Data Display window that displays the last measurement 
data or that is recalled at last.
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To Set Analysis Functions
Function Setup

Data calculation
-Measurement data/source data
-Read out function
-Built-in function, etc.

The analysis functions can be displayed on the Parameters area of the Data Display window.  Up to 
20 functions can be set.
Name: Function name
Unit: Unit of the function
Definition: Definition of the function. The following identifiers can be used.
-Variables for the measurement/output data used in this test
-Functions defined in the above lines
-Local variables passed from the application test that calls this test as a component
-Built-in functions and global variables
-Read out functions
For details, see online help or User’s Guide.
Note:
The Apply button performs calculation of the definition in this screen. If this button is clicked when 
the Data Display window associated with this test has been opened, the display is also updated.  The 
associated Data Display window will be the Data Display window that displays the last measurement 
data or that is recalled at last.
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To Set Auto Analysis Function

Interpolation

Line 1 setup

Line 2 setup

Marker setup

Auto Analysis Setup

Click the Auto Analysis Setup tab to display the auto analysis setup screen.  The auto analysis 
capability allows you to display/move the marker/line on the data graph automatically after 
measurement.  The above example displays marker at Vd=1 V point and draw a tangent line for this 
point.
Interpolation Mode:  Check this box to enable the interpolation mode. You can position marker 
between measurement points. 
Line 1, Line 2:  This area sets the line 1 or line 2 automatically displayed and moved to the specified 
position after the measurement.  Check Enable box to enable the line.
For Type, select a line type, Normal, Gradient, Tangent, or Regression.
For Axis, select the axis effective for the line.
In First Point and Second Point, specify the cursor points used to draw line.
In Gradient, specify the slope of the Gradient line.
Marker:  This area sets the marker automatically displayed and moved to the specified position after 
the measurement.  Check Enable box to enable the marker.
For Condition, enter a variable name and a condition expression to specify where you want the 
marker to display.
For After, check this box to enable the additional condition.  And enter a second variable and 
condition expression. This sets up a search start condition for finding specified point.
For example, you can specify the following expressions to search for a measurement point that 
satisfies the first condition after the second condition is satisfied.
Condition: [DGM] = [MAX(DGM)*0.01] [x] After [DGM] = [MAX(DGM)]
Note:
The Apply button performs calculation of the definition in this screen. If this button is clicked when 
the Data Display window associated with this test has been opened, the display is also updated.  The 
associated Data Display window will be the Data Display window that displays the last measurement 
data or that is recalled at last.
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To Set X-Y Graph Display
Display Setup

Specify X axis and Y axis

Click the Display Setup tab to display the display setup screen. The X-Y Graph area is used to set 
the X axis and Y axis of the X-Y Graph Plot area in the Data Display window.
•Name: Name of variable to plot on the X axis
•Scale: Linear or Log
•Min: Minimum value of the specified axis
•Max: Maximum value of the specified axis
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To Set Data List Display
Display Setup

Select variables to list

The List Display area selects the variables to be listed in the List Display area of the Data Display 
window.  Up to 20 variables can be set.
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To Set Parameters Display
Display Setup

Select parameters to display

The Parameters area selects the variables to be listed in the Parameters area of the Data Display 
window.  Up to 20 parameters can be set.
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To Save Test Setup

Preset Group name.
Use this field to 
select preset group.

My Favorite Setup button

The test setups you create MUST be saved to the internal hard disk drive as “My Favorite Setup”.
To save the setup, click the Save button.
To recall the setup, click the Recall button.

You can organize the setups by using Preset Group.  In the above example, the Demo group is 
selected and listed in the “My Favorite Setup”.

To create a new preset group, click the My Favorite Setup button to display the function menu, and 
select Add New Preset Group. 
To select the available preset group, use the field below the My Favorite Setup button.
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To Export/Import Your Preset Group

My Favorite Setup button

You can export/import your preset group.

To export the present preset group, click the My Favorite Setup button, select Export, and specify the 
folder and the name of the preset group to export. 

To import the preset group, click the My Favorite Setup button, select Import, and specify the preset 
group to import. 
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Class Exercise

Define test setup and perform test.

1. Click I/V Sweep icon and open setup editor.

2. Define test setup as shown in the previous pages.

3. Save it as Trng Id-Vd.

4. Connect device, and perform test.

5. Export preset group, and import it. SMU4

SMU2

SMU1

SMU3

Note:



Module 4
Classic Test Environment

4-26

Measurement Result Example

This is a test result example displayed on the Data Display window.
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Multi Channel I/V Sweep

• To Define Source/Measurement Channels

• To Set Var1 Sweep Sources

• To Set Constant Output

• To Set Ranging Mode

• To Set ADC/Integration Time

• Advanced Setup

• To Set User Functions

• To Set Data Display

This section explains how to perform the Multi Channel I/V sweep measurement.  You will perform 
the above tasks to execute the Multi Channel I/V sweep measurement.
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Multi Channel I/V Sweep

Start measurement

Voltage or current
Stop value

Start value
0

Time

: Measurement

Hold time

Delay timeStop value

Start value
0

Voltage or current

Stop value

Start value
0

Voltage or current

Primary sweep source

Second sweep source

Tenth sweep source

Delay time

Multi Channel I/V Sweep measurement is similar to I/V Sweep measurement.
Changes from I/V Sweep are listed below.
•All SMU can be set to the VAR1 sweep source (up to 10 channels)
•Both voltage mode and current mode are available for the VAR1 sweep output
•VAR1’ sweep output is not available
•SMU pulse output is not available
The output channels start to output in the order in which they are listed on the Channel Setup screen. 
If multiple measurement channel are used, the channels perform the measurements in order.
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Channel Setup

Channel Definition
-SMU
-V name/I name
-I/V/COMMON
-VAR1/VAR2/CONST

Setup Name

To Define Source/Measurement Channels

Click the Multi Channel I/V Sweep icon and open the setup editor.  Then click the Channel Setup tab 
to display the channel definition screen. 
•Enter the Setup Name for the test setup to be defined on the setup editor.
•List SMUs used for source output or measurement, and set the following parameters.

•Unit: SMU name or number
•V Name: Variable name for the voltage measurement or source data
•I Name: Variable name for the current measurement or source data
•Mode: Source output mode, V (voltage), I (current), or COMMON (ground)
•Function: Source output function, VAR1 (primary sweep), VAR2 (secondary sweep), CONST 
(constant)
Note: Up to 10 sources can be set to VAR1.

V Name and I Name are used to specify the parameters displayed on the Data Display window.  The 
display parameters are selected on the Display Setup tab screen.
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To Set VAR1 Sweep Sources
Measurement Setup

Start

Stop
SMU1

Start

Stop
SMU2

The Measurement Setup tab screen is used to set the source output value and timing parameters.  
At the VAR1 area, you set VAR1 sweep sources.
Follows are common parameters for all VAR1 sweep sources.
•Direction: Single (start to stop) or Double (start to stop to start) 
•Linear/Log: Linear sweep or Log sweep
•No of Step: Number of sweep steps
Following parameters can be set for each VAR1 sweep sources.
•Unit: SMU name or number
•Name: Variable name of source output
•Start: Source output start value
•Stop: Source output stop value
•Compliance: SMU compliance value
•Pwr Comp: SMU power compliance value
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To Set Constant Output
Measurement Setup

At the Constants area, you set the SMU constant output.
•Unit: SMU name or number
•V Name: Variable name for the voltage measurement or source data
•I Name: Variable name for the current measurement or source data
•Mode: Source output mode, V (voltage), I (current), or COMMON (ground)
•Source: SMU output value
•Compliance: SMU compliance value
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To Set Ranging Mode
Measurement Setup

The Range button opens the SMU Range Setup dialog box.  The dialog box is used to set the 
measurement ranging mode. 
•Unit: SMU name or number
•Name: Variable name for the measurement data
•Mode: Ranging mode, AUTO, LIMITED, or FIXED
•Range: Range value
•Range Change Rule: BY FULL RANGE, GO UP AHEAD, or UP AND DOWN AHEAD
•Rate: Value used for range changing.  See the following formula.
For the AUTO or LIMITED, SMU automatically selects the minimum range that covers the 
measurement value, and performs the measurement by using the range.  For the limited auto ranging, 
the instrument does not use the range lower than the specified range value.  For example, if you 
select the 100 nA limited auto ranging, the instrument never uses the 10 nA range and below. 
BY FULL RANGE performs normal auto ranging operation.
For the GO UP AHEAD and UP AND DOWN AHEAD rules, specify the Rate value, 11 to 100, 
which fixes the boundary of the ranging. The ranging occurs when the measurement data goes across 
the boundary values shown below.
go up boundary = present measurement range × Rate / 100
go down boundary = present measurement range × Rate / 1000
The go down boundary is available only for the UP AND DOWN AHEAD rule.
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To Set ADC/Integration Time
Measurement Setup

The ADC/Integ button opens the A/D Converter & Integration Time Setup dialog box.  The dialog 
box is used to select the ADC for each SMU and set the integration time for each ADC (high 
resolution or high speed).  This button is not available when a pulse source is used.
A/D Converter:
•Unit: SMU name or number
•Name: Variable name of the measurement data
•ADC: ADC type, HR ADC (high resolution) or HS ADC (high speed)
Integration Time:
•Mode: AUTO, MANUAL, or PLC.  Rule to decide the integration time.  For details, see online help 
or User’s Guide.
•Factor: Coefficient for the reference value of the integration time.
•Auto Zero: Auto Zero function ON or OFF.  For HR ADC.
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Advanced Setup
Measurement Setup

The Advanced button opens the Advanced Setup dialog box.  The dialog box is used to set the SMU 
filter and SMU series resistor settings, and set the wait time.
Channel Settings:
•Unit: SMU name or number
•V Name: Variable name for the voltage measurement or source data
•I Name: Variable name for the current measurement or source data
•Series R: SMU series resistor NONE or 1MOHM (1000000 ohm)
•SMU Filter: SMU filter ON or OFF
Wait Time Control:
•Factor: Coefficient for the reference value of the wait time.  For details, see online help or User’s 
Guide.
After Measurement Settings:
•Bias Hold after Measurement: Bias hold function ON or OFF.
•Output Value after Measurement: Source output value after measurement.  START (sweep start 
value), STOP (sweep stop value).
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To Set User Functions
Function Setup

Data calculation
-Measurement data/source data
-Built-in function, etc.

Click the Function Setup tab to display the User Function/Analysis Function setup screen.  The user 
functions can be displayed on the X-Y Graph Plot, List Display, and Parameters area of the Data 
Display window.  Up to 20 functions can be set.
Name: Function name
Unit: Unit of the function
Definition: Definition of the function.  The following identifiers can be used.
-Variables for the measurement/output data used in this test
-Functions defined in the above lines
-Local variables passed from the application test that calls this test as a component
-Built-in functions and global variables
For details, see online help or User’s Guide.
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To Set Data Display
Display Setup

Specify X axis and Y axes

Select variables to list

Click the Display Setup tab to display the display setup screen.
The X-Y Graph area is used to set the X axis and Y axes of the X-Y Graph Plot area in the Data 
Display window.
•Name: Name of variable to plot on the X axis
•Scale: Linear or Log
•Min: Minimum value of the specified axis
•Max: Maximum value of the specified axis
The List Display area selects the variables to be listed in the List Display area of the Data Display 
window.  Up to 20 variables can be set.
For example, following variables are set for the Class Exercise.
Vbe, Ic, Ib, Vh, Ih
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Class Exercise

Define test setup and perform test.

1. Click Multi Channel I/V Sweep icon and open setup 
editor.

2. Define test setup as shown in the previous pages.

3. Save it as Trng Multi.

4. Connect devices (NPN Bipolar Transistor and Red 
Miniature LED) as shown in next several pages, and 
perform test.

5. Export preset group, and import it. 

Note:
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SMU Triax Connection

Force Lines to Fixture 1,2,3,4 Ports

16442A/B Fixture

B1500A Rear View

SMU4
SMU3
SMU2

SMU1

CMU

GNDU

Force side Sense side

For the non-Kelvin connections, connect only the Force lines, leaving the Sense lines open.

Connect corresponding numbers.  On the 16442A/B fixture use the numbers labeled 1 - 6, not 1 - 3. 

Your B1500A may not match the SMU configuration shown in this figure.  Note that SMU1 is the 
module top of the GNDU (ground unit).  The SMU number become large from bottom to top as 
shown.

This is the SMU cable setup that will be used in the remainder of the class exercises.
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Jumper Leads - MOS transistor

1 2 3 4 5 6

7 8 9 10 11 12

13 14 15 16 17 18

2019 21 22 23 24

25

27

26

28

14

1528

1

F

G

3
F

G

4
F

G

5
F

G

6
F

G

2
F

G

1
SMU

21
VMU

21
VSU

F

S

GNDU

F
2

F
1

PGU

B

E
C

17: Emitter
16: Base
15: Collector

E B C

13 14

Shorter Lead

For all class exercises, you need the 28-pin dual in line socket which comes standard with the 4145 
fixture (16058A) or the newer fixture (16442A/B).  Either fixture works fine.

With the 16442A/B fixture, note that there are two SMU numbering schemes....3 SMUs with force 
and sense, or six SMUs with force only.   For this class example we will use the six (6) SMU scheme. 

Connect jumper leads as follows.
Terminal 13 : SMU1 F terminal
Terminal 14 : GNDU F terminal
Terminal 15 : SMU4 F terminal
Terminal 16 : SMU3 F terminal
Terminal 17 : SMU2 F terminal

Locate the bipolar transistor in the corner of the 28-pin dual in line socket as shown, with the flat side 
of the device facing toward you. Unlike the MOS device, the bipolar transistor is not static sensitive.  
You may touch the leads without using a ground strap.
Locate the LED between terminals 13 and 14 of the 28-pin dual in line socket.
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Measurement Result Example

This is a test result example displayed on the Data Display window. 
At the start of measurement, LED lights off.  Beyond the threshold voltage, the LED lights on. 
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I/V List Sweep

• To Define Source/Measurement Channels

• To Set Var1 Sweep Sources

• To Set Constant Output

• To Set Ranging Mode

• To Set ADC/Integration Time

• Advanced Setup

• To Set User/Analysis Functions

• Auto Analysis Setup

• To Set Data Display

This section explains how to perform I/V List sweep measurement. You will perform the above 
tasks to execute the I/V List sweep measurement. 
I/V List Sweep measurement is similar to I/V Sweep measurement.
Changes from the I/V Sweep are listed below.
•VAR1/VAR2 step output values are set by using a vector data. Vector data from a spreadsheet 
software, either tab separated  or comma separated can be copied to the Define vector data dialog 
box via the Windows clipboard. 
•All SMU installed in the B1500A can be set to VAR1.
•VAR1’ is not supported.
For more information, see online help or User’s Guide.



Module 4
Classic Test Environment

4-42

Channel Setup

Channel Definition
-SMU
-V name/I name
-V/I/VPULSE/IPULSE/COMMON
-VAR1/VAR2/CONST

Setup Name

To Define Source/Measurement Channels

Click the I/V List Sweep icon and open the setup editor.  Then click the Channel Setup tab to display 
the channel definition screen. 
•Enter the Setup Name for the test setup to be defined on the setup editor.
•List SMUs used for source output or measurement, and set the following parameters.

•Unit: SMU name or number
•V Name: Variable name for the voltage measurement or source data
•I Name: Variable name for the current measurement or source data
•Mode: Source output mode, V (voltage), I (current), VPULSE (voltage pulse), IPULSE (current 
pulse), or COMMON (ground)
•Function: Source output function, VAR1 (primary sweep), VAR2 (secondary sweep), or CONST 
(constant)
Note: Up to 10 sources can be set to VAR1.

V Name and I Name are used to specify the parameters displayed on the Data Display window.  The 
display parameters are selected on the Display Setup tab screen.
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To Set VAR1 Sweep Sources

Grid button

The Measurement Setup tab screen is used to set the source output value and timing parameters.  
At the VAR1 area, you set VAR1 sweep sources.
•Unit: SMU name or number
•Source: Click the grid button to open the Define vector data dialog box. Enter the vector data of 
VAR1. For example, -500 m, 0, 500 m, 1, 1,05,1.1, 1.15, 1.2, 1.25, 1.3, 1.35, 1.4, 1.45, 1.5, 1.55, 1.6, 
1.65, 1.7, 1.75, 1.8, 1.85, 1.9, 1.95, 2, 2.5, and 3 V are set for the Vth-gmMax. Step voltages near the 
gmMax are set to 50 mV and others are set to 500 mV.
•Compliance: SMU compliance value
•Pwr Comp: SMU power compliance value
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To Set Constant Output
Measurement Setup

At the Constants area, you set the SMU constant output.
•Unit: SMU name or number
•V Name: Variable name for the voltage measurement or source data
•I Name: Variable name for the current measurement or source data
•Mode: Source output mode, V (voltage), I (current), VPULSE (voltage pulse), IPULSE (current 
pulse), or COMMON (ground)
•Source: SMU output value. For example, Vdrain is set to 100 mV for the Vth-gmMax.
•Compliance: SMU compliance value
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To Set Ranging Mode
Measurement Setup

The Range button opens the SMU Range Setup dialog box.  The dialog box is used to set the 
measurement ranging mode. 
•Unit: SMU name or number
•Name: Variable name for the measurement data
•Mode: Ranging mode, AUTO, LIMITED, or FIXED
•Range: Range value
•Range Change Rule: BY FULL RANGE, GO UP AHEAD, or UP AND DOWN AHEAD
•Rate: Value used for range changing.  See the following formula.
For the AUTO or LIMITED, SMU automatically selects the minimum range that covers the 
measurement value, and performs the measurement by using the range.  For the limited auto ranging, 
the instrument does not use the range lower than the specified range value.  For example, if you 
select the 100 nA limited auto ranging, the instrument never uses the 10 nA range and below. 
BY FULL RANGE performs normal auto ranging operation.
For the GO UP AHEAD and UP AND DOWN AHEAD rules, specify the Rate value, 11 to 100, 
which fixes the boundary of the ranging. The ranging occurs when the measurement data goes across 
the boundary values shown below.
go up boundary = present measurement range × Rate / 100
go down boundary = present measurement range × Rate / 1000
The go down boundary is available only for the UP AND DOWN AHEAD rule.
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To Set ADC/Integration Time
Measurement Setup

The ADC/Integ button opens the A/D Converter & Integration Time Setup dialog box.  The dialog 
box is used to select the ADC for each SMU and set the integration time for each ADC (high 
resolution or high speed).  This button is not available when a pulse source is used.
A/D Converter:
•Unit: SMU name or number
•Name: Variable name of the measurement data
•ADC: ADC type, HR ADC (high resolution) or HS ADC (high speed)
Integration Time:
•Mode: AUTO, MANUAL, or PLC.  Rule to decide the integration time.  For details, see online help 
or User’s Guide.
•Factor: Coefficient for the reference value of the integration time.
•Auto Zero: Auto Zero function ON or OFF.  For HR ADC.
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Advanced Setup
Measurement Setup

The Advanced button opens the Advanced Setup dialog box.  The dialog box is used to set the SMU 
filter and SMU series resistor settings, and set the wait time.
Channel Settings:
•Unit: SMU name or number
•V Name: Variable name for the voltage measurement or source data
•I Name: Variable name for the current measurement or source data
•Series R: SMU series resistor NONE or 1MOHM (1000000 ohm)
•SMU Filter: SMU filter ON or OFF
Wait Time Control:
•Factor: Coefficient for the reference value of the wait time.  For details, see online help or User’s 
Guide.
After Measurement Settings:
•Bias Hold after Measurement: Bias hold function ON or OFF.
•Output Value after Measurement: Source output value after measurement.  START (sweep start 
value), STOP (sweep stop value).
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To Set User/Analysis Functions
Function Setup

Data calculation
-Measurement data/source data
-Built-in function, etc.

Click the Function Setup tab to display the User Function/Analysis Function setup screen.  The 
user/analysis functions can be displayed on the X-Y Graph Plot, List Display, and Parameters area of 
the Data Display window.  Up to 20 functions can be set.
Name: Function name
Unit: Unit of the function
Definition: Definition of the function.  The following identifiers can be used.
-Variables for the measurement/output data used in this test
-Functions defined in the above lines
-Local variables passed from the application test that calls this test as a component
-Built-in functions and global variables
For details, see online help or User’s Guide.

For example, following user/analysis functions are set for the Vth-gmMax.
<Name>  <Unit>  <Definition>
Gm          S        diff(Idrain,Vgate)
gmMax    S         max(gm)
Von         V         @L1X
Vth          V         Von-(Vdrain/2)

For built-in functions, see online help or User’s Guide.
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Auto Analysis Setup
Auto Analysis Setup

Click the Auto Analysis Setup tab to display the Auto Analysis setup screen. This screen is used to 
set the automatic analysis function. When a measurement finishes, the function automatically draws 
lines, a marker, or both on the X-Y Graph of the Data Display window.
You can set up two lines and one marker for the automatic analysis function. 
In the Line 1 and Line 2 areas, you can set up the lines to be drawn. 
In the Marker area, you can set up the marker.
For details, see online help or User’s Guide.

For example, the Line 1 is set for the Vth-gmMax .
Type: Tangent
Axis: Y1
First Point: Data Condition
Condition: gm = gmMax
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To Set Data Display
Display Setup

Specify X axis and Y axes
Select variables to list Select parameters to list

Click the Display Setup tab to display the display setup screen.
The X-Y Graph area is used to set the X axis and Y axes of the X-Y Graph Plot area in the Data Display 
window.
•Name: Name of variable to plot on the X axis
•Scale: Linear or Log
•Min: Minimum value of the specified axis
•Max: Maximum value of the specified axis
For example, following axes are set  for the Vth-gmMax.

<Name> <Sharing> <Scale>  <Min>     <Max>
X     Vgate                       Linear    -500 mV   3 V
Y1   Idrain     (None)       Linear    -1 mA     10 mA
Y2   gm         (None)       Linear      0 S         10 mS

The List Display area selects the variables to be listed in the List Display area of the Data Display window.  Up 
to 20 variables can be set.
For example, following variables are set for the Vth-gmMax.
Vgate, Vsource, Vdrain, Vsubs, Idrain, gm

The Parameters area selects the variables to be listed in the Parameters area of the Data Display window.  Up to 
20 parameters can be set.
For example, following parameters are set for the Vth-gmMax.
gmMax, Vth
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Class Exercise

Define test setup and perform test.

1. Click I/V List Sweep icon and open setup editor.

2. Define test setup as shown in the previous pages.

3. Save it as Trng List.

4. Connect an N-ch MOSFET as shown in next several 
pages, and perform test.

5. Export preset group, and import it. 

Note:
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SMU Triax Connection

Force Lines to Fixture 1,2,3,4 Ports

16442A/B Fixture

B1500A Rear View

SMU4
SMU3
SMU2

SMU1

CMU

GNDU

Force side Sense side

For the non-Kelvin connections, connect only the Force lines, leaving the Sense lines open.

Connect corresponding numbers.  On the 16442A/B fixture use the numbers labeled 1 - 6, not 1 - 3. 

Your B1500A may not match the SMU configuration shown in this figure.  Note that SMU1 is the 
module top of the GNDU (ground unit).  The SMU number become large from bottom to top as 
shown.

This is the SMU cable setup that will be used in the remainder of the class exercises.
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Jumper Leads - MOS transistor

16088-60002
Dual in line package
(28 pin)
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For all class exercises, you need the 28-pin dual in line socket which comes standard with the 4145 
fixture (16058A) or the newer fixture (16442A/B).  Either fixture works fine.

With the 16442A/B fixture, note that there are two SMU numbering schemes....3 SMUs with force 
and sense, or six SMUs with force only.   For this class example we will use the six (6) SMU scheme.  
On older fixtures, this scheme is shown in light blue lettering. In newer fixtures, this scheme is 
shown in white reverse background lettering.
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Device Orientation and Insertion

Insert the transistor last, 
AFTER connecting the 
cables and leads.  Remove 
the shorting wire after 
insertion in the socket.

14

15

1
1: Substrate
2: Source
3: Gate
4: Drain

23
G

S D
Sub

The MOS FET leads must be re-arranged into a straight line as shown.

IMPORTANT:
The MOS FET is highly sensitive to electrostatic damage.  Touching the bare leads can definitely 
destroy the device.  The device comes with a special shorting wire attached.  Bend the leads the way 
you want, insert the device in the socket, and then remove the shorting wire.  The wire has a tab.  Just 
grab the tab and pull straight out.  The wire will spiral out as you pull.  

Once the shorting wire is removed, you must use a wrist strap when handling the device.
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Measurement Result Example

This is a test result example displayed on the Data Display window. 
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I/V-t Sampling Measurement

• To Define Channels and Variables

• To Set Sampling Parameters

• To Set SMU Outputs (CONST)

• Range/ADC/Advanced

• To Set User Functions/
Analysis Functions

• To Set Data Display

This section explains how to perform I/V-t sampling measurement.  You will perform the above tasks 
to execute the I/V-t sampling measurement.
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Channel Setup

GNDU

SMU1

Channel Definition
-SMU
-V name/I name
-I/V/COMMON
-CONST

Setup Name

Variable name for time stamp data
Variable name for data index

To Define Channels and Variables

Click the I/V-t Sampling icon and open the setup editor.  Then click the Channel Definition tab to 
display the channel definition screen. 
•Enter the Setup Name for the test setup to be defined on the setup editor.
•List SMUs used for source output or measurement, and set the following parameters.

•Unit: SMU name or number
•V Name: Variable name for the voltage measurement or source data
•I Name: Variable name for the current measurement or source data
•Mode: Source output mode, V (voltage), I (current), or COMMON (ground)
•Time Stamp Name: Variable name for the time stamp data
•Index Name: Variable name for the data index

You can read measurement data by using the Data Display window. Parameters displayed on the 
window are selected on the Display Setup tab screen.  If you enter the variable name in the V Name, 
I Name, Time Stamp Name, and/or Index Name entry fields, you can choose the variables as the 
display parameters.
•The time stamp is the time the measurement is started for each measurement point.
•The index is the index number for each measurement data.



Module 4
Classic Test Environment

4-58

To Set Sampling Parameters
Measurement Setup

Hold time

Measurement time

Sampling interval

TriggerSampling parameter

Click the Measurement Setup tab to display the setup screen for the sampling timing parameters and 
the SMU source output parameters.  At the Sampling Parameter area, you set the following sampling 
timing parameters.
Linear/Log:
Sampling mode. LINEAR for linear sampling. LOG10, LOG25, LOG50, LOG100, LOG250, or 
LOG500 for logarithmic sampling.  For the logarithmic sampling, the number after LOG indicates 
the number of measurement data in a decade. For example, LOG10 mode is used to get 10 
data/decade.
For the log sampling, the B1500A holds only the data that can be plotted on the log scale in the same 
distance as close as possible. Only the held data is counted in the number of measurement result data.
For the linear sampling with Interval < 2 ms, if the total measurement time runs over the specified 
time Interval × No of Samples, the sampling measurement will be stopped even if the number of 
measurement result data is less than the specified No of Samples.
Interval:
Interval of the sampling, in seconds. 0.002 to 65.535 s, 0.001 s resolution.
Interval < 0.002 s in 0.00001 s resolution is also available for the linear sampling.  It must satisfy the 
following formula.  For details, see online help or User’s Guide.
Interval ≥ 0.0001 + 0.00002 × (number of measurement channels-1)
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To Set Sampling Parameters
Measurement Setup

Sampling parameter

Hold time

Measurement time

Sampling interval

Trigger

No of Samples:
Number of samples. Integer. 1 to the following value.
For linear: 100001 / (number of measurement channels)
For logarithmic: 1 + (number of data for 11 decades)
Total Sampling Time:
This field just displays the total sampling time that is the time from the measurement start time for 
the first point to the end of sampling measurement. It does not include the hold time.
Total Sampling Time = Interval × No of Samples
Output Sequence:
Source output sequence. SIMULTANEOUS or SEQUENTIAL. 
Hold Time:
Time since the Source value output until the first sampling point, in seconds. 0 to 655.35 s, resolution 
0.01 s.
The following values are also available for Interval < 0.002 s.  |Hold Time| will be the time since the 
sampling start until the Source value output.
-0.09 to -0.0001 s, resolution 0.0001 s.
Base Hold Time:
Hold time of the Base value output until the Source value output, in seconds. 0 to 655.35 s, resolution 
0.01 s.
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To Set SMU Outputs (CONST)
Measurement Setup

SMU constant output setup

At the Constants area, you set the SMU constant output.
•Unit: SMU name or number
•V Name: Variable name for the voltage measurement or source data
•I Name: Variable name for the current measurement or source data
•Mode: Source output mode, V (voltage), I (current), or COMMON (ground)
•Base and Source: SMU output value
•Compliance: SMU compliance value
Base value is available for all output channels for the SIMULTANEOUS mode and the last source 
channel for the SEQUENTIAL mode.
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Range/ADC/Advanced
Measurement Setup

Fixed range mode

The Range button opens the SMU Range Setup dialog box.  
The ADC/Integ button opens the A/D Converter & Integration Time Setup dialog box.
The Advanced button opens the Advanced Setup dialog box.
For the dialog boxes, see the following pages respectively in the I/V Sweep section of this module.
To Set Ranging Mode
To Set ADC/Integration Time
Advanced Setup

Note:
If the range changing occurs during measurement, the SMU may not complete measurement within 
the sampling interval.  So use FIXED range if the sampling interval is top priority and the 
resolution/sensitivity is second priority.
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To Set User Functions/Analysis Functions
Function Setup

Data calculation
-Measurement data/source data
-Built-in function, etc.

Data calculation
-Measurement data/source data
-Read out function
-Built-in function, etc.

Click the Function Setup tab to display the User Function/Analysis Function setup screen.

The user functions can be displayed on the X-Y Graph Plot, List Display, and Parameters area of the Data 
Display window.  Up to 20 functions can be set.
•Name: Function name
•Unit: Unit of the function
•Definition: Definition of the function. The following identifiers can be used.

•Variables for the measurement/output data used in this test
•Functions defined in the above lines
•Local variables passed from the application test that calls this test as a component
•Built-in functions and global variables
For details, see online help or User’s Guide.

The analysis functions can be displayed on the Parameters area of the Data Display window.  Up to 20 functions 
can be set.
•Name: Function name
•Unit: Unit of the function
•Definition: Definition of the function. The following identifiers can be used.

•Variables for the measurement/output data used in this test
•Functions defined in the above lines
•Local variables passed from the application test that calls this test as a component
•Built-in functions and global variables
•Read out functions
For details, see online help or User’s Guide.
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To Set Data Display
Display Setup

Specify X axis and Y axis

Select parameters to display

Select variables to list

Click the Display Setup tab to display the display setup screen. The X-Y Graph area is used to set 
the X axis and Y axis of the X-Y Graph Plot area in the Data Display window.
•Name: Name of variable to plot on the X axis
•Scale: Linear or Log
•Min: Minimum value of the specified axis
•Max: Maximum value of the specified axis

The List Display area selects the variables to be listed in the List Display area of the Data Display 
window.  Up to 20 variables can be set.

The Parameters area selects the variables to be listed in the Parameters area of the Data Display 
window.  Up to 20 parameters can be set.
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Class Exercise

Define test setup and perform test.

1. Click I/V-t Sampling icon and open setup editor.

2. Define test setup as shown in the previous pages.

3. Save it as Trng Sampling.

4. Connect device (capacitance), and perform test.

5. Export preset group, and import it. 

GNDU

SMU1

Note:
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Measurement Result Example

This is a test result example displayed on the Data Display window.
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C-V Sweep Measurement

• To Define Channels and Variables
• To Set Sweep Source
• To Set Signal Source
• To Set Measurement Timing and Abort Function
• To Set SMU Outputs (CONST)
• Range/Advanced
• To Set User Functions/

Analysis Functions
• To Set Data Display
• To Perform Compensation

and Correction

This section explains how to perform C-V sweep measurement.  You will perform the above tasks to 
execute the C-V sweep measurement.
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Channel Setup

Channel Definition
-CMU/SMU
-V name/I name
-I/V/COMMON

Setup Name

Variable name for time stamp data

Variable name for data index

SMU1

SMU2

CML

CMH

To Define Channels and Variables

Click the C-V Sweep icon and open the setup editor.  Then click the Channel Definition tab to 
display the channel definition screen. 
•Enter the Setup Name for the test setup to be defined on the setup editor.
•List units used for source output or measurement, and set the following parameters.

•Unit: MFCMU/SMU name or number
•V Name: Variable name for the voltage measurement or source data
•I Name: Variable name for the current measurement or source data
•Mode: Source output mode, V (voltage), I (current), or COMMON (ground)
•Time Stamp Name: Variable name for the time stamp data
•Index Name: Variable name for the data index

You can read measurement data by using the Data Display window. Parameters displayed on the 
window are selected on the Display Setup tab screen.  If you enter the variable name in the V Name, 
I Name, Time Stamp Name, and/or Index Name entry fields, you can choose the variables as the 
display parameters.
•The time stamp is the time the measurement is started for each measurement point.
•The index is the index number for each measurement data.
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To Set Sweep Source
Measurement Setup

CV sweep

Start

Stop
Step

The Measurement Setup tab screen is used to set the source output and timing parameters.  
At the C-V area, you set the DC bias output of the MFCMU.
•V Name: Variable name of the MFCMU output
•Model: MFCMU measurement mode. Primary and secondary measurement parameters. Select one 
from the following four models.

•Cp-G: Parallel capacitance (F) and Conductance (S)
•Cp-D: Parallel capacitance (F) and Dissipation factor
•Cs-Rs: Series capacitance (F) and Series resistance (ohm)
•Z-Th: Impedance (ohm) and Phase (degree)

•C/Z Name: Variable name of the primary measurement parameter, C or Z
•G/D/R/Th Name: Variable name of the secondary measurement parameter, G, D, R, or Th
•Direction: Sweep direction, single (start to stop) or double (start to stop to start)
•Start: Source output start value
•Stop: Source output stop value
•Step: Source output incremental step value
•No of Step: Number of sweep steps
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To Set Signal Source
Measurement Setup

At the Signal Source area, you set the MFCMU output frequency and oscillator level.
•Frequency List: MFCMU output frequency
•F Name: Variable name of MFCMU output frequency
•AC Level: MFCMU oscillator level, 10 mV to 250 mV, 1 mV resolution
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To Set Meas. Timing and Abort Function
Measurement Setup Integration time (AUTO or PLC)

Timing parameters

Sweep abort function

Hold time
Delay time

Measurement time

Trigger

CONTINUE AT ANY
STOP AT ANY ABNORMAL
-Range overflow
-MFCMU error
-SMU compliance
-SMU oscillation

At the Integration Time area, you set the integration time of the impedance measurement by the MFCMU.
•Mode: AUTO or PLC.  Rule to decide the integration time.  For details, see online help or User’s Guide.
•Factor: Coefficient for the reference value of the integration time.

At the Timing area, you set the source output and measurement timing.
•Hold: Source output hold time. Time after the measurement trigger until starting delay time.
•Delay: Measurement start delay time. Time after the hold time until starting measurement.

The Sweep [ ] status field sets the sweep abort function.
When this field is CONTINUE AT ANY, the sweep measurement is not aborted.
When this field is STOP AT ANY ABNORMAL, the sweep measurement will be aborted when one of the 
following conditions is detected.
•Measurement range overflow
•MFCMU error
•SMU compliance
•SMU oscillation
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To Set SMU Outputs (CONST)
Measurement Setup

SMU output setup

At the Constants area, you set the SMU constant output.
•Unit: SMU name or number
•V Name: Variable name for the voltage measurement or source data
•I Name: Variable name for the current measurement or source data
•Mode: Source output mode, V (voltage), I (current), or COMMON (ground)
•Source: SMU output value
•Compliance: SMU compliance value
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Range/Advanced
Measurement Setup

The Range button opens the CMU Range Setup dialog box.  The dialog box is used to set the 
measurement ranging operation.
•Unit: CMU name or number
•Mode: Ranging mode, AUTO or FIXED
•Range: Measurement range.  This field is effective when Mode=FIXED.
Available values are 50 ohm, 100 ohm to 300 kohm (=<200 kHz), 100 ohm to 30 kohm (=<2 MHz), 
and 100 ohm to 3 kohm (=<5 MHz) in 1, 3 step

The Advanced button opens the Advanced Setup dialog box used to set the following functions.
AC Level/DC Bias Monitor Settings:
Defines the variables for the AC level data and the DC bias data monitored by the MFCMU while 

the capacitance measurement is performed.
After Measurement Settings:
•Bias Hold after Measurement: Bias hold function ON or OFF.
•Output Value after Measurement: Source output value after measurement.  START (sweep start 
value) or STOP (sweep stop value)
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To Set User Functions/Analysis Functions
Function Setup

Data calculation
-Measurement data/source data
-Built-in function, etc.

Data calculation
-Measurement data/source data
-Read out function
-Built-in function, etc.

Click the Function Setup tab to display the User Function/Analysis Function setup screen.
The user functions can be displayed on the X-Y Graph Plot, List Display, and Parameters area of the 
Data Display window.  Up to 20 functions can be set.
•Name: Function name
•Unit: Unit of the function
•Definition: Definition of the function. The following identifiers can be used.

•Variables for the measurement/output data used in this test
•Functions defined in the above lines
•Local variables passed from the application test that calls this test as a component
•Built-in functions and global variables
For details, see online help or User’s Guide.

The analysis functions can be displayed on the Parameters area of the Data Display window.  Up to 
20 functions can be set.
•Name: Function name
•Unit: Unit of the function
•Definition: Definition of the function. The following identifiers can be used.

•Variables for the measurement/output data used in this test
•Functions defined in the above lines
•Local variables passed from the application test that calls this test as a component
•Built-in functions and global variables
•Read out functions
For details, see online help or User’s Guide.
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To Set Data Display
Display Setup

Specify X axis and Y axis

Select parameters to display

Select variables to list

Click the Display Setup tab to display the display setup screen. The X-Y Graph area is used to set 
the X axis and Y axis of the X-Y Graph Plot area in the Data Display window.
•Name: Name of variable to plot on the X axis
•Scale: Linear or Log
•Min: Minimum value of the specified axis
•Max: Maximum value of the specified axis

The List Display area selects the variables to be listed in the List Display area of the Data Display 
window.  Up to 20 variables can be set.

The Parameters area selects the variables to be listed in the Parameters area of the Data Display 
window.  Up to 20 parameters can be set.
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Calibration button

Advanced Options…

Calibration

To Perform Compensation and Correction

The MFCMU is equipped with the error correction function used to realize accurate impedance 
measurements. The correction function minimizes the effects of the error elements in the extension 
cables and the DUT interface such as manipulator and probe card.
•Phase compensation: Corrects phase error caused by extending measurement cables.
•Open correction: Corrects for stray admittance. Effective for high impedance measurements.
•Short correction: Corrects for residual impedance. Effective for low impedance measurements.
•Load correction: Corrects any error by using the working standard (load standard).

Click the Calibration button to open the Calibration window.  And click the CMU calibration tab on 
the window to perform the compensation and correction data measurement.
•To measure the phase compensation data, open the measurement terminals at the end of the device 
side and click the Measure... button.
•To measure the open correction data, open the measurement terminals at the end of the device side 
and click the Measure... button.
•To measure the short correction data, connect the measurement terminals together at the end of the 
device side and click the Measure... button.
•To measure the load correction data, connect the load standard that has the reference value or 
calibration value. Then, click the Measure... button.

For details of the error correction (CMU calibration) and the Advanced Options, see online help or 
User’s Guide.  The Advanced Options window is used for the compensation/correction data 
measurement setup.
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Class Exercise

Define test setup and perform test.

1. Click C-V Sweep icon and open setup editor.

2. Define test setup as shown in previous pages. And 
save it as Trng CV.

3. Open measurement terminals, and perform phase 
compensation and open correction.

4. Connect device, and perform test.

5. Export preset group, and import it. 

SMU1

SMU2

CML

CMH

Note:
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Measurement Result Example

This is a test result example displayed on the Data Display window.
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Switching Matrix Control

• To Define Switch Setup

This section explains how to define the switch setup for B2200 Switching Matrix.
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To Define Switch Setup

-Open All
-Switch Setup
-Close Range
-Open Output
-Open Range
-Open Input

Setup Name

-BBM
-MBBR

To specify Input Port

To specify Output Channel

This setup screen is used to create the relay control setup (switch setup) for Agilent B2200A/B2201A 
Switching Matrix.
To send the switch setup to B2200, click the Single button.  Before doing this, you have to establish 
the GPIB connection to B2200 by using the Switching Matrix tab screen of the Configuration 
window and B1500A is set to system controller.  See Module 12.
This screen provides the following GUI.
Add:  Adds a setup row for relay connection.
Delete:  Deletes the setup row.  To select the setup row, use the left radio button.
Up:  Moves the selected setup row upward.
Down:  Moves the selected setup row downward.  The setup row provides the following entry fields.
Operation:  Relay control operation.  Open All, Switch Setup, Close Range, Open Output, Open 
Range, or Open Input.  See the next page.
Input:  B2200 input port number or label.  Available for the Switch Setup, Close Range, and Open 
Input operations.
Outputs:  B2200 output channel number or label.  Four entry fields are available for the Switch Setup 
and Open Output operations to specify the output channels.  Two entry fields are available for the 
Close Range and Open Range operations to specify the range of output channels.
Rule:  Relay connection rule.  BBM or MBBR.
•BBM: Breaks the previous connection and then makes the new connection for the specified outputs.
•MBBR: Makes the new connection and then breaks the previous connection for the specified 
outputs.
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Operation and number of Outputs

Opens the relays connected to the specified input port.

Opens the relays connected to the specified output 
channels.  They are between two channels given by 
the Outputs fields.

Opens the relays connected to the specified output 
channels.  Up to four output channels can be specified 
at once.

Makes the connection from the specified input port to 
the specified output channels.  They are between two 
channels given by the Outputs fields.

Makes the connection from the specified input port to 
the specified output channels.  Up to four output 
channels can be specified at once.

Opens all relays.

Description

0

2

4

2

4
0

Number of 
Outputs

Open Input

Open Range

Open Output

Close Range

Switch Setup
Open All

Operation

Note:
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Class Exercise

Define switch setup and send it to B2200.

1. Click Switching Matrix Control icon and open setup 
editor.

2. Define switch setup as you want. And save it as Trng 
Switch.

3. If B2200 is available, establish the GPIB connection 
between B1500 (must be set to system controller) and 
B2200, and apply your switch setup.

Note:
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Direct Control

• To define measurement channel.

• To set Measurement Data Variables and Miscellaneous Variables.

• To set Agilent FLEX commands.

• To set User Functions.

• To set Data Display.

This section explains how to use Direct Control to perform various measurements (e.g. C-f 
measurement, Quasi-Static C-V measurement) using Agilent FLEX commands.  You will perform 
the above tasks to use Direct Control (C-f measurement for example).
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To Define measurement Channel
Channel Setup Setup Name

Channel Definition
-CMU
-V name

Click the Direct Control icon and open the setup editor.  Then click the Channel Setup tab to display 
the channel definition screen. 
•Enter the Setup Name for the test setup to be defined on the setup editor.
•Add CMU used for measurement.
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To Set Measurement Data and Miscellaneous Variables
Channel Setup

Variable name for time stamp data

Types and Names for Measurement 
Data Variables

You can read measurement data by using the Data Display window. Parameters displayed on the 
window are selected on the Display Setup tab screen.  If you enter the variable name in entry fields, 
you can choose the variables as the display parameters.
For example, following Measurement Data Variables are set for the C-f Sweep Measurement.
<Unit>          <Type>                                    <Name>
CMU1:MF    CMU Re(Y)                                 G
CMU1:MF    CMU Im(Y)                                  B
CMU1:MF    CMU DC Bias Monitor Data      DcMon
CMU1:MF    CMU AC Level Monitor Data     AcMon
CMU1:MF    CMU Frequency                         Freq
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To Set Agilent FLEX commands
Measurement Setup

Command Setup

The Measurement Setup tab screen is used to set Agilent FLEX commands for measurement.  
For example, following FLEX commands are set for the C-f Sweep Measurement.

<Command> <Arguments>
1    FMT                  13,1
2    TSC                  1
3    MM                   22,CMU1:MF
4    WTFC               0,0
5    WMFC              1
6    WFC                 CMU1:MF,4,1e3,5e6,50
7    ACT                  0,2
8    ACV                 CMU1:MF,30e-3
9    DCV                 CMU1:MF,1
10  RC                    CMU1:MF,0
11  TSR
12  XE
13  ReadDataBuffer

See B1500A Programming Guide for more details about FLEX commands.
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To Set User Functions
Function Setup

Click the Function Setup tab to display the User Function/Analysis Function setup screen.  The user 
functions can be displayed on the X-Y Graph Plot, List Display, and Parameters area of the Data 
Display window.  Up to 20 functions can be set.
Name: Function name
Unit: Unit of the function
Definition: Definition of the function.  The following identifiers can be used.
-Variables for the measurement/output data used in this test
-Functions defined in the above lines
-Local variables passed from the application test that calls this test as a component
-Built-in functions and global variables
For details, see online help or User’s Guide.
For example, following user functions are set for C-f Sweep Measurement.
<Name>  <Unit>  <Definition>
PI                         3.1415
ImY          S        compenImY(Freq,G,B)
ReY          S        compenReY(Freq,G,B) 
C              F         ImY/(2*PI*Freq)
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To Set Data Display
Display Setup

Specify X axis and Y axes.

Select variables to list

Click the Display Setup tab to display the display setup screen. The X-Y Graph area is used to set 
the X axis and Y axes of the X-Y Graph Plot area in the Data Display window.
•Name: Name of variable to plot on the axis
•Scale: Linear or Log
•Min: Minimum value of the specified axis
•Max: Maximum value of the specified axis
For example, following axes are set  for the C-f Sweep Measurement.

<Name>  <Scale>  <Min>    <Max>
X     Freq       Linear      1 kHz     5 MHz
Y1   C            Linear     -250 nF   500 nF

The List Display area selects the variables to be listed in the List Display area of the Data Display 
window.  Up to 20 variables can be set.
For example, following variables are set for the C-f Sweep Measurement.
Time, Freq, C, G, B
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Class Exercise

Define test setup and perform test.

1. Click Direct Control icon and open setup editor.

2. Define test setup as shown in the previous pages.

3. Save it as Trng C-f.

4. Connect a device (capacitance) as shown in next 
several pages, and perform test.

5. Export preset group, and import it. 

Note:
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16442A/B Fixture

B1500A Rear View

SMU4
SMU3
SMU2

SMU1

CMU

GNDU

Cable Connections

The following cables are required to perform this class exercise.
CMU cable (Agilent N1300A-001/002), 1 ea.

One side of the CMU cable forms the attachment used to join and fix it to the CMU.  And the other 
side provides four BNC connectors used to connect the fixture as shown.

Connect the cables between the B1500A and the test fixture as follows.
Hcur : PGU1 (red)
Hpot : PGU2 (orange)
Lcur : VSU1 (black)
Lpot : VSU2 (gray)
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1 2 3 4 5 6

7 8 9 10 11 12

13 14 15 16 17 18

2019 21 22 23 24
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F
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GNDU

F
2

F
1

PGU

CMUL 

CMUH 

Jumper Leads – Capacitance

0.1uF

For all class exercises, you need the 28-pin dual in line socket which comes standard with the 4145 
fixture (16058A) or the newer fixture (16442A/B).  Either fixture works fine.

This class exercise requires four jumper leads to connect the DUT.  Connect the jumper leads 
between the following terminals.

PGU1 : terminal 1
PGU2 : terminal 1
VSU1 : terminal 4
VSU2 : terminal 4
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Measurement Result Example

This is a test example displayed on the Data Display window.
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5 Basic Measurement
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SMU Fundamentals

Classic Test Environment

SMUs Connected in Series or Parallel

Cabling and Fixture Issues

Kelvin and Driven Guard

Probes and Prober Connections

Triax and Coax Adapters

Safety Interlock Issues

In This Module

Note:
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Output Switch

V Source Mode

SMU
FORCE

COMMON

I  Source Mode

Common Mode

A

V +-

SMU Block Diagram
Three Modes

The source monitor unit (SMU) can function in three modes:
- Voltage source while monitoring current
- Current source while monitoring voltage
- Source common with no monitor

The SMUs on the B1500A can output V or I in constant, linear sweep, logarithmic sweep or pulsed 
modes.

Constant V or I mode could be used for “spot” measurements or biases.

Swept output is used to trace a curve.  A second SMU can be swept subordinately to measure a 
“family of curves.”

Pulsed mode is used during swept measurements to reduce the effects of thermal stress on the device 
under test (DUT).
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Single Sweep Double Sweep

Linear Sweep

Log Sweep

Basic Sweep Measurement
VAR1

The SMUs can now sweep up to a value and then back down (double sweep). This feature is useful 
when the device must be tested without abruptly removing the forcing condition.

Log sweeps are required any time the measurement results span many decades, such as a MOS 
subthreshold curve.

The variable used to set the SMU to a basic sweep is VAR1.  It may be called the primary sweep.
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Subordinate 
sweep

Synchronous
sweep

VAR1 
(primary sweep)

VAR2
(secondary sweep)

VAR1 (primary sweep)

VAR1’ (synchronous sweep)

Sweep Measurement Modes
Combining VAR1, VAR1’, VAR2

A subordinate sweep variable (VAR2) may be combined with the basic sweep variable (VAR1).  
This corresponds to the step knob and sweep knob of a curve tracer.  This produces a family of 
curves.  VAR2 may be called the secondary sweep.

Another useful combination is a synchronous sweep.  Here VAR1 and VAR1’ are in-step. VAR1’
defaults to a gain of 1, which means it exactly tracks VAR1.  You can also vary the initial offset 
between VAR1 and VAR1’.  These features are useful for bipolar gummel plots, op-amp differential 
input tests, etc.
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Four terminal MOS device
Only one configuration required
Speed up testing 

Source

Gate

Drain

Substrate

ConstantCommonVAR1 VAR2

SMU4SMU1SMU2SMU3

Why Four SMUs?

The basic semiconductor device is the 4-terminal MOS transistor.  By assigning an SMU to each 
terminal, you have complete flexibility to make any measurement without having to change the 
device hookup.  No relays are required to switch any connection; this is all done by changing the 
mode of the SMU from the front panel.
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MOS Id vs Vd Basic Measurement

You will connect the SMU cables and jumper leads
You will then "properly" insert the MOS transistor
You will learn how to load a setup data
Observe Classic Test setup screen
Click                     button to make a new measurement
Observe Application Test setup screen

To Get Started:
Use the next several pages as you guide
Verify that four triax cables are connected as shown 
Connect four jumper leads to the 28 pin socket as shown
Insert the MOS transistor using the "anti-static" procedure

Class Exercise

The purpose of this class exercise is to familiarize yourself with how to connect a MOS FET device, 
and make a basic IDVD family of curves measurement.  You will observe the Application Test setup 
screen and the Classic Test setup screen (interrelationship between the Channel Setup, Measurement 
Setup, Display Setup screen). 

The next several pages show how to connect the 4-terminal MOS FET used in this course.  The 
device for this exercise includes a separate substrate pin.  This corresponds to the back gate 
connection.  We can observe all characteristics of the device as if we were probing it at the wafer 
level.



Module 5
Basic Measurement

5-8

Force Lines to Fixture 1,2,3,4 Ports

16442A/B Fixture

B1500A Rear View

SMU4
SMU3
SMU2

SMU1

CMU

GNDU

Force side Sense side

SMU Triax Connection

For the non-Kelvin connections, connect only the Force lines, leaving the Sense lines open.

Connect corresponding numbers.  On the 16442A/B fixture use the numbers labeled 1 - 6, not 1 - 3. 

Your B1500A may not match the SMU configuration shown in this figure.  Note that SMU1 is the 
module top of the GNDU (ground unit).  The SMU number become large from bottom to top as 
shown.

This is the SMU cable setup that will be used in the remainder of the class exercises.
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If you use the Sense lines …

Curves clamped at 10 mA level

B1500A Rear View

SMU4
SMU3
SMU2

SMU1

CMU

GNDU

Wrong Triaxial Hookup

This picture shows the triax cables connected to the right set of connectors which is wrong.
The 4 triax cables must be connected to the left set of connectors (FORCE). 

You will likely see this type of erroneous response with clamping at 10 mA (no trace above 10 mA 
even though compliance is set much higher).  Also you may see the response with notches at 10 mA
level.
The effect is magnified when the SMU measurement ranging is set to AUTO.

This curve was produced using your training class MOS device and the IDVD setup.
No error was seen until the ranging was changed from FIXED 100 mA to AUTO.  Then it was 
evident that the cables were hooked up improperly.
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S
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G
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Sub

Jumper Leads – MOS transistor

For all class exercises, you need the 28-pin dual in line socket which comes standard with the 4145 
fixture (16058A) or the newer fixture (16442A/B).  Either fixture works fine.

With the 16442A/B fixture, note that there are two SMU numbering schemes....3 SMUs with force 
and sense, or six SMUs with force only.   For this class example we will use the six (6) SMU scheme.  
On older fixtures, this scheme is shown in light blue lettering. In newer fixtures, this scheme is 
shown in white reverse background lettering.
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1. Prepare the Agilent B1500A 
Manual CD-ROM Edition 4 or 
later

2. Insert the CD-ROM into the 
B1500A built-in CD-ROM drive

3. Click My Favorite Setup button
4. Click Preset Group > Import Preset 

Group …
5. Import ¥data¥Demo.xpg on the 

Manual CD-ROM

To Import Demo Data 

The Agilent B1500A Manual CD-ROM stores demo data used for performing this class exercise.  
Insert the CD-ROM and import the demo data to the EasyEXPERT database.  The demo.xpg file 
contains the test setup data used in this class exercise.
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1. Highlight IDVD in My Favorite Setup
2. Click Recall button

To Get Classic Test Setup:

1. Highlight Id-Vd in My Favorite Setup
2. Click Recall button

To Get Application Test Setup:

To Get Setup Data 

You can get the test setup data as shown.

IDVD is a sample setup data for Classic Test.

Id-Vd is a sample setup data for Application Test.
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Classic Test – Channel Setup

After you get the IDVD setup data, you will see the Classic Test setup screen as shown.

The Channel Setup screen allows the user to assign a meaningful name to the force/meas functions of 
each SMU.  These names may be used in the Function Setup screen to define algebraic expressions.  

The Mode column is used to determine whether a particular SMU is to be used to 1) force current 
and measure voltage (I mode), or 2) force voltage and measure current (V mode).  The entry 
COMMON implies the node is used as "ground."

The Function column defines which SMUs are to be used as swept sources or constant sources.  
VAR1 is the primary swept source.  VAR2 is known as the subordinate swept source, meaning 
VAR1 will sweep through its range, then VAR2 will step and VAR1 will sweep again.  CONST is 
self- explanatory.
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Do not abort on
compliance,
oscillation, etc.

Classic Test – Measurement Setup

The Measurement Setup screen is shown here.  The variables VAR1 and VAR2 define the sweep 
parameters.  In a case where two sweep parameters are defined, the second parameter (VAR2) is 
called the subordinate (secondary) sweep parameter.  This means that the primary parameter will be 
swept once for each discrete value of the subordinate parameter.

The “Constants” area is used to define non-swept voltage/current sources.  This area is used to define 
ground references (forcing zero volts) as well as constant biases.  
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Classic Test – Display Setup

The Display Setup screen allows you to set the X-Y graph axes.  The display setup is divorced from 
the measurement setup to allow the user to tailor the view to a particular region of interest.  
This screen also allows you to set data variable names to be displayed in the List Display and 
Parameters areas on the Data Display window which is opened when the measurement is started.
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1. Click Single button

This opens the Data Display window 
and starts measurement.

The Data Display window shows 
measurement result data graph/list.

To Start Measurement 
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Graph Plot

Analysis tools

Auto Scale

List Display

Parameters

Data Display Window – Graph 

This window displays measurement result graph, list, and parameter values.

Markers are used to traverse the actual measurement data.  Markers cannot be placed anywhere on 
the screen except on an actual measurement trace.  They are denoted with a small circle.  One moves 
the markers with the front panel rotary pulse generator (RPG) knob, mouse, or touch screen.  

Cursor may be used anywhere on the screen and are denoted by a small cross.  The cursor is moved 
using mouse, touch screen, or an arrow key.

The line function may be selected to draw one of four types of lines: line between cursors, gradient 
line, tangent line, regression line.

One of the most used interactive functions on this window is the autoscale feature which is applied 
by clicking the icon of yardsticks.
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Marker position

Graph Plot

List Display

Parameters

Data Display Window - List 
Analysis tools

The List Display corresponds exactly with the Graph Plot.  Even the highlighted line of data 
corresponds to the marker position on the Graph Plot.

Up to twenty columns of data can be set on the List Display.  Note that the Graph Plot can only plot 
nine columns (X, Y1 to Y8). 

The list data can be copied to a spreadsheet software easily.  Click Edit > Copy List.  This copies all 
of the list data into the clipboard.
On the Notepad, paste it and save it as a text file.  The file can be opened as a tab separated value 
data by using a spreadsheet software.  See the next page.

The details of the analysis tools function are discussed in Module3.
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Paste to Notepad

Open by a spreadsheet software

To Copy List Data 
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Application Test

Recall Id-Vd application test setup data.
After you get the Id-Vd setup data, you will see the Application Test setup screen as shown.

Test Parameters area shows the device connection information and allows the user to set the SMU 
outputs.

Device Parameters area allows the user to set device parameters. In the Id-Vd setup, the device 
parameters are polarity, gate length, gate width, temperature, and maximum drain current.

Extended Setup button opens the Extended Setup dialog box shown in the next page.
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Clicking the Extended Setup button opens …

Application Test – Extended Setup

The Extended Setup dialog box allows the user to set the additional test setup parameters.  In the Id-
Vd setup, the additional parameters are source voltage, maximum gate current, maximum substrate 
current, integration time, hold time, and delay time.
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In Series or Parallel

To Double the Output Voltage
from 100 V to 200 V for HRSMU and MPSMU
from 200 V to 400 V for HPSMU

To Double the Output Current
from 100 mA to 200 mA for HRSMU and MPSMU
from 1 A to 2 A for HPSMU

Use the VAR1’ mode to synchronize two SMUs

SMUs May Be Connected

You can double the voltage or current output by combining SMUs.
The VAR1’ mode allows a second SMU to be swept in tandem with the first.
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Two SMUs in Series

VAR1 VAR1'

SMU1
V=0 to 100

SMU2
V=0 to -100

200 V Resistor Sweep

Base

Collector

Const. Emitter

VAR1' VAR1

SMU1
I=0

SMU2
V=0 to -100

SMU3
V=0 to 100

200 V BVceo

Base current  =  0
or leave open

V1 V2

WARNING

200 Volt Sweep (400 Volt with 2 HPSMUs)

Higher voltages are necessary to observe breakdown conditions, such as BVceo.  In the case of 
BVceo the base must be open (no SMU) or the SMU must be set as a current source with I=0. 

One SMU must sweep in a positive direction while the other sweeps in a negative direction.  The 
result is a floating measurement with double the differential voltage.  A resistor is used in the next 
few slides to demonstrate a 200 V sweep.

Note:  Using two HPSMUs, it is possible to sweep a total of 400 Volts.
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Two SMUs in Series

Voltage across resistor
VR = V1-V2

Channel and User Function Pages

The voltage across the resistor (VR) is the difference between V1 and V2.  A simple user function 
can be used to plot VR.
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Two SMUs in Series VAR1' Ratio = -1

Measurement and Display Pages

The VAR1’ mode is used to synchronously sweep two SMUs.  Setting Ratio = -1 forces one SMU to 
sweep in the opposite direction of the other.
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Two SMUs in Series

Use the interlock
cable and observe
safety precautions.

511K
Resistor

WARNING

Graphics Page     0 to 200 V 

The result is a clean 200 V sweep.
Remember that there is a serious shocking hazard.
The interlock cable is necessary for any voltage sweep greater than 42 V.
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Two SMUs in Parallel

SMU1
V=0 to 0.2

VAR1 VAR1’

V1 V2

Ground Unit 
(GNDU) or

Chassis Gnd

SMU2
V=0 to 0.2

1 ohm Use Ground Unit 
or the chassis
ground as the
SMU return path.

Circuit Common

Shorting bar

NOTE

200 mA Output

Two SMUs can be operated in parallel.
The trick is to not use any SMU as COMMON.
HRSMU and MPSMU can only sink 100 mA. 
Use GNDU (ground unit) or the chassis to sink the 200 mA of current.  Chassis noise level will not 
affect the measurement.  There is a shorting bar in the back of the instrument which connects SMU 
common to the chassis.  The shorting bar must be connected as shown above.  Use the connector on 
the shorting bar to make an easy chassis connection to your circuit.  The chassis connection is also 
provided if you use a packaged part test fixture, such as the 16058A or 16442A/B.

Note
The only time you would ever want to remove the shorting bar, is the case of floating the instrument 
circuit common when using other instruments.  An example might be a connection to a RF Network 
Analyzer.  You may want to remove chassis ground loops by connecting the circuit common directly 
to the NWA chassis.

Note
Never use the chassis ground for low current measurements.  It is noisy.  Use the GNDU or an SMU 
set to 0 volts or COMMON mode.

Note
If the GNDU is used, connect the 16493L GNDU cable between the GNDU and the test fixture.  Do 
not connect the triaxial cable.  The GNDU is rated for up to 4.2 A, while the maximum current rating 
of the triaxial cable is 1 A.  
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Two SMUs in Parallel

Current in resistor
Itotal = I1+I2

Channel and User Function Pages

A user function totals the current in both SMUs.
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Two SMUs in Parallel VAR1' Ratio = 1

Measurement and Display Pages 

The VAR1’ mode with Ratio = 1 forces two SMUs to sweep the same voltage.
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Two SMUs in Parallel

1 ohm
Resistor

Graphics Page     0 to 200 mA

The result is a clean sweep to 200 mV.  It shows the current measurement data near 200 mA.
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Guard connection
Kelvin connection

Prober interface

Triaxial Probes

RF Fixturing interface

Feedthru and triax to coax adapters

16442A/B fixture interlock 

16058A fixture compatibility

What?
Where?

Why?

Cabling and Fixturing Issues

The B1500A is a precision instrument.  However, the ability to make precise and reliable 
measurements may be compromised by your fixturing to the device. The following section provides 
some theory and hints for making sense out of cabling and fixturing issues.
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Simplified Diagram

x1

Buffer

SMU DUTForce

V

Guard
Rs
10K

Guard  Connection for Non-Kelvin Connection

The guard connection is needed for measurement < 1 nA.  Below 1 nA a regular coax cable's 
capacitance dominates over the DUT (device under test) capacitance.  What you see is cable 
charging current.  I = C(dv/dt)  where dv/dt is the rate of change of SMU voltage from one step to the 
next of a coax cable with no guard.  C is the total capacitance of the cable.

The above diagram shows how the cable capacitance is eliminated with a triaxial cable.  The guard is 
driven at the same voltage as the force center conductor.  No current can flow between guard and 
force when they are held at the same potential.  Guard and force are isolated by a buffer amplifier.  
They can never be shorted together.  
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Shield (Ground) Guard
Force

16494A-001
(1.5 m)

16494A-002
(3.0 m)

Shield Capacitance 900 pF 1800 pF

Guard Capacitance 130 pF 240 pF

Force Resistance 160m ohm 320m ohm

Triaxial Cable for Non-Kelvin connection

Shown above are typical capacitance and series resistance of the force line.  If cables are too long, 
high capacitance may cause the SMU to oscillate.  Keep the force-guard cable capacitance less than 
600 pF.  Similarly, the guard-shield capacitance must be less than 5000 pF.  

Note the rather high force resistance.  Kelvin connections must be used to eliminate this cable error.
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Shield (Ground)
Guard

Force

Shield (Ground)

Force

Vg       Coax CablesVg        Triax Cables

MOSFET Subthreshold MOSFET Subthreshold

Id

fA

pA

nA

uA

mA

Id

fA

pA

nA

uA

mA

Eliminate cable low current errors.

Leakage

Why Use Guarded (Triax) Cables?

The triax cable is a special low dielectric loss, high impedance cable.  This cable may be used down 
to fA levels when properly used with a guarded probe.  The guard voltage tracks the force voltage 
exactly, so that no voltage drop can exist between guard and force.  This eliminates the capacitive 
loading that would otherwise limit low current measurements. 

If low impedance coax cables are used with outer layer at ground potential, two limitations will be 
immediately apparent.  The cable leakage will limit the low current measurement floor.  In addition, 
when the voltage is swept, the sudden change will cause additional cable charging.  This distorts the 
low current portion of a MOS subthreshold curve as shown.

RULES:
Unguarded coax cable is OK for measurements above 1 nA.
Triax cable or coax with outer layer at guard potential should be used for measurements below 1 nA.
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Simplified Diagram

x1

Buffer

SMU

Guard
Sense

DUTForce

V

Rs
10K

Guard Connection for Kelvin connection

With the Kelvin connection, sensing is done at the DUT, eliminating the fraction of an ohm of cable 
resistance.  The internal sensing resistor Rs is the only feedback path without the Kelvin connection.  

Note that the B1500A operates just fine without the sense cable. This is important to know because 
in general you do not need the sensing Kelvin connection.  Most MOS measurements are high 
impedance and the residual cable loss is insignificant.  
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Guard

Force

Ground

Sense

Kelvin Triaxial Cable

The triaxial cables are good for low current measurements.  However, two cables are necessary for 
low resistance Kelvin measurements.

Agilent Technologies designed a special Kelvin triaxial cable for the precision semiconductor 
parameter analyzers.  This cable is optimized for both low current and low resistance measurement.  
Both force and sense lines are held rigidly in the same Teflon cable.  Friction is reduced and the 
cable is less sensitive to noise caused by moving the cable. 

Kelvin triaxial cable assemblies are available with two connector options:

16494B B1500/4156 compatible on one end;  4142 compatible on the other end
16493K B1500/4156 compatible on both ends (standard option)
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IB

Re = 735 mΩ 

Rcable = 214 mΩ

VC monitor

Slope = 1/Re
(Kelvin) 

Slope = 1/(Re+Rcable)
(Non-Kelvin) 

Ib (mA)

Vc (mV)0 50

20

0.1

Why Kelvin Measurements?

In the example above, the device is connected with a SMU on the base sweeping current, a voltmeter 
on the collector, and the emitter is grounded with a Kelvin SMU. The base SMU does not have to be 
Kelvin since we are only forcing current and do not care about measuring the cable loss in the base.  
Also, the collector SMU is being used only as a high impedance voltmeter, so there is no cable loss 
in this lead.

The emitter on the other hand, must be connected to a Kelvin SMU.  Because of this, we can 
compensate for the 0.214 ohm path through the cable and fixture. From the graph we can see the 
emitter resistance is 0.735 ohm when compensated using the Kelvin connection.  Non-Kelvin 
resistance is 0.949 ohm, due to the extra 0.214 ohm cable and fixture resistance error.
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Bipolar Re Using A Kelvin SMU

You will connect a Kelvin triax cable to the B1500A 
You will then connect jumper leads and the bipolar device
You will get the REKELV setup
You will observe Re using Kelvin and Non-Kelvin connections.  
Why is the Non-Kelvin error so large?

To Get Started:
Use the next several pages as you guide
Verify that all triax cables are connected properly
Connect four jumper leads to the 28 pin socket as shown
Insert the bipolar transistor (not static sensitive)

Class Exercise

The purpose of this class exercise is to familiarize yourself with making a Kelvin measurement.  Low 
resistance measurements such as Re, Rc (bipolar) or Rs, Rd (MOS) are excellent examples because 
the resistances are of the same approximate magnitude as cable resistances.  Kelvin techniques must 
be used, or your error can be as much as 100 %.

The next several pages lead you through the steps of connecting a Kelvin cable, making the correct 
Force/Sense jumper lead connections, orienting the device properly in the socket, and getting the 
REKELV algorithm.  The measurement will be Re (emitter resistance) of a bipolar transistor.  You 
will be able to remove the Sense jumper lead on the Emitter terminal of the device to see the gross 
measurement degradation when the connection is non-Kelvin (no sense connection near the device).
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Triax to SMUs 1 and 2

Kelvin Triax to SMU 3

16442A/B Fixture

B1500A Rear View

SMU4
SMU3
SMU2

SMU1

CMU

GNDU

Cable Connections

This class example requires a Kelvin triaxial cable.  If the Kelvin cable is not available, substitute 
two standard triax cables.
SMUs 1,2,3 can all be connected with Kelvin triaxial cables, but only SMU3 requires the Kelvin 
connection.

Note
If you use the 16058A fixture instead of the 16442A/B, connect the triaxial cables as shown below.

SMU1 Force ---> 16058A SMU1
SMU2 Force ---> 16058A SMU2
SMU3 Force ---> 16058A SMU3
SMU3 Sense ---> 16058A SMU4
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E B C

B

E
C

17: Emitter
16: Base
15: Collector

Class Example - Jumper Leads 

Connect jumper leads as shown.  Where, the SMU4 F terminal is connected to the B1500A’s SMU3 
Sense connector.  So the couple of the SMU3 F and SMU4 F terminals makes a Kelvin terminal.

Locate the bipolar transistor in the corner of the socket as shown, with the flat side of the device 
facing toward you.
Unlike the MOS device, the bipolar transistor is not static sensitive.  You may touch the leads 
without using a ground strap.
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1. Highlight REKELV in My Favorite 
Setup

2. Click Recall button

To Get REKELV Test Setup:

To Get Setup Data
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Click                  button to start measurement

Single Kelvin Measurement

Click the Single button to make a new measurement.  You should see a response similar to this, will 
the analysis line correctly overlaying the curve. 
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You can switch
the analysis line
between the two
curves with this 
softkey

Click           button to start append measurement

Non-Kelvin Measurement

Remove the jumper lead connected between the terminal 17 and the SMU4 F terminal.  And click the 
Append button to add another measurement to the graph.

Now you see the very large difference between Kelvin and non-Kelvin measurements when the 
resistance is low.  You can see that Re jumps from about 0.735 ohm in this example, to about 0.949 
ohm.  The extra resistance is due to cable loss and fixture loss.  This resistance is compensated out 
when you use the Kelvin connection.



Module 5
Basic Measurement

5-44

To Kelvin Probe

To Guarded Chuck

Prober Kelvin Cable Connection

Photo of SMU cable connection to a Cascade Microtech Summit probe station.
The Kelvin triaxial cables mate directly to the probe station. 
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Non-Kelvin Connection

Jumper to eliminate cable
resistance in force line

Insulator
COMMON

FORCE

SENSE

Shielding Box

Connector Plate
16495H-002

or
16495J-002

GUARD

GUARD
COMMON

FORCE,SENSE Line
GUARD Line

Kelvin Triaxial Cable
16493K

Probe Cable (Coaxial) Prober

DUT

S
M
U

F

S

F

S

Connector Plate 

This is a "hybrid" Kelvin connection.  Cable resistance from SMU is eliminated by shorting FORCE 
and SENSE lines inside the prober.  A short line to the probe makes the non-Kelvin connection, 
simplifying hookup.
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Use single triax for basic MOS FET measurements

One triax on each Force line 

Leave the Sense lines open...no cable connected

Use triax bulkhead feedthru adapters on the prober

Use a probe holder with a triaxial connector

Use a probe holder than accommodates replaceable 

probe tips (inexpensive repair)

Simplifying the Prober Connection

The next section sheds light on the confusing topic of connection to the device under test.  Without 
proper considerations, noise, capacitance, sense resistance, or inductance will result in unacceptable 
measurement error.
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Guarded to within 2mm of tip

Single Triax Kelvin Triax

Triaxial Probes

These probes are guarded within 2mm of the probe tip, ideal for low current applications.  The 
Kelvin triax probe is the ideal mate for the Kelvin triax cable. A third variation of these probes is a 
Kelvin triax probe with only one probe.  The Kelvin connection is made inside the probe holder.  
This compromise eliminates most cable loss while making a single point contact.
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Triax is not necessary...bias currents are > 1 nA.
Use triax to coax adapters with floating guard.

RF in Bias NetworkBias Network
DUT

Bias SensingBias Bias Bias Sensing
RF out

SMU2 SMU1 F F S S 

Simplifying RF Connections

Above 1 nA guarding is of little use.  Cable capacitance has a negligible effect on the bias port.  Use 
the floating guard triax(m) to BNC(f) adapter at the B1500A rear panel.  Then use standard coax 
BNC cables.  Use sense to minimize series resistance error.  100 mV errors can occur in bias voltages 
if remote sensing is not used.

Some recent bias tees from Agilent Technologies are specially designed to mate easily to triax SMU 
ports.
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For measurements above 42 Volts
For program control using program memory

View from B1500A rear panel

1
2

345
6

Short required

Interlock Connection

To prevent shock hazard, the B1500A will not operate above 42 V, unless you connect the interlock 
circuit.
The interlock connection is required when the voltage exceeds 42 V or when the program memory is 
used in a control program.

The 16442A/B test fixture has the interlock circuit internally which makes this short by closing a lid 
activated switch.
You must make the circuit to your prober to comply with US OSHA safety standards.  The switch on 
the prober should be mounted into the access door of the shield box.

If you want to connect to the BNC type interlock connector on the 16088B, your fixture or prober, 
use the 16435A Interlock Cable Adapter.  The 16435A provides a BNC cable and a small adapter 
box which is used to join the BNC cable and the interlock cable furnished with the B1500A.   

If you want to wire your own cable or fixture,  these Agilent part numbers may be used:
1252-1419   Female 6-pin plug connector
1252-1418   Male 6-pin cable connector
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16493J-001 1.5 m cable
16493J-002 3.0 m cable

16442A/B Fixture

The 16493J interlock cable is designed to be connected directly between the B1500A’s interlock 
connector and the 16442A/B.  If the fixture lid is closed, internal switch is closed, and then the 
B1500A can perform measurement up to 100 volts; 200 V with the HPSMU. 
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Use the 16058A with the B1500A 
4 non-Kelvin SMU inputs
3 general purpose coaxial inputs

Add the 16493A Adapter Cable
Interlock connection
4 additional coaxial inputs

Add the 16435A Adapter

16058A Fixture Compatibility

The 16058A has 4 non-Kelvin SMU inputs and 3 coaxial inputs for the other instrument connection.  

By adding the 16493A Adapter Cable, you get access to 5 more coaxial connections.  The adapter 
was designed to bring out the fixture interlock connection and 4 additional connections, such as the 
4142/4155/4156’s VSU/VMU.

The 16493A cable converts the 16058A fixture interlock connection to a single coaxial connector.  
This mates directly with the 16435A Interlock Cable Adapter mentioned on the previous page.

Note
You will notice that the socket modules for Agilent Technologies entire DC parametric product line 
are interchangeable.  So socket modules that came with the 4142, 4145, 4155, or 4156 will work with 
the 16058A, 16088A/B, and 16442A/B fixtures.
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6 Low Current Measurement
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Low-Current Measurement Challenges

Calibration and Zero Cancel

Effect of Cable Movement

ASU for Ultra Low-Current Measurement

Low-Current Subthreshold

Trade-Off Speed Vs Accuracy

Low-Current Gummel Plot

Low-Current Gate Oxide Leakage

In This Module

This module is primarily written for the B1500A installed with the HRSMU (high resolution SMU) 
and covers sub pA measurement techniques.  Course exercises are included which fully explore 
speed vs. accuracy issues to the fA level.
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Measurements below 10 fA at the wafer level

Repeatability within a few fA 

Speeds less than 1 minute for subthreshold sweep

Low Current Measurement
What is possible?

Making wafer level measurements to fA levels is easy and routine using proper measurement 
procedures on a low noise probe station.  This module explains how.
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NOISE FROM PROBER
Faraday enclosure required
Eliminate all electrical interference

STRAY CAPACITANCE
Full guarding, including the probe
Guarded chuck to measure substrate current

MEASUREMENT SETUP
Hold time, integration, auto ranging

CALIBRATION & ZERO CANCEL

Low Current Measurement
Challenges

Measurement below 1pA is not possible without special attention to the prober and cabling.  The 
wafer must be in total darkness and in an electrically isolated metal box.  Motors must be turned off 
or completely shielded.

Stray capacitance kills any hope of making good low current measurements.  High cable capacitance 
which is unguarded can produce pA level currents during voltage steps.  The probes themselves must 
be guarded.

The B1500A defaults at bootup to setup conditions which are not optimized for ultra low current.  
This is desirable because there is a large trade-off between speed and ultra-low current accuracy.  
The typical use is moderate current levels where settings can be optimize for speed, not accuracy.

There are some features such as zero cancel, which can eliminate the last 10 or 20 fA of error from 
your measurement.  Before zeroing, you should check that SMU CALIBRATION has been 
performed.  SMU Calibration removes most error and makes the final zero cancel easier. 
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Low loss triaxial connection (no matrix card)
Guard to tip of probe (no bare needle or probe cards)
No air flowing near probe tip (including dry nitrogen)
No hot chuck 
Chuck isolated from ground (10^13 ohms)
Chuck guarded for substrate measurements
Shielded probe station 
No vibration; cables stationary
Microscope light, motors, etc. off

Clean Probing Environment
What is Required?

This check list covers most sources of noise or stray capacitance.  In a "clean" probing environment 
the B1500A can be used with short integration time and no delay time between steps.
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Sweep 0 to 1 volt with no cables attached to SMU
Check that there is a +/- 3 fA base line 

Add prober cables but no prober
Wait several minutes
Still +/- 3 fA base line?

Add shielded prober but no probes

Add probes

Debugging A Noisy Probe System
Where to Start?

This is a systematic strategy for focusing in on the sources of noise and error.  You can be very 
surprised.  Some prober cable is not low loss.  You may see popping noise due to relaxing of Teflon 
fiber in the cables, high current level due to poor dielectric loss, etc.  You may find improper triax 
adapters, high levels of stray capacitance, etc.,  as you add prober and probe connections.
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WAIT 30 MINUTES AFTER TURN ON
Instrument must stabilize

CAL & ZERO WITH PROBES UP
Prevent device damage

ZERO EVERY 30 MINUTES 
To get repeatable fA level measurements

Low Current
Calibration & Zero Cancel

The SMU can be thought of as a sophisticated OP AMP.  With any OP AMP there is an associated 
input offset error.  This error is small and varies with ambient temperature shifts and other factors.  It 
can be reduced to a negligible amount with a zero cancel function.
Zeroing is performed with the probes up.  If there is a very large error to correct, you may get a 
warning message.  This usually means that SMU CALIBRATION has not been recently performed. 
SMU calibration eliminates gross.  ZEROing only has an effect on the 1 nA range or less.
Use the Calibration window to perform the SMU calibration and zero cancel.  See the next page.

NOTE:
The B1500A provides the auto calibration function which automatically starts calibration for all 
modules every 30 minutes if the output switches of all modules are off for 30 minutes.  You can 
enable or disable this function on the Calibration window.  If auto-calibration is enabled, move 
probes up (open measurement terminals) after measurement to prevent device damage and to 
perform calibration correctly.
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Calibration
Low Current
Calibration & Zero Cancel

Click Calibration button to open the Calibration window.

SMU calibration is performed on the SMU Calibration tab screen. Specify the modules for 
calibration by checking the left check box and click Start Calibration button to start calibration.  If 
ASU (atto sense/switch unit) is connected and 1 pA range is used for measurement, check Full Range 
Calibration check box before clicking Start Calibration button.

SMU zero cancel is performed on the SMU Zero Cancel tab screen. Specify the modules for zero by 
checking the left check box and click Measure... button to start SMU zero.   If ASU is connected and 
1 pA range is used for measurement, check Full Range check box before clicking Measure... button. 

To enable the auto calibration function, check the Enable Auto Calibration check box on the SMU 
Calibration tab screen.
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To Get Started:
Use the next several pages as your guide
Remove any cable attached to SMU4
Measure SMU4 noise level using the setup shown

Class Exercise
Measurements Near Zero fA

You will be able to answer the following questions:
What does a sweep into an open SMU port look like?
What is the time per meas using PLC integration?
Add a 1.5 m cable during a sweep...how long to settle?
Move and bend the cable...how much current flows?

The following pages lead you step-by-step through the "ZERO CHECK" class exercise.  This is the 
logical place to start if you are debugging a "noisy" test environment.

You will create an algorithm to look at the low level measurement capability of a SMU.  On the next 
page you will see the expected curve when looking into an open at the rear panel.
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+/- 3 fA variation typical, using 16 PLC integration time

Cursor at the maximum point 3.17 fA

Marker at the minimum point -1.84 fA

ZERO CHECK - No cable
Using Default SMU Setup

With slight modification of the default SMU settings of Classic Test I/V Sweep, you can check the 
conditions of your measurement system.  This is a typical plot when no cable is attached to the SMU 
port.  You would typically expect no more than a few fAs of deviation from zero using 16 PLC 
integration time.
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Delete SMU1 and SMU2

Change Mode to V and
Function to VAR1

ZERO CHECK
Channel Setup

Click the Classic Test tab, I/V Sweep, and Select to display the Channel Setup screen.
On this display, delete the rows of SMU1 and SMU2.
Change the Mode of SMU4 to V.
Change the Function of SMU4 to VAR1.

This setup will be used for checking the zero measurement on SMU4.
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Do not change this screen

ZERO CHECK
Measurement Setup

This default sweep setup is enough for the Zero Check measurement.
The sweep steps are small (10 mV) and that is ideal for checking current at fA levels.
Also the sweep starts at 0, so no big discontinuities on the first step of the sweep.

There is no need to change anything on the Measurement Setup screen.  But the ranging mode and 
the integration time settings must be changed.  See the next page. 
Click Range button to change the ranging mode.  
Click ADC/Integ button to change the integration time setting.  
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Change SMU Range to
AUTO or LIMITED 10 pA

Change Integration Time to
16 PLC

ZERO CHECK
Range and Integration Time

You must change the range setting from the default of LIMITED 1 nA to LIMITED 10 pA or to 
AUTO.  Otherwise you will have 100 fA resolution instead of the best 1 fA resolution possible.
Also change the High Resolution ADC Mode to PLC and Factor to 16.  You will see +/- 3 fA
variation measurement result as shown in the previous slide.
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Linear, with zero set to mid scale

ZERO CHECK
Display Setup

The best check is done with a LINEAR scale which brackets either side of ZERO by 100 fA or less.

A log scale is particularly unacceptable,  Log plots of zero are not possible, and all readings of a log 
plot must be either all positive or all negative.
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Approx. 50 sec

< +/- 3 fA< +/- 3 fA
> +/- 3 fA

ZERO CHECK
Effect of connecting a triaxial cable

If you change anything in your fixturing or cabling, wait at least 1 minute before making a 
measurement at low currents.

Here we see the effect of connecting a cable to the open SMU port of the B1500A.  The discontinuity 
lasted for 50 seconds of a 2 minute sweep from 0 to 1 volt in 10 mV steps.
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Bumping cable

Bending Cable

ZERO CHECK
Effect of cable movement

As you can see, your fixturing must be free from vibration.  Bending cables during a test is another 
NO NO.  The above measurements were made on a single triax cable for classic parameter analyzers.  
The Kelvin triax cable is less sensitive to movement (triboelectric effects).  However, either cable 
works fine to fA level if the cables are reasonably still...i.e. not swinging, coiled up and moved, etc.

(End Of This Class Exercise)
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Control cable
(control signal and Sense signal)

Force

Sense (optional)
Triax cable

From HRSMU

Force

D-sub

For Ultra Low Current Measurement

ZERO CHECK
Appendix: Using ASU

For ultra low current measurement, use ASU (atto sense/switch unit).
The HRSMU has an innate 1 fA measurement resolution.  And the ASU extends it to 0.1 fA. 

Note that the ASU must be connected to the HRSMU before turning on the B1500A.
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Configuration

ZERO CHECK
Appendix: Using ASU

You can check whether the ASU connection is correct or wrong.  Open the Configuration window 
and look at the ASU tab screen.  
If the ASU Serial Number field shows its serial number, the HRSMU-ASU combination is correct.
If the ASU Serial Number field shows *s/n mismatch, the combination is wrong.  
The B1500A can work with this wrong combination however it cannot satisfy its specifications.  The 
specifications are guaranteed for the correct combination of HRSMU and ASU.
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HRSMU+ASU

HRSMU

ZERO CHECK
Appendix: Using ASU

This slide shows the open measurement results with ASU and without ASU.
The ASU provides the 1 pA measurement range and the stable measurement results as shown.

The 1 pA range is disabled with the default setting.  To enable the 1 pA range, set the ranging mode 
to LIMITED 1 pA (1 pA limited auto ranging) or FIXED 1 pA (1 pA fixed range).
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You will:
Check low level accuracy with fixture lid open/closed
Observe trade off between resolution and speed
Change resolution from LIMITED 1 nA to LIMITED 10 pA
Observe trade off between averaging and speed
Change integration from AUTO to PLC to MANUAL 

To Get Started:
Use the next pages to setup the MOS FET correctly
Get the IDVG setup in the Demo preset group

Class Exercise
Low Current Subthreshold

The following pages show a typical plot of the subthreshold curves for this class exercise, device 
connections, and setup changes with comments.
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Jumper Leads – MOS transistor

For all class exercises, you need the 28-pin dual in line socket which comes standard with the 4145 
fixture (16058A) or the newer fixture (16442A/B).  Either fixture works fine.

With the 16442A/B fixture, note that there are two SMU numbering schemes....3 SMUs with force 
and sense, or six SMUs with force only.   For this class example we will use the six (6) SMU scheme.  
On older fixtures, this scheme is shown in light blue lettering. In newer fixtures, this scheme is 
shown in white reverse background lettering.

Connect the cables between the B1500A and test fixture as follows.
SMU1 : SMU1
SMU2 : SMU2
SMU3 : SMU3
SMU4 : SMU4
Connect jumper leads as follows.
Terminal 1 : SMU1 F terminal
Terminal 2 : SMU2 F terminal
Terminal 3 : SMU3 F terminal
Terminal 4 : SMU4 F terminal
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Class Exercise
SD214DE MOS Subthreshold

With lid closed, you should see this typical response using the IDVG setup data.  If the subthreshold 
region is much higher, at the pA or nA level, the MOS device may be statically damaged.  Replace 
the device using the handling procedure detailed on the previous page.
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Change LIMITED range 
from 10 pA to 100 nA. 

Change Factor from 16 to 1.  
Change Mode from PLC to AUTO 
to NORMAL.

Class Exercise
Trade Off Speed vs Accuracy

You can trade off speed vs accuracy by varying the LIMITED range setting or the integration time 
setting.  
The 100 nA range will speed up the test but you will lose low-end resolution.  Try setting LIMITED 
to 10 pA range or 100 pA range.  Accuracy increases but speed slows considerably.
For the integration time, small factor value will speed up but accuracy decreases.
Also measurement speed will be changed by the Mode setting.  Set the mode which provides 
applicable measurement results.
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Ve is swept while Vb and Vc are held at 0 V
Ib and Ic are plotted on log scale

Base
Collector

SMU3

Constant
Emitter

VAR1

SMU2

Constant

SMU4

Gummel Plot
What is measured?

The "Gummel Plot" is an excellent low current measurement to make on a bipolar transistor.  It plots 
log base current and log collector current against the same bias voltage.  A good bipolar device has 
constant gain over a wide bias range (both curves are linear and parallel).  Low level  base and 
collector currents can be measured to the fA level on small signal devices.   

Above, we see the simplest channel definition for making a Gummel plot.  The emitter is swept from 
ground to a negative value on a NPN device.  Another method would be to hold Ve at 0 V while 
synchronously sweeping Vb and Vc in a positive direction.  In the later case, Vb could be the 
primary sweep VAR1, and Vc could be the synchronous sweep VAR1'.
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You will notice that sub 10 fA measurements are possible

Set the jumper leads for the bipolar transistor
Insert the device and perform a zero cancel offset
Get the GUMMEL setup in the Demo preset group

To Get Started:

Class Exercise
Low Current Gummel Plot

The following pages will lead you through the setup and measurement procedure for a low current 
Gummel measurement.  Single triaxial cable connections to the force lines of SMUs 2, 3, and 4 are 
fine for this test.  Kelvin triaxial cables are not necessary.
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Jumper Leads - Bipolar examples

For all class exercises, you need the 28-pin dual in line socket which comes standard with the 4145 
fixture (16058A) or the newer fixture (16442A/B).  Either fixture works fine.

With the 16442A/B fixture, note that there are two SMU numbering schemes....3 SMUs with force 
and sense, or six SMUs with force only.   For this class example we will use the six (6) SMU scheme. 

Connect the cables between the B1500A and test fixture as follows.
SMU1 : SMU1
SMU2 : SMU2
SMU3 : SMU3
SMU4 : SMU4
Connect jumper leads as follows.
Terminal 15 : SMU4 F terminal
Terminal 16 : SMU3 F terminal
Terminal 17 : SMU2 F terminal

Locate the bipolar transistor in the corner of the socket as shown, with the flat side of the device 
facing toward you.

Unlike the MOS device, the bipolar transistor is not static sensitive.  You may touch the leads 
without using a ground strap.
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Small step size.
Negative sweep values.

Gummel Plot
Measurement Setup

Ve is swept below ground level to keep positive bias on the NPN device.
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Maximum resolution

16 PLC

Gummel Plot
Range and Integration Time

Medium integration smoothes the plot at the ultra low levels.  Make sure the range is set to AUTO or 
LIMITED  to lowest current range:
HRSMU: 10 pA
MPSMU: 1 nA
HPSMU: 1 nA
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LOW CURRENT MEASUREMENT
Gummel Plot

This curve shows a normal gummel characteristic of the bipolar transistor.  The collector current is 
linear when plotted on log scale from 10 mA down to fA levels.

Keep the fixture lid closed and do not bump any part of the setup during the measurement.

(End of This Class Exercise)
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Fix by isolating 
base-collector leads

Fix by using ferrite
bead on base lead

Gummel Plot With 
Base-Collector Self Oscillation

This is a common occurrence when high frequency bipolar transistors are tested with jumper lead 
connections.   When RF couples in the air to the  base lead, there can be enough DC rectification to 
increase the base current bias.  This causes positive feedback. At some point along the curve, there 
will be enough feedback to abruptly turn on the transistor (steep increase in base and collector 
current).
Separating the leads can help marginally.  Threading one or two ferrite beads onto the base jumper 
lead usually solves the problem.  Use ferrite beads with any type of 4145, 4155, 4156 jumper lead.  
Using the beads on a jumper lead involves prying open one end of the plastic connector.  The 
connector is temporarily unsoldered from the lead to slip on several beads.
For severe oscillation, the RF transistor must be tested in an RF fixtured designed to maintain RF 
isolation between input (base) and output (collector) ports.
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ULTRA LOW CURRENT
Subthreshold Curve

This curve shows the high quality measurement that you would typically expect with the B1500A 
and a well guarded probe station.  The MARKER is sitting at 5.3 fA near the subthreshold region.

To get best ultra low current accuracy, zero the SMU offset error just prior to taking the 
measurement by using the Calibration window.  See beginning of this module, before page 10 in this 
module.  Do the ZEROing procedure with the probes up.
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Small STEP: 100 mV

Large HOLD TIME: 3 sec

ULTRA LOW CURRENT
Measurement Setup

To prevent charging current due to residual cable or probe capacitance, you should limit the STEP 
size to 100 mV.  The B1500A has a built-in delay time on the low current ranges, and you do not 
need to add extra time.

If the STEP is large, like the -500 mV for the first point in this sweep, simply add an initial hold time. 
3 to 5 seconds should work fine.  This has the effect of holding off measurement for a specified 
amount of time, at the beginning point only.
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Not part of the subthreshold characteristic

ULTRA LOW CURRENT
Effect of Cable Charging Current

You can see an initial high current that drops off after a few measurements.  This is the effect when 
delay time is set to zero.  Any residual capacitance due to un-guarded probes is the cause.  This effect 
is minimal in this case due to the use of fully guarded probes to within 2 mm of  the probe tip.  With 
unguarded probes this initial charging current can be orders of magnitude larger, and dominate the 
low end portion of  the subthreshold curve.  

The solution is to improve the guarding as much as practical.  Then get the last bit of charging out of 
the curve by using a delay time of at least 3 seconds in the Measurement Setup.  This gives the cable 
time to discharge prior to making the first measurement.
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Lowest resolution:  Auto or Limited 10 pA                    

Set long integration time

ULTRA LOW CURRENT
Range and Integration Time

In this example we are measuring Id very accurately.  The B1500A autoranges every decade of 
current down to 1 nA as a factory default.  Change this to AUTO or LIMITED 10 pA to get two 
more ranges of low end resolution (1 fA resolution).  The factory default of LIMITED 1 nA gives 
100 fA resolution and is adequate for most measurements.  Since the B1500A can trade off speed for 
resolution, you get better speed performance by limiting current ranging.

If your prober environment is not ultra low noise, you can remove some random noise by setting long 
integration time. 
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Leakage to fA levels
Electrical connection to wafer backside
Chuck must be guarded

Gate

Substrate

Wafer backside

Oxide
+

Low Current Leakage
Gate Oxide

Gate oxide leakage tests are complicated by the fact that there is an electrical connection to the back 
of the wafer.  The chuck must be insulated and guarded to get meaningful low current results.  The 
huge capacitance of the chuck surface would cause charging currents which would swamp out the 
low level currents you are trying to measure through the oxide.



Module 6
Low Current Measurement

6-36

Low Current Gate Oxide Measurement
Fowler-Nordheim (FN) Plot

The Fowler-Nordheim (FN) plot is a log plot of oxide leakage in accumulation mode breakdown.  
The plot shows a characteristic "arc" leading up to the rupture current.

This plot is a measurement result example of a MOS capacitor on a wafer.  You cannot get this kind 
of plot by measuring the class exercise MOS FET. 

The MARKER is set to -27.590 mA.  This is the point at which rupture of the gate oxide occurred.  
The B1500A has the sweep abort function which automatically aborts sweep measurement when any 
abnormal occurs.
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Negative sweep.
Accumulation mode.

Wait for 5 V initial step

FOWLER-NORDHEIM PLOT
Measurement Page

A 3 second delay at the beginning of the measurement will be required.  The SMU must initially step 
from 0 to -5 V, a very large step.  Fully guarded probes to within 2 mm of probe tip and fully guarded 
chuck eliminated the need for delays at every measurement point. The only wait will be the initial 3 
second hold time.
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Gate Oxide Capacitor

Chuck Guard

SMU1 SMU2

Chuck

10^13 ohms

10^13 ohms

Shielding Box (Ground)

Low Current Gate Oxide Meas.
Using Guarded Chuck

This is a simplified block diagram of the prober requirements for a guarded chuck connection.  When 
implemented properly, very fast low level sweeps are possible due to the elimination of stray 
capacitance at the probes (wafer top side) as well as in the chuck (wafer bottom side).
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z SMU Pulsed Sweep Measurement

z I/V-t Sampling Measurement

z Negative Hold Time for High Speed Sampling

z Auto Analysis

z Bias Hold Function

z SMU Filter

z SMU Series Resistor

z Standby Function

In This Module

There are too many measurement functions to conveniently cover in one module.  Ultra low current 
measurement and capacitance measurement are covered in separate modules.  

This module covers the key features listed above.
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z Use PULSE mode for precise force/measure timing
z Pulse down to 500 μs width
z Use current ranges from 1 nA to 1 A  (HPSMU)
z Use voltage ranges from 2 V to 200 V (HPSMU)

z Use PULSE mode for repeatable 1 A measurements
z Eliminate heating during IV sweeps
z Avoid device damage

z Only one pulsed source is available

z Only one measurement channel is available
z Set the expected maximum measurement value to Compliance
z Measurement integration time cannot be changed

SMU Pulsed Sweep Measurement

SMUs can be pulsed for precise force/measure timing, or to reduce heating of the device when 
forcing high currents.

The measurement unit performs measurement by using the compliance range.  It is the minimum 
range which covers the Compliance value.  The Compliance value should be the expected maximum 
measurement value or greater.
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hold time

pulse period
pulse width

stop

start

base

output voltage
or current

time

SMU Pulse Mode
VAR1 Sweep

When you select VPULSE or IPULSE on the Channel Setup screen, the SMU Pulse area will appear 
on the Measurement Setup screen.

Pulse period may be adjusted from 5 ms to 5 s in 100 us steps.  Pulse period is measured from the 
base value to peak value transition, between two consecutive pulses.

Pulse width may be adjusted from 0.5 ms to 2 s in 100 us steps. Pulse width is measured between the 
transition from base value to peak value and the transition from peak value to base value.
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VAR1
Primary

VAR2
Secondary

SMU Pulse Mode
Pulse On Primary Source

One SMU can pulse while another follows.  Either VAR1 or VAR2 may be pulsed, but not both.

The settings above could be used to pulse a drain while stepping the gate.  
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z Use the HPSMU or GNDU as the current return path
z Use Kelvin connections (must use on GNDU)
z Use 16493L GNDU cable for the GNDU connection

S
F

F
S

HRSMU
or

MPSMU

HPSMU   1.0 A

GNDU     4.2 A

Hints on Pulsing the HPSMU

The 1 A SMU (HPSMU) cannot use another MPSMU or HRSMU as the current return.  It must be 
used with the other HPSMU or the GNDU that can sink enough current.  The GNDU is the unit that 
you can use without defining in the Channel Setup.

The GNDU can sink up to 4.2 A, and it is designed for the Kelvin connection.  The force and sense 
lines must be shorted near the DUT.

For the connection of the GNDU, do not use the normal triaxial cable.  The GNDU is rated for up to 
4.2 A, while the maximum current rating of the triaxial cable is 1 A.
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z Minimum pulse width is 500 us

z Only one pulsed source is available

z Only one measurement channel is available

z Measurement range is always compliance range

z Integration time cannot be changed

SMU Pulse Mode
Limitations
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z You will observe a MOS FET family of curves 
z You will edit VAR1 from V mode to VPULSE mode
z You will learn how to properly define a "pulsed" algorithm

z Use the next several pages as you guide
z Get the IDVD setup
z Follow the instructions on the following pages

To Get Started:

Class Exercise
SMU Pulse Mode

You will setup a basic MOS family of curves without VPULSE.  Then change VAR1 to VPULSE.
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16442A/B Fixture

B1500A Rear View

SMU4
SMU3
SMU2

SMU1

CMU

GNDU

SMU Triax Connection
Force Lines to Fixture 1,2,3,4 Ports

This is the SMU cable setup that will be used in the remainder of the class exercises.

Connect the cables between the B1500A and test fixture as follows.
SMU1 : SMU1
SMU2 : SMU2
SMU3 : SMU3
SMU4 : SMU4
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Jumper Leads – MOS transistor

For all class exercises, you need the 28-pin dual in line socket which comes standard with the 4145 
fixture (16058A) or the newer fixture (16442A/B).  Either fixture works fine.

With the 16442A/B fixture, note that there are two SMU numbering schemes....3 SMUs with force 
and sense, or six SMUs with force only.   For this class example we will use the six (6) SMU scheme.  
On older fixtures, this scheme is shown in light blue lettering. In newer fixtures, this scheme is 
shown in white reverse background lettering.
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VPULSE 
Data Display Window

Make a measurement to verify the setup is correct.  You should see the above family of curves.  The 
algorithm is defaulted to standard staircase sweep on VAR1 (no pulsed SMU).
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Drain pulse

Enter new name before save

VPULSE 
Channel Setup

Switch VAR1 from V mode to VPULSE mode.  A new panel will pop up on the Measurement Setup.

Before saving this new setup, enter new name into the Setup Name field, then click the Save button.
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This box pops up 
only if VPULSE 
or IPULSE is set 
on Channel Setup.

Range and 
ADC/Integ
are disabled

Maximum measurement value

VPULSE 
Measurement Setup

Default pulse conditions for the Measurement Setup are shown here.  The base is 0, and the pulse 
duty cycle is 10 %.  These settings are OK for this class exercise.  Click the Single button to start a 
pulsed sweep measurement.

Range and ADC/Integ buttons are disabled for pulsed measurement.  The measurement range is 
always the compliance range.  And the integration time cannot be changed.

For example, if you change the Compliance value to 30 mA, the data beyond 30 mA cannot be 
measured.
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Interval

Hold Time

Starts sampling

Voltage or current

Channel 1 output

Voltage or current

Channel 2 output

Bias hold time
Measurement time

Source

Base

Source

: Measurement

Time

Time=0 (origin)

Time=Hold time + a Time=Hold time + Interval + b
a b

a, b : time from measurement start to integration start

I/V-t Sampling Measurement

B1500A supports the sampling measurement which performs the operation shown above.  
With the SEQUENTIAL output sequence, the source channels start to force the Source value 
sequentially.  Then the last source channel forces the Base value, and forces the Source value after 
the Bias hold time.  After the Hold time, the measurement channels start measurement sequentially, 
and repeat this in the specified interval if the measurement channel is ready to measure.  After the 
last sampling measurement, the source channels stop output sequentially.  
The order of source output is defined in the Channel Setup.  Top of the channels on the setup screen 
starts output first.  And the following channels start output sequentially.  After the measurement, the 
source channels stop output sequentially in the opposite order.

With the SIMULTANEOUS output sequence, the source channels start to force the Base value 
simultaneously.  And the channels force the Source value after the Base hold time.  After the Hold 
time, the measurement channels start measurement sequentially, and repeat this in the specified 
interval if the measurement channel is ready to measure.  After the last sampling measurement, the 
source channels stop output simultaneously.

For the measurement channels which use the high resolution A/D converter, the order of 
measurement is defined in the SMU Range Setup.  Top of the channels on the setup screen starts 
measurement first.  And the following channels start measurement sequentially.  For the 
measurement channels which use the high speed ADC, the channels start measurement 
simultaneously.
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z LINEAR
z Sampling interval: >= 2 ms

0.1 ms to 1.99 ms (limited)
z Number of samples: 1 to 100001

z LOG
z Sampling interval: >= 2 ms
z Number of samples: 1 + number of data for 11 decades
z Remaining data:
10/25/50/100/250/500 data are plotted into one decade 
of the log scale in the same distance

I/V-t Sampling Measurement

There are two sampling mode.  The linear sampling repeats the sampling in the specified interval 
until the number of measurement data reaches the specified number of samples.  High speed 
sampling is available if the following conditions are satisfied. The high speed sampling allows 
you to set the sampling interval 0.1 ms to 1.99 ms in 0.01 ms step.

1. Sampling mode is LINEAR
2. High speed ADC is used for all measurement channels
3. Interval >= 0.08 ms + 0.02 x (number of measurement channels) ms

The log sampling repeats the sampling in the specified interval and gathers the measurement data 
which can be plotted on the log scale in the same distance.   The sampling will be stopped when 
the number of measurement data reaches the specified number of samples.
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z Monitor the charging voltage of an RC circuit
z Learn LOG10 data interval
z Learn how to properly define a sampling algorithm

z Use the instrument setup as same as the SMU pulse exercise
z Connect the RC components as shown in the next page
z Get and run the RC-sampling-log setup
z Change the range or ADC and perform append measurement

To Get Started:

You will:

Class Exercise
Sampling Measurement



Module 7
Measurement Functions

7-17

1 2 3 4 5 6

7 8 9 10 11 12

13 14 15 16 17 18

2019 21 22 23 24

25

27

26

28

14

1528

1

F

G

3
F

G

4
F

G

5
F

G

6
F

G

2
F

G

1
SMU

21
VMU

21
VSU

F

S

GNDU

F
2

F
1

PGU

28: SMU1

25: SMU2

22: SMU4

0.5M

0.1 uF

0.1 uF

0.5 M

Jumper Leads – Sampling Exercise

The 0.5 M ohm and 0.1 uF values were chosen because these values are readily available, and they 
give a RC time constant suitable for observing 2 ms time steps. 
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10 data
10 data

10 data

Y data

X data

X + Y = 20

2 ms 200 s5 decades

Sampling Exercise – LOG10, 2 ms interval
RC Measurement

The RC-sampling-log setup is for the LOG10 sampling with 2 ms interval and 51 samples.
LOG10 sampling obtains 10 data in one decade.  And the data will be plotted on the log scale in the 
same distance.  However this rule cannot be kept at the beginning of sampling because of long 
interval.  
In this example, there are 10 data in each decade from 100 ms to 10 s, and 20 data in the remaining 
decades.  The first data will be near zero second.  See the List Display.
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10 data/decade

10 data/decade

10 data/decade

Sampling Exercise – LOG10, 2 ms interval
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Variable for time data

Sampling Exercise
Channel Setup
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High speed ADC 

FIXED range 

Sampling Exercise
Measurement Setup

Use the FIXED range and the high speed A/D converter to get 2 ms interval.

Change the range to AUTO.  Or change the ADC to the high resolution ADC.  And perform append 
measurement.  You may not get 2 ms interval at the beginning of sampling.
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-90 ms =< Hold Time =< -0.1 ms, 0.1 ms step

Bias starts  at 0 s 

Negative Hold Time 
Available for Interval < 2 ms

For the sampling measurement, the available hold time value is 0 to 655.35 s, in 10 ms step.
However, the negative hold time -90 ms to -0.1 ms, in 0.1 ms step is also available for the high speed 
sampling which the Interval is less than 2 ms.
This measurement result example is obtained by the setup shown in the following pages.
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Jumper Leads – Negative Hold Time
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Negative Hold Time 

Interval < 2 ms 

Current source 

Negative Hold Time
Channel and Measurement Setup
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GM max
*

Early Voltage

Vth

Isub max

Hands-off marker
and line fitting

Auto Analysis

Auto analysis automates the task of doing scalar calculation on swept data.  Computed parameters 
such as Vth or GMmax can be displayed in the Parameters area on the Data Display window.  The 
built-in user functions allow data to be plotted and analyzed according to any arbitrary formula.  The 
B1500A has built-in functions such as axis intercepts, logs, regression lines, area integration, 
max/min, and many more.  The ability to automatically extract important parameters such as 
threshold voltage without the need to manually manipulate screen cursors or markers is important in 
process development.
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Auto Analysis
Vth Example

Here we see a full-featured example of auto analysis.  GMmax and Vth are automatically calculated 
each time a measurement is made.  Even if you alter the analysis, say by moving the line, you can 
restore the original analysis by clicking the Apply button on the Auto Analysis Setup screen.

IMPORTANT!
Please note that formulas for auto analysis are not hard coded into the B1500A.  You define the 
formulas, and so you can customize the method of performing the analysis.
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z Plot square root of the drain current  (SQRT Id)

z Plot rate of change of SQRT Id  (PEAK)

z Find Peak Value of the PEAK plot

z Drop down to the SQRT Id plot

z Draw a tangent line on the SQRT Id plot

z Read the X-intercept of the tangent line as Vth22

Vth Measurement
A Tedious Process Now Automated

In the previous example of graphically determining Vth, the above steps were automated.  There are 
other definitions of Vth which are less complex, but now you don't have to worry about complexity.  
The B1500A can perform the process without you having to interact with the screen.

Not only automation removes human error, but also it allows computer controlled analysis to proceed 
without interruption.
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z Make a MOS threshold voltage (Vth) measurement
z Observe how parameters for the analysis are defined
z Observe how the user functions and analysis functions are 

used in the analysis

z Use the standard MOS device and pin connections
z Get the GMMAX setup
z Make a measurement and turn the knob
z Click the Apply button to restore the analysis

To Get Started:

 You will:

Class Exercise
Auto Analysis

In this exercise you will observe how auto analysis works.  You will understand each setup screen 
required to implement an auto analysis process.
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Good
Continuous Curve
No Static Damage

BAD
Broken-Lumpy Curve
Severe Static Damage

*
*

Vth Measurement
Damaged MOS FET Device?

The class exercise uses a packaged MOS FET device which is very susceptible to static damage.  If 
the device has been handled or moved in and out of the socket a few times, you may see a BAD 
response as indicated above.  Replace the device with a new one.

At the wafer level, you can have the same problems.  Putting a charged probe with cables attached 
down on a gate junction can weaken or destroy the device.  Also, the B1500A offset cancel (zero 
cancel) sends signals down to the probes.  These voltages can damage a sensitive gate junction.
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Vth Measurement
Channel and Measurement Setup

Nothing new here.  This slide is included for completeness.  You will notice that these variables are 
heavily used on the Function Setup screen.
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Vth Measurement
Function Setup

Here are definitions for the Y1-axis plot (SQRT_ID) and the Y2-axis plot (PEAK).  

@L1X means the X-axis intercept of LINE 1.
@L1G^2 means the squared gradient value of LINE 1.  In this case, it is just calculating line 1 slope.  
It is squared to account for the fact that the Y1-axis is a square root.

Click Help > Agilent EasyEXPERT Help to open the online help.  And visit the Read Out Functions
page for all of these functions.
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Vth Measurement
Display Setup Page

VTH and BETA are values which will be displayed at the Parameters area on the Data Display 
window.  

These variables are defined in the Function Setup screen.
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Auto Analysis
Analysis Setup Page

This screen is the heart of auto analysis.  You define custom procedures for graphical analysis with 
fill-in-the-blank ease.  

(End of This Class Exercise)
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CONST

VAR2

VAR2

CONST

Bias Hold   ON

Bias Hold   OFF

VAR1/VAR1’/CMU

VAR1/VAR1’/CMU

Source or Base value for Sampling

Stop or Start value

End of Single measurement
or

Start of next measurement

Stop value

O V

O V

O V

Bias Hold After Measurement

Bias hold function keeps bias output after a measurement is made.  For instance, the user may need 
to keep one or more SMUs on between measurements to bias up a Vcc pin of an IC.  Without this 
function, a user is forced to connect an external power supply. Now there is no need for extra 
supplies.

When this function is ON, the source channels apply the following value.
Constant source: Base value or Source value (I/V-t sampling)
Constant source: Source value (I/V Sweep or C-V Sweep)
VAR1/VAR1’ source: Start value or Stop value (I/V Sweep)
VAR2 source: Stop value (I/V Sweep)
CMU: Start value or Stop value (C-
V Sweep)
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z Perform Repeat Measurement
z Measure the LED I-V characteristics
z Monitor LED during Repeat Measurement

z Use the connection as same as the SMU pulse exercise
z Add an LED and jumper leads per following pages
z Get the LED setup

To Get Started:

You will:

Class Exercise
Bias Hold Function
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Shorter Lead

Jumper Leads – Bias Hold Exercise

Connect test leads as shown.  And add the LED between terminals 13 and 14 of the 28-pin dual in 
line socket.
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SMU1 Function to VAR1

Vh = 0 to 2.5 V

Bias Hold to ON
Output Value to STOP 

Bias Hold Exercise
Channel and Measurement Setup

Set the SMU1 Function to VAR1.  The VAR1 output 0 to 2.5 V is enough to light the LED.

Set the Bias Hold after Measurement field to ON to enable the bias hold function.  And set the 
Output Value after Measurement field to STOP.  This setup keeps 2.5 V output between sweep 
measurements.  So the LED can light between the measurements.
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Repeats three times

Click Run to start 
measurement

Repeat button
Bias Hold Exercise
Repeat Measurement Setup

Click Repeat button to open this window which is used to set and run the repeat measurement.

This example performs the LED I-V sweep measurement three times and then finishes the repeat 
measurement.
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LED lights on

LED lights off

Bias Hold Exercise

During the measurement, leave the fixture lid open.  And monitor the LED.  This measurement does 
not force dangerous voltage.  

At the start of measurement, LED lights off.  Beyond the threshold voltage, the LED lights on.  After 
the measurement, the LED keeps lighting until start of the next sweep measurement.  And this cycle 
is repeated until the end of the repeat measurement.  After the repeat measurement, the LED lights 
off.
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V/I DAC

Filter OFF

Filter ON

Time
Filter setting

SMU 
(V or I mode)

Force

SenseSeries Resistor
(1 M ohm)

SMU Filter

The filter is mounted on each SMU.  It assures clean source output with no spikes or overshooting.  
However, using a filter may increase the SMU settling time.  If measurement speed is top priority, set 
the SMU Filter OFF.
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SMU Filter: ON (add filter)
or OFF (no filter)

SMU Filter

To change the SMU filter setup, open the Advanced Setup window by clicking the Advanced button 
on the Measurement Setup screen.  And specify ON or OFF by using the SMU Filter pull down 
menu.
In the power on state, the Classic Test sets the SMU Filter to ON.
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Series Resistor
(1 M ohm)

SMU 

Force

Sense

Guard
Sense line is internally disconnected 
during the series resistor is connected

GNDU

Use short cable to minimize 
the guard capacitance 

SMU Series Resistor

The series resistor (approx. 1 Mohm) is mounted on each SMU.  The series resistor may be used for 
the device protection, negative resistance measurement, and so on.  It depends on the characteristics 
of test device and measurement environment. 

Note that the series resistor may not effective for device protection.  For example, the breakdown 
measurement may damage the device even if the series resistor is used.

If you use a series resistor, the voltage you set is applied to the near side of the series resistor.  Thus, 
the voltage will be divided by the series resistor and the device under test.  Then, the measurement 
data is not compensated.

Restrictions:
The series resistor cannot be used for the measurements that use the HRSMU connected to the ASU 
or the measurements that use 1 A range of the HPSMU.
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z Measure 0.5 M ohm without Series Resistor
z Measure the same device with Series Resistor
z Learn how the Series Resistor works

z Use the instrument setup as same as the SMU pulse exercise
z Connect 0.5 M ohm as shown in the next page
z Get and run the IV-res setup
z Set the Series Resistor and perform Append measurement

To Get Started:

You will:

Class Exercise
SMU Series Resistor
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Jumper Leads – SMU Series Resistor
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0.5 M ohm (device only)

1.5 M ohm (with Series Resistor)

SMU Series Resistor

The measurement result without the SMU series resistor shows about 0.5 M ohm I-V characteristics.
By setting the SMU series resistor, the measurement result shows about 1.5 M ohm characteristics.  

The IV-res setup uses the analysis function and auto analysis function to draw the regression line and 
get the slope of the line.  For the definition, see the Function Setup screen and the Auto Analysis 
Setup screen.
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Series R: 1MOHM (add 1 M ohm)
or NONE (thru)

SMU Series Resistor

To change the SMU series resistor setup, open the Advanced Setup window by clicking the 
Advanced button on the Measurement Setup screen.  And specify NONE or 1MOHM by using the 
Series R pull down menu.
In the power on state, the Classic Test sets the Series R to NONE.
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to draw regression line

to get slope of the line

SMU Series Resistor
Function Setup and Auto Analysis Setup

The analysis function and the auto analysis function are used to calculate the resistance value. 
This auto analysis setup will draw the regression line for the X-Y1 curve.  And the analysis function 
@L1G is used to pass the slope of the line to the R1 variable.
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Calculated value

1.5 M ohm (with Series Resistor)

SMU Series Resistor
Compensation

If you use the SMU series resistor, you will need to compensate the measurement data to eliminate 
the effects of the series resistor (1 M ohm).  
This is a compensation example by using the following user function.

Vcalc = V1 – I1 * 1000000

The Rcalc value is obtained by using the analysis function and the auto analysis function as same as 
the IV-res setup.
This compensation example is shown in the Rcalc setup.
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Standby Function

Standby function sets any SMUs (except HRSMU with ASU) to specific output values and 
compliances before starting or after stopping measurement. Standby function is useful for power 
supplies of complicated device (eg. Smart TEG), defect analysis, and so on.
This slide shows the standby and measurement operation in the following setup. This example 
assumes that the channel setup is defined in the Standby Channel Definition as follows in the order, 
and the output value in the standby state is the same as the output value in the measurement state.
•SMU1: Voltage source, non-standby channel
•SMU2: Voltage Source, standby channel
•SMU3: Voltage Source, standby channel
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To Use Standby Function

Click the Standby Channel Definition button to open the Standby Channel Definition window.
Define Standby channels (Unit, Mode, Source, and Compliance).
Click the Standby ON button to set standby channel outputs. The Standby indicator will change from 
OFF to ON.



8 Capacitance Measurement
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CMU Fundamentals

Classic Test Environment

CMU Calibration

SCUU for IV/CV Switching 

GSWU for Accurate Capacitance Measurement

ASU for IV/CV Switching

In This Module

Note:
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• Occupies 1 slot of B1500A
• Four terminal pair configuration
• Spot & Sweep measurements 
• Faster measurement time 
• 1 kHz to 5 MHz frequency range
• +/-25V DC bias 

(+/-100V with SCUU)
• Cable length auto detection (1.5 or 3 m)
• Higher accuracy below 100pF

B1500A Multi Frequency CMU

The multi frequency CMU (capacitance measurement unit) adds the CV measurement capability to 
the B1500A.  You can now perform both IV and CV measurements by using the B1500A one box 
without an external capacitance meter.
Key features of the CMU are listed above.
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CMU

CMU Block Diagram
Four-Terminal Pair Configuration

Generally, any mutual inductance, interference of the measurement signals, and unwanted residual 
factors in the connection method incidental to ordinary termination methods will have significant 
effects on the measurements, especially at a high frequency.  The CMU employs the four-terminal 
pair (4TP) measurement configuration which permits easy, stable, and accurate measurements and 
avoids the measurement limitations inherent to such factors.

The above figure shows the four-terminal pair measurement principle.  The measurement terminals 
consist of the following four coaxial connectors.
-Hcur: High current
-Hpot: High potential
-Lpot: Low potential
-Lcur: Low current
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Single Sweep Double Sweep

Linear Sweep

Up to +/- 25 V, using only CMU
Up to +/- 100 V, using SCUU (Agilent N1301A-100)

C-V Sweep Source

CMU supports the linear single sweep and the linear double sweep.  The CMU can sweep up to a 
value and then back down (double sweep).  This feature is useful when the device must be tested 
without abruptly removing the forcing condition.

The CMU can force up to 25 V DC bias.  The DC bias can be expanded up to 100 V by using the 
SCUU (SMU CMU unify unit) that is used to switch the IV measurement and the CV measurement 
automatically.  For the SCUU, see the following pages in this module.
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You will make the MOS FET Cgs-Vg measurement
You will learn how to properly define a C-V sweep algorithm

Use the next several pages as you guide
Get the CV-1MHz setup
Follow the instructions on the following pages

To Get Started:

Class Exercise
C-V Sweep Measurement
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16442A/B Fixture

B1500A Rear View

SMU4
SMU3
SMU2

SMU1

CMU

GNDU

Cable Connections

The following cables are required to perform this class exercise.
CMU cable (Agilent N1300A-001/002), 1 ea.
Triax cable (Agilent 16494A-001/002), 2 ea.

One side of the CMU cable forms the attachment used to join and fix it to the CMU.  And the other 
side provides four BNC connectors used to connect the fixture as shown.

Connect the cables between the B1500A and the test fixture as follows.
SMU1 : SMU1
SMU2 : SMU2
Hcur : PGU1 (red)
Hpot : PGU2 (orange)
Lcur : VSU1 (black)
Lpot : VSU2 (gray)
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CMUL 

CMUH 

Jumper Leads – MOS transistor

For all class exercises, you need the 28-pin dual in line socket which comes standard with the 4145 
fixture (16058A) or the newer fixture (16442A/B).  Either fixture works fine.

With the 16442A/B fixture, note that there are two SMU numbering schemes....3 SMUs with force 
and sense, or six SMUs with force only.   For this class example we will use the six (6) SMU scheme.  
On older fixtures, this scheme is shown in light blue lettering. In newer fixtures, this scheme is 
shown in white reverse background lettering.

This class exercise requires six jumper leads to connect the DUT.  Connect the jumper leads between 
the following terminals.
SMU1 : terminal 2
SMU2 : terminal 4
PGU1 : terminal 1
PGU2 : terminal 1
VSU1 : terminal 3
VSU2 : terminal 3
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Cgs

Conductance

Capacitance Measurement 
Measurement Example

This is the measurement example of the MOS FET Cgs-Vg characteristics.  
To make the measurement, set SMU1 and SMU2 to COMMON.  And set the CMU as shown in the 
next page.
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DC bias:
-5 V to +5 V

Frequency
and Oscillation level

Integration time

Selects measurement parameters

Capacitance Measurement 
Measurement Setup

1. Select the Cp-G mode, and enter the C Name and G Name.
2. Set the Start, Stop, and Step to specify the DC bias sweep condition.
3. Set the Frequency List to specify the measurement frequency.
4. Set the AC Level to specify the AC signal level (oscillation level).
5. Set the Integration Time as you like.

(End of This Class Exercise)
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Open terminalsCorrects phase error caused 
by extending measurement 
cables.

Phase 
Compensation

Connect standardCorrects any error by using 
the working standard.

Load Correction

Connect terminals 
together

Corrects for residual 
impedance. Effective for low 
impedance measurement.

Short Correction

Open terminalsCorrects for stray admittance. 
Effective for high impedance 
measurement.

Open Correction

Measurement 
terminals

EffectivenessType

Perform before 
measurement

Recommended

Recommended

Perform before 
measurement

CMU Calibration

CMU is equipped with the error correction function used to realize accurate impedance 
measurements.  The correction function minimizes the effects of the error elements in the extension 
cables and the DUT interface such as manipulator and probe card.

At least perform the phase compensation and the open correction. They only need to open the 
measurement terminals.

Performing the short correction and the load correction is recommended.  

If it is easy to make the short condition in your test environment, perform the short correction.

If you have the load standard, perform the load correction.

The standard must have the reference value.  And the reference value must be defined in the 
Advanced Options for CMU Calibration window.  This window is opened by clicking the Advanced 
Options… button.  See the next page.
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Calibration

Opens dialog box to start 
correction/compensation.

CMU Calibration

Open the Calibration window and click the CMU Calibration tab to perform the CMU calibration.

At first, open the measurement terminals for CMUH and CMUL, and perform the Phase 
Compensation by clicking the Measure… button.

After the phase compensation, perform the Open Correction by clicking the Measure… button.

If you can make the short condition, short the measurement terminals, and perform the Short 
Correction.

If you have the load standard, connect it, and perform the Load Correction.

Note:
If you use the calibration standard, define the reference data before starting the calibration.  It must 
be defined in the Reference Standard Value on the Advanced Options for CMU Calibration window.
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SCUU Output: Force1/CMUH
Force2/CMUL

Triaxial Cable

Manipulator/Positioner

Switches CV/IV

B1500A with SCUU

SCUU – for IV/CV Switching

Guard

Force 

Guard

Force 

Hcur/Hpot

C
M

U

SMU N+1

SMU N

IV

CV

IV

CV

N: SMU number, Integer.

Lcur/Lpot

You have a very hard time switching between CV and IV measurements (you may actually devote 
separate probe stations to CV and IV just to avoid having to change cables).  In addition, great care 
has to be taken when cabling to a capacitance meter to insure that all of the capacitance 
measurements are properly compensated.
The SCUU removes all of these worries and makes connection simple and easy.  In addition, the 
B1500A software automatically takes care of the multiplexing based upon the type of algorithm 
selected from the front panel.
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B1500A Rear View

SMU4
SMU3
SMU2

SMU1

CMU

GNDU

CMUL or SMU4 Force

CMUH or SMU5 Force

SMU5 16442A/B Fixture

SCUU Connection Example – Direct Docking

Before connecting the SCUU, turn the B1500A off.  And restart the B1500A after connection is 
completed.  The B1500A cannot recognize the SCUU without restart after connection.

Use normal triaxial cables or Kelvin triaxial cables to connect between the SCUU and the test fixture.
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CMU
SMU CMU Unify Unit 

(SCUU)

SCUU cable
SMU

SMU

Force1 or CMUH

Force2 or CMUL

Sense1

Sense2

SCUU Connection Example – SCUU Cable

To install the SCUU near the manipulators/positioners, use the N1301A-102 SCUU cable. 

To realize accurate capacitance measurement, use the N1301A-200/201/202 GSWU & cable.  See 
the next section.
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Hc

Hp

Lp

Lc

CMU cable or 
SCUU cable Extension cableCMU Manipulator 

or Positioner

DUT

4TP configuration Shielded 2T 
configuration

3T configuration

Return path

GSWU
– for Accurate Capacitance Measurement

This slide shows the typical cable connections for the capacitance measurement.  Note the following 
tips to perform the measurement accurately.
-Extend the four terminal pair configuration as close as possible to the device side
-Make the return path at the end of the extension cables (coaxial cables)
The return path is effective for:
-reducing the residual inductance of the measurement cable
-stabilizing the residual inductance when measurement cable distance is changed (moved)
The residual inductance will be roughly 1/10 to 1/30 compared with no return path.

To make the return path, use the GSWU (Ground Switch Unit) which was developed to make the 
setup easily.  The GSWU is the accessory available only for the B1500A equipped with the CMU 
and the SCUU. 

Note:
For the accurate measurement, it is recommended to make the return path at the point as close as 
possible to the device side.
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SCUU Output: Force1/CMUH
Force2/CMUL

Triaxial Cable

Manipulator/Positioner

GSWU

CV

IV

Guard

Force 

Guard

Force 

GSWU Control Cable

Hcur/Hpot

C
M

U

SMU N+1

SMU N

IV

CV

IV

CV

N: SMU number, Integer.

Lcur/Lpot

Switches CV/IV CV: thru

IV: open

Clip wireClip wire

Switches CV/IV

B1500A with SCUU

GSWU
Simple direct connection between SMU/CMU and 
manipulator/positioner

GSWU Connection Example

1. Place the GSWU at the appropriate location near the manipulators/positioners.
2. Connect the GSWU control cable between the GSWU and the SCUU.
3. Connect a clip wire between the GSWU and the outer conductor of the manipulator/positioner
connected to Force1/CMUH.
4. Connect a clip wire the GSWU and the outer conductor of the manipulator/positioner connected to 
Force2/CMUL.

When the SMU paths (IV) are available for the manipulators/positioners, the GSWU opens between 
the outer conductors.  However, when the CMU paths (CV) are available, the GSWU connects them 
together to make the return path of measurement current. 
By using the EasyEXPERT software, cable length between the CMU and the SCUU is automatically 
detected, and the GSWU switch control is automatically performed.  Also, capacitance error 
compensation is also automatically performed if the compensation data are available.

Note:
When the SMU paths are available for the manipulators/positioners, the connection between the 
outer conductors must be broken because they are connected to the SMU guard terminals separately 
and the guard terminals must be disconnected from anything at the end of the extension.
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To CMU Hpot/Hcur

ASU 2

ASU 1
To HRSMU 1

CMUH or Force

CMUL or
Force

Sense

Sense

CMU return path

To CMU Lpot/Lcur
To HRSMU 2

ASU – for IV/CV Switching

The ASU (Atto Sense and Switch Unit) is available for the B1500A installed with the HRSMU.  
Using the ASU permits use of the 1 pA range.  Also the ASU can switch the measurement resources, 
HRSMU or an instrument connected to the AUX input connectors.

The ASU has input connectors, one triaxial and two coaxial.  The triaxial connector must be 
connected to the HRSMU Force terminal, and the coaxial connectors must be connected to the other 
resource such as CMU.  Also the ASU has the control connector to be connected to the HRSMU by 
using the ASU cable.

The ASU has output connectors, two triaxial, that must be connected to the DUT interface such as 
manipulators or probe card.  When the measurement resource is the HRSMU, they are the 
Force/Sense connectors for the Kelvin connection.  And when the resource is not the HRSMU, the 
CMU/AUX is connected to the Force, and the Sense is not used.

If you connect the CMU, two ASUs are required.  Then the ASU’s CMU-pot/CMU-cur connectors 
must be connected to the Hpot/Hcur of the CMU.  And the other one must be connected to the 
Lpot/Lcur in like manner.

To realize accurate impedance measurements using the four-terminal pair measurement method, 
connect the CMU return terminals of ASUs together.

Note:
For the accurate measurement, it is recommended to make the return path at the point as close as 
possible to the device side.
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B1500A Rear View

SMU4
SMU3
SMU2

SMU1

CMU

GNDU

Hcur Hpot

Lcur Lpot

SMU3 Force

SMU2 Force

ASU1

ASU2

ASU to CMU/HRSMU Connection Example

To connect the ASUs, use the following cables.
CMU cable (Agilent N1300A-001/002), 1 ea.
Triax cable (a part of Agilent B5288A-001/002), 2 ea.
D-sub cable (a part of Agilent B5288A-001/002), 2 ea.

One side of the CMU cable forms the attachment used to join and fix it to the CMU.  And the other 
side provides four BNC connectors used to connect two ASUs as shown.

The triax cable and the D-sub cable are connected between ASU and HRSMU.

Before starting the ASU connection, turn the B1500A off.  And restart the B1500A after the 
connection is completed.  The B1500A cannot recognize the ASUs without restart after the 
connection.
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Configuration

ASU I/O Path: SMU (to use HRSMU)
or AUX (to use CMU)

ASU Switch Control

To control the ASU switch connection, open the Configuration window and display the ASU tab 
screen.  Then highlight the B1517A/B5288A row and set the ASU I/O Path, SMU or AUX by using 
the ASU I/O Path pull down menu.

Set SMU when you use the HRSMU.
Set AUX when you use the CMU or the other resource connected to the ASU’s AUX In.

If the ASU Serial Number field shows its serial number, the HRSMU-ASU combination is correct.
If the ASU Serial Number field shows *s/n mismatch, the combination is wrong.  
The B1500A can work with this wrong combination however it cannot satisfy its specifications.  The 
specifications are guaranteed for the correct combination of HRSMU and ASU.
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In This Module

• To Open Application Test Definition 

• To Modify Test Definition 

• To Use Debug Tools

• To Use Built-in Functions

• To Add Data Display

• To Use Auto Analysis 

• To Define Test Output

• To Use Test Setup Internal Variables

• To Use Vector Data to Modify Test Definition
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Modification Overview

1. Open an application test definition to be modified

2. Open test definition editor

3. Save the definition as your test definition

4. Modify the definition as you like

5. Resave and close the definition

6. Export your test definition as your backup

This module explains the modification example using the Vth Const Id test definition.  After the 
modification, the new definition can perform the Vth Const Id measurement, display the Id-Vg curve, 
and additionally display the gm-Vg curve.
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To Open an Application Test Definition
Example: Select Vth Const Id as template

Click a test definition in Library list area, and click Select button to open the test definition.
For example, open Vth Const Id.
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To Open Test Definition Editor
Click Library>Open Definition of This Test…

Cancel
Define New Test…
Open Definition of This Test…
Delete Definition of This Test
Import Test Definition…
Export Test Definition…

Click Library and select Open Definition of This Test… to open the test definition editor.

The following pages show the modification example to display the gm-Vg curve given by the Vth
Const Id test result.
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To Save Definition As Your Definition
Save the definition as your definition (ex: Trng vth)

Test Definition editor

Save   Ctrl+S
Close

new categorynew test name

Create a new Category (ex. Exercise), and change the Test Name (ex. Trng Vth).
After changing the test name, save the test definition.  Saving the definition will change the window 
title to the new test name.  Window title will be changed from Vth Const Id to Trng Vth in this 
example.

In this example, the Trng Vth definition belongs to the Exercise category only.
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To Modify Test Definition
Change default values and add parameters (ex: Pcomp_d)

This area sets the 
properties of the 
specified parameter.

•Min
•Max
•Digits
•Resolution
•Unit
•Typical Values
•Symbols

Test Definition editor

On the Test Specification tab screen, you can add new parameters or change parameter settings.  
This example changes the default value of the Module parameters for the MOS FET class exercise 
typical setup and adds the Pcomp_d test parameter (drain terminal power compliance).
The Module parameter default values are changed as follows.  See the actual settings on the test 
definition editor.
Drain: SMU4
Gate: SMU3
Source: SMU2
Subs: SMU1

The Pcomp_d parameter is defined as follows.
Name=Pcomp_d, Type=Numeric, Default=1 mW, Description=Power compliance for drain terminal, 
Align=check, X=550, Y=120, Width=80, Ext=uncheck
Properties: Min=1 mW, Max=20 mW, Digits=4, Resolution=1 mW, Unit=W
For Align, X, Y, and Width values, consult the settings of the other parameters for the same terminal 
(ex. Drain). For example, Pcomp_d must be located between Vd and Subs entry fields (see 
application test screen on the main window).  So X and Width should be the same as the settings of 
Vd, and Y should be between 90 and 180 (see the actual settings of Vd and Subs on the test 
definition editor).

Typical Values… button opens a dialog box used to define the typical values used for the selections 
of the parameter value in the Application Test mode.  For example, set 2 mW to 20 mW in 2 mW
step for Pcomp_d.

Symbols… button opens a dialog box used to map a numeric value to a string.  For example, 
Value=1 and Symbol=ON are set, typing ON enters 1, and typing 1 enters ON.  The value must 
satisfy the Min, Max, Digits, and Resolution settings. The value and the symbol must be one by one.  
The definition is effective only for the parameter.
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To Modify Test Definition
Change or set test parameters (ex: Pcomp_d)

Test Definition editor

On the Test Contents tab screen, you can change the test execution flow (program flow), 
measurement conditions, display setup, and so on.

To add the Pcomp_d parameter to the measurement setup, click the Vth Const Id line in the program 
list.  And in the I/V Sweep setup editor, display the Measurement Setup tab screen.  And enter 
Pcomp_d to the Pwr Comp entry field.
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To Modify Test Definition
Change display setup and define external variables

Test Definition editor

External variable
Test setup internal variable

External variables must 
be defined before making 
the matching table.

On the Display Setup tab screen, you can change the graph scale Min/Max values or add/delete the 
list parameters.

This example makes the matching table between the External variables and the Measurement data.  
The measurement data can be referred outside the test setup via the external variable. 
Where, the measurement data means the variables used in the test setup.  And the external variables 
means the parameters defined in the Test Specification, the Local Variable Definition, or the Test 
Output’s Analysis Parameter Definition.

This example sets the matching table as follows.
Vth_constId external variable: Vth internal variable
GM_data external variable: gm internal variable
VG_data external variable: Vgate internal variable
ID_data external variable: Idrain internal variable

External variables must be defined before making the matching table.  In this example, the variables 
are defined in the Analysis Parameter Definition.  See the next page.
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To Modify Test Definition

Test Definition editor

Define Test Output and Analysis Parameters

This example defines the Test Output and the Analysis Parameters.
1. Display the Test Output screen.
2. Check the Define own Output Parameters.
3. Click the Define Analysis Parameters button.
4. Define the analysis parameters (ex. GM_data, VG_data, ID_data, and Vth_constID).
5. Define the X-Y Graph, List Display, and Parameters.

Note
External variables must be defined before making the matching table shown in the previous page.  In 
this example, the following parameters can be the external variables.
Parameters defined in the Test Specification
Variables defined in the Local Variable Definition
Variables defined in the Analysis Parameter Definition (this example)

Note
If this test definition is used in the other test definition, the analysis parameters can be referred 
outside this test definition.  This means that the analysis parameters can be the Measurement data in 
the External Variable Setup as shown in the previous page.
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To Modify Test Definition
Add local variable (ex: Yes for Message box)

Test Definition editor

Variable Yes is used in 
the message box.

Click Local Variables Definition line to display the local variable list.  And define variables.
This example defines Yes variable as follows.  This variable is used in a message box.  See the next 
page.
Name=Yes, Value=0, Description=User response
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To Modify Test Definition
Define Message box

Test Definition editor

This setup makes the OK button on 
the message box.

This message box 
asks you clicking the 
OK button to display 
the gm curve.

The value of the local 
variable Yes is set to 1 
from 0 by clicking the 
OK button.

This setup displays the message 
“To display the gm curve, click OK.”
on the message box.

Click the Message line in the program list.  And define the message box.
This example defines the message box that opens after the Vth Const Id measurement and displays a 

message and the OK button.
1. Enter the message.
2. Enter the button name. 
3. Select the variable used to keep the status of the button.
4. Repeat 2 and 3 for all buttons you want to add.
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To Modify Test Definition
Example: Displaying Message box

In this modification example, the message box opens after the Vth Const Id measurement is 
completed.  This message box asks you clicking the OK button to display the gm curve.
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Class Exercise

Modify test definition.

1. Open Id-Vd test definition.

2. Modify it as follows.
- to move marker and tangent line to Vdrain=1 point 
if Yes is clicked after Id-Vd test.
- to perform Vth gmMax test if Yes is clicked.

3. Use the debug tools.

4. Save the definition as a new one (ex. Trng IdVd Vth).

5. Perform the test.

6. Export the new definition, and import it. 

1. Add the Yes variable to the Local Variable Definition.
2. Insert the following lines between the lines Id-Vd and END BLOCK.
Message
IF Yes=1

Auto Analysis 
END IF
Message
IF Yes=1

Vth gmMax
END IF

3. Define the first message box.
Message: Do you perform auto analysis?
Button1 Label: Yes, Selected: Yes
Button 2 Label: No, Selected: (blank)

4. Define the second message box.
Message: Do you perform Vth gmMax test?
Button1 Label: Yes, Selected: Yes
Button 2 Label: No, Selected: (blank)

5. Define the IF statements.
Condition Expression: Yes=1

6. Define the Auto Analysis.
Line 1: Enable, Tangent, Axis: Y1, Data Condition: Vdrain=1
Marker: Enable, Condition: Vdrain=1

7. Change the Vth gmMax test parameters as follows.
Drain: Drain
Gate: Gate
Source: Source
Subs: Subs
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To Use Debug Tools

Break point

ReturnPort = SMU1

ReturnCh = OUT1

Variable Inspector

This slide shows an example of using the Variable Inspector for debugging.  Confirm whether the 
correct values are passed to the variables properly.
Set the break point, and click the Run button.  After the program is paused, click the Inspect button.  
The Variable Inspector is displayed.  You can check the values by using the variable display fields.  
The field can be displayed by using the Add XXXX Variable button.  XXXX will be Numeric, 
Vector, String, or Module.
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•Run
•Abort
•Stop
•Break
•Inspect 

To Use Debug Tools

The Debug tab menu provides the following buttons:
•Run button starts the debug (executes the test flow).  During execution, the label changes to Pause.  
Clicking Pause button pauses the execution, and changes the label to Run that is used to continue the 
debug (execution).
•Abort button aborts the debug (execution).
•Step button executes the highlighted line of the test flow.  Clicking the button repeatedly continues 
the execution by a line.
•Break button sets/releases the break point.  For the break point, this button releases the break point 
from the highlighted line.  Program execution will break at the break point automatically.
•Inspect button is available when the debug (execution) is paused or breaked.  This button opens the 
Variable Inspector used to monitor value of device parameters, test parameters, analysis parameters, 
local variables, or system variables.
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Debug: Inspect button

Break point

Paused point

To Use Debug Tools

The Variable Inspector is displayed by clicking the Inspect button after the program is paused, and is 
used to monitor or change the value of the device parameters, test parameters, analysis parameters, 
local variables, or system variables.  For the vector variables, only data monitor is available. The 
Variable Inspector provides the following buttons to add the variable monitor area.
• Add Numeric Variable
• Add Vector Variable
• Add String Variable
• Add Module Variable
The following functions are available for the menu displayed by clicking the banner of the variable 
monitor area.
•Up: This button shifts the variable monitor area upward.
•Down: This button shifts the variable monitor area downward.
•Remove: This button deletes the variable monitor area.
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To Resave and Close Your Test Definition
Close the definition editor, and overwrite your test definition

Save   Ctrl+S
Close

Test Definition editor

After you create your test definition, save the definition and close the Test Definition editor.
Click File > Close.  Confirm Test Definition Save dialog box is opened.  Click Yes to save your test 
definition and continue the close operation.  The Confirm Test Definition Overwrite dialog box is 
opened.  Click OK to overwrite your test definition.
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To Export/Import Test Definition
Click Library>Export Test Definition or Import Test Definition

Cancel
Define New Test…
Open Definition of This Test…
Delete Definition of This Test
Import Test Definition…
Export Test Definition…

The test definition can be exported as the EasyEXPERT test definition file format or XML file 
format.  And the file can be imported to the EasyEXPERT later.
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To Use Built-in Functions
Absolute value: abs(A)
Averaging: avg(A), mavg(A,B)
Data conversion: string(A), value(A)
Difference: delta(A)
Differentiation, integration: diff(A,B), integ(A,B)
Exponent, logarithm: exp(A), lgt(A), log(A)
Maximum, minimum: max(A), min(A) 
Reading data : getNumericData(A), getVectorData(A)
Square root: sqrt(A)
Trigonometric function: acos(A), asin(A) , atan(A), atan2(A,B), 

cos(A), sin(A), tan(A) 

The EasyEXPERT software provides the built-in functions to calculate the display data and 
parameter or to get the test result data.  The built-in functions can be used in the user function and 
analysis function of the test setup, and in the test execution flow of the test contents. 
The following functions are also available.
at(A,B), at(A,B,C), ceil(A), cond(A,B,C,D), dim1Size(A), dim2Size(A), floor(A), index(A,B), 
isValid(A), setDeviceId(A), storeAt(A,B,C,D), substring(A,B,C), swmToModule(A)
For details of the functions, see User’s Guide or online help.
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To Use Built-in Functions
User function setup example

gm = diff(Id,Vg)
gmMax = max(gm)

GM_MAX=getVectorData(gmMax)
VTH=getNumericData(Vth)
GM=getVectorData(gm)
ID=getVectorData(Id)
VG=getVectorData(Vg)

This is an user function setup example.  This example uses the diff function to calculate gm values 
and the max function to get the maximum gm value.
Also, the getVectorData and getNumericData functions are used in the test execution flow to get the 
test result data.
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To Use Read Out Functions

Marker index value: @MI

X coordinate value: @MX, @CX

Y coordinate value: @MY, @MYn, @CY, @CYn

Regression line parameter: @L1CO, @L2CO

Line slope: @L1G, @L1Gn, @L2G. @L2Gn

Line X intercept: @L1X, @L2X

Line Y intercept: @L1Y, @L1Yn, @L2Y, @L2Yn

Intersection of lines: @IX, @IY, @IYn

n: integer. 1 to 8.

The EasyEXPERT software provides the read out functions to read the marker position, cursor 
position, line slope, line intercept, and so on.  The read out functions can be used in the analysis 
function of the test setup.
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To Use Read Out Functions
Analysis function setup example

Vth = @L1X

This is an analysis function setup example.  This example uses the @L1X function to get the X 
intercept value of the line 1.
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To Add Data Display
Analysis: Display Data Setup

Data display

Measurement, 
data display, and 
data save

The test setup performs measurement, displays the test result, and stores the test result data to the test 
record.
In addition to the default test result display, you can make additional data display by using the 
Display Data Setup statement.  The statement provides the user interface as same as the Display 
Setup of the Classic Test or the Test Output of the test definition.  The above example displays the 
ID-VG/GM-VG curves, GM_MAX and VTH values, and tangent line by using the extra Data 
Display and Auto Analysis function.  See next slide.

Note:
This additional display data cannot be saved to the data record. However only the last display data 
can be saved if the Test Output has not been set.
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To Add Data Display
Additional data display example

This is a test result example displayed on the Data Display window.
The auto analysis setup for this example is shown in the next page.
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To Use Auto Analysis Function
Analysis: Auto Analysis

• Line 1

• Line 2

• Marker

GM=GM_MAX

The Auto Analysis statement is used to apply the automatic analysis function to the last test result 
before this statement.  When the test finishes, the function automatically draws lines, a marker, or 
both on the X-Y Graph of the Data Display window.  This statement provides the same GUI as the 
Auto Analysis setup in the Classic Test. 
You can set up two lines and one marker for the automatic analysis function by using the setup 
editor.
In the Line 1 and Line 2 areas, you can set up the lines to be drawn.
In the Marker area, you can set up the marker.

This example draws the tangent line for the Y1 data at the maximum GM point. 
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To Control Test Result Data Outputs

Analysis: Data Display Control

Data Display: OFF/ON

Miscellaneous: Data Store Control

Data Store: OFF/ON

By the default setting, the results of the tests defined in your test definition are displayed on the Data 
Display window and are stored to the data record.
You can control the data display of the tests by using the Data Display Control statement.  Insert the 
statement, and remove the check from the Enable Data Display box to disable the data display.
You can also control the data storage of the tests by using the Data Store Control statement.  Insert 
the statement, and remove the check from the Enable Creating Test Result Record box to disable the 
data storage.
The functions cannot control the following data output.  They are always enabled.
-Data output by the Test Output of the test definition
-Data output by the last test setup if the Test Output has not been set
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To Define Test Output

Opens Analysis Parameter 
Definition window 
(see next page).

1. Define analysis parameters.
2. Set display parameters.

Specify X axis and Y axis

Select variables to list
Select parameters to 
display

The test output setup is optional.  If you have the following requirements, define the analysis 
parameters and set the display parameters.
-To send the test result data to the subsequent tests in an application test
-To make the program branching depends on the test result
-To make the calculation using the test data in the Test Contents
-To display/record the test result of this application test
At first, define the analysis parameters:
•Check the Define own Output Parameters box.
•Click the Define Analysis Parameters… button.  The Analysis Parameter Definition window is 
opened.
•Declare the analysis parameters.  See next slide.
•Click the Close button.
•Set the display parameters.  See below.
The X-Y Graph area is used to set the X axis and Y axis of the X-Y Graph Plot area on the Data 
Display window.
•Name: Name of variable to plot on the X axis
•Scale: Linear or Log
•Min: Minimum value of the specified axis
•Max: Maximum value of the specified axis
The List Display area selects the variables to be listed on the List Display area of the Data Display 
window.  Up to 20 variables can be set.
The Parameters area selects the variables to be listed on the Parameters area of the Data Display 
window.  Up to 20 parameters can be set.
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To Define Test Output
Analysis Parameters Define Analysis Parameters…

Define the analysis parameters as shown below:
At the Vector Parameters area or the Scalar Parameters area:
•Click the Add button.
•Enter the Name, Unit, and Description of the parameter.
For the sweep output/measurement data, use the vector parameter.
For the spot output/measurement data, use the scalar parameter.
For the data given by the max( ) and min( ) built-in function, use the vector parameter.
In this example, VG, ID, and GM are the vector parameter and VTH is the scalar parameter. 
GM_MAX is the vector parameter because the max( ) built-in function is used to calculate this value.
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To Define Test Output
Display Parameters

This example sets:
X-Y Graph: ID-VG plot for Y1-X graph and GM-VG plot for Y2-X graph
List Display: VG, ID, and GM
Parameters: GM_MAX and VTH
All parameters must be defined in the Analysis Parameter Definition window shown in the previous 
slide.
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To Use Test Setup Internal Variables

From Classic Test setup,
Display Setup screen

Assign to external variables…

External Variable Setup

•Local variable
•Device parameter
•Test parameter
•Analysis parameter

Internal variable

From Application Test setup

Assign to external variables…

You may want to read the parameters/variables used in Classic Test setup or Application Test setup 
defined in the Test Contents.  Then use the External Variables Setup window used to make a 
mapping table between the test setup internal variables/parameters and the external variables (local 
variables, device parameters, test parameters, or analysis parameters).

To open the External Variable Setup window from a classic test setup:
•Specify the classic test.
•Click the Display Setup tab.
•Click the Assign to external variables… button.
To open the External Variable Setup window from an application test setup:
•Specify the application test.
•Click the Assign to external variables… button.
Note
Application test internal parameter/variable to be connected to an external variable must be the 
analysis parameter in its test definition.
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To Use Test Setup Internal Variables 
Setup example Assign to external variables…

This example makes the mapping table between the test setup internal parameters and the analysis 
parameters. 
•Define VTH, GM_MAX, VG, ID, and GM as the analysis parameters.
•Set these analysis parameters to the display parameters.
•Open the External Variable Setup dialog box.
•Assign VTH to the internal parameter Vth.
•Assign VG to the internal parameter Vg. 
•Assign GM to the internal parameter gm. 
•Assign GM_MAX to the internal parameter gmMax.
•Assign ID to the internal parameter Id.

For the example definition, open the Trng idvd idvg2 definition stored in the ¥data folder on the 
Manual CD-ROM.  The Manual CD-ROM stores the example test setup and definition data used in 
this manual.
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To Use Test Setup Internal Variables 
Result example

This is a result example of the test output setup shown in the previous pages.
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To Use Test Setup Internal Variables 
Using built-in functions
Local Variables Definition

BLOCK

IdVg

VG = getVectorData(“Vg”)

ID = getVectorData(“Id”)

GM = getVectorData(“gm”)

GM_MAX = getVectorData(“gmMax”)

VTH = getNumericData(“Vth”)

IdVd

END BLOCK

Vg, Id, gm, gmMax, and Vth
must be the display 
parameters of IdVg.

Display parameters of
the last Data Display window

Test setup

Test setup

This example shows another way to read the value of the internal variables (Vg, Id, gm, gmMax, and 
Vth).  In this example, you do not use the mapping table but use the getVectorData and 
getNumericData built-in functions.  The functions can be used to read the value of parameters 
displayed on the last data display. 
To read the value:
•Define VG, ID, GM, GM_MAX, and VTH as the analysis parameters.
•Set these analysis parameters to the display parameters.
•Insert the ASSIGN statements to add the formula shown above. 
Note
Application test internal parameter/variable to be connected to an external variable must be the 
analysis parameter in its test definition.
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To Use Test Setup Internal Variables 
Using built-in functions, setup example

This example sets the following test flow:
Local Variables Definition    ! Defiles Yes variable
BLOCK

Message    ! Do you perform Id-Vg measurement?
IF Yes=1

IdVg ! Classic test setup for Id-Vg measurement
VG=getVectorData(“Vg”)
ID=getVectorData(“Id”)
GM=getVectorData(“gm”)
GM_MAX=getVectorData(“gmMax”)
VTH=getNumericData(“Vth”)

END IF
Message    ! Do you perform Id-Vd measurement?
IF Yes=1 
IdVd ! Classic test setup for Id-Vd measurement
END IF
Message    ! Click OK to display VTH and GM_MAX values and end the test

END BLOCK

For the example definition, open the Trng idvd idvg3 definition stored in the ¥data folder on the 
Manual CD-ROM.  The Manual CD-ROM stores the example test setup and definition data used in 
this manual.
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To Use Test Setup Internal Variables 
Using built-in functions, result example

This is a result example of the test output setup shown in the previous pages.
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Class Exercise

Modify test definition using vector data.

1. Open the Cgg-Vg test definition.

2. Modify it for the multiple frequency test using a 
vector data. See next several pages.

3. Use the debug tools.

4. Save the definition as a new one (ex. Trng Cgg-Vg).

5. Perform the test.

6. Export the new definition, and import it. 
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To open test definition of Cgg-Vg Application 
Test

Select the Cgg-Vq Application Test in the CMOS Category.
Click the Library button > Open Definition of This Test….
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To set properties of vector data

Select the Type of FREQ parameter to Vector.
Select the Unit of Properties to Hz.
Click the Dimension… button and set Dim1Max (3 for this example).
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To set vector data using Define vector data 
window

Click the Grid button to open the Define vector data window. Enter a vector data (1 MHz, 2 MHz, 
3MHz) for this example.
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To read vector data using the at() function in 
the classic test

Click the Test Contents tab.
Select the Cgg-Vg line.
Click the Measurement Setup tab and set the Frequency List using the at() functions.
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In This Module

• What is Test Definition

• What is Test Contents

• To Open Test Definition Editor

• To Define Test Specification

• To Define Test Contents

• Available Elements

• Available Variables

This section explains how to create your test definition.  You will perform the above tasks to create 
the definition.
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What is Test Definition

Test Specification Test Output

Test Contents

•Test name
•Test description
•Variables

•Entry fields

•Variables

•Test result display

•Local variables
•Test execution flow
•Test setup

•Device parameters
•Test parameters

•X-Y graph
•Data list
•Parameter display

•Classic test
•Application test
•My Favorite setup

•Analysis parameters

Test definition consists of test specification, test contents, and test output setup.  The test 
specification contains test name, description, device parameters, and test parameters.  The parameters 
will be the variables used to pass the test conditions to the test execution flow or test setup defined in 
the test contents.  Especially for the test parameters, you can specify the position of entry field for 
each parameter.  You can see the entry fields when the main screen displays this application test 
setup.  The test contents are the core of the test definition.  You will define the local variables, test 
execution flow, and test setup.  You can define the test setup by selecting application tests, classic 
tests, or my favorite setup, and entering the test conditions.  
The test output setup is optional.  If you have the following requirements, declare the analysis 
parameters and define the display parameters on the Test Output tab screen.  See “To Define Test 
Output” in Module 9.
-To send the test data to the subsequent tests
-To make the program branching depends on the test data
-To display/record the calculation result using the test data 
-To display/record the test data of this application test
You can use the device parameters, test parameters, and analysis parameters in the test execution 
flow (program flow) of the test contents without declaration of local variables.
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What is Test Contents

Variables
•Device parameters
•Test parameters

Variables
•Analysis parameters

Local variables

Program Component

Application Test

Classic Test

Analysis

Miscellaneous

Test OutputTest Specification

My Favorite

Test contents are the test execution flow (program flow), and is the core of the test definition.  In the 
test contents, the following elements can be defined.
•Local variables
•Program components
•Application tests
•Classic tests
•My Favorite setup
•Analysis components
•Miscellaneous components
•Device parameters defined in the test specification
•Test parameters defined in the test specification
•Analysis parameters defined in the test output
The program is executed from top to bottom in the test execution program list.
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To Open Test Definition Editor

Define New Test…

To start test definition, open the test definition editor.
Select the Application Test tab, click the Library button, and select the Define New Test… function.  
The test definition editor will be opened.  See next slide.
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To Define Test Specification

Set test information

Define device parameters

Set properties 
of parameter

The test definition editor provides three tabs, Test Specification, Test Contents, and Test Output.  At 
first define the test specification.  Click the Test Specification tab.
In the Test Information area:
•Click the right button in the Category field to specify the category the new test definition belongs.
•Enter the Test Name.
•Select the Icon that will be displayed on the list area below the Library button of the main screen.  It 
is the image file used to select the test definition.  See previous slide.
•Enter the Description of the test.
In the Device Parameters Definition area:
•Click Add button to display the entry fields for the parameter.
•Set the Name, Default value, and Description for the parameter. When you add a parameter, you 
will see the entry fields at the Properties area.  The area shows you the properties (minimum value, 
maximum value, number of effective digits, resolution, and unit) for the device parameter or the test 
parameter specified by the radio button put on the left of the parameter name.
For the Typical Values… button and the Symbols… button, see online help or User’s Guide.
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To Define Test Specification

Define test parameters

Set properties 
of parameter

In the Test Parameters Definition area:
•Select the Background that will be displayed on the application test setup area of the main screen.  
Usually it is the image that shows the device connections.
•Set the Name, data type, Default value, and Description for the parameter.  When you add a 
parameter, you will see the entry fields at the Properties area. The area shows you the properties 
(minimum value, maximum value, number of effective digits, resolution, and unit) for the device 
parameter or the test parameter specified by the radio button put on the left of the parameter name.
•Set the X, Y, and Width values to specify the position of entry field displayed on the application test 
setup area.  
•Check the Align box to set the X origin of entry field to the left edge of the entry field.  Uncheck 
this box to set it to the left edge of the parameter name placed left next to the entry field.
•Check the Ext box.  The entry field will be put on the Extended Test Parameters dialog box that is 
displayed by clicking the Extended Setup button on the application test setup area of the main screen. 
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Setup example
Test Specification

This example sets:
Category: Exercise (This category may be created by the class exercise in Module 9)
Test Name: Trng idvd idvg
Icon: MOSFET.bmp
Device parameters:

Hold and Delay
Background: Vth_Const_Id.PNG
Test parameters:

Drain, Gate, Source, Subs, Idcomp, Igcomp
IdVd_V1start, IdVd_V1step, IdVd_V1stop, IdVd_V2start, IdVd_V2step, IdVd_V2nop
IdVg_V1start, IdVg_V1stop, IdVg_V1step, IdVg_Vdrain
Vsource, Vsubs

Entry field properties: 80 (width) x 30 (distance in vertical direction)
Press the Layout… button to open the Define Layout dialog box.
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To Define Layout of Test Parameter Entry 
Fields

Primary Entry Field

The Define Layout dialog box is used to define the layout of the test parameter entry fields displayed 
on the application test setup screen.
The following methods are available for selecting the entry fields.
•Click on the entry field. Multiple entry fields can be selected by clicking on the entry field while 
holding down the Ctrl key on the keyboard.
•Drag the mouse to draw a rectangle around multiple entry fields.
•Select Select All from the EDIT menu to select all entry fields.
The selected entry fields are outlined by the blue rectangles. The primary entry field, which is the 
base for layout operations, is surrounded by a highlighted blue rectangle. Only one primary entry 
field can be selected. To change the primary entry field, click on a selected entry field. The entry 
field is always that was most recently  clicked will be the primary entry field.
The following methods are available for releasing (unselecting) the selected entry fields.
•Click the selected entry field while holding down the Shift key on the keyboard.
•Click outside of the selected entry fields to release all selected entry fields.
The following methods are available for defining the layout of the selected entry fields.
•Drag & drop with the mouse to move the selected entry field(s).
•Change the X/Y values in the property window to move the selected  entry field(s).
•Press the arrow keys on the keyboard to move the selected entry field(s).
•Use the functions in the Align menu to align the selected entry field(s) to the primary entry field.
•Use the functions in the Distribute menu to evenly distribute the selected entry fields horizontally or 
vertically.
•Use the functions in the Centralize menu to move the horizontal or vertical center of all selected 
entry fields to the horizontal or vertical center of the entry field area.
For more information, see online help or User’s Guide.
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Result example
Parameter entry fields

This is a result example of the test specification setup shown in the previous pages.



Module 10
Creating Your Test Definitions

10-11

To Define Test Contents

Select available element

Specify the line 
to insert 
element or edit

Click available 
button

Define the setup necessary 
for the highlighted element

Define the test contents as shown below:
•Click the Test Contents tab.
•Click the Local Variable Definition line to highlight the line. The right open space displays the 
Local Variables Definition statement setup editor.
•Define the local variables used in this test execution flow (program flow).
•Click the line that an element has to be inserted.
•Click an element of Program Component, Application Test, Analysis, Classic Test, or Miscellaneous 
tab menu.
•Click the Insert button of the Edit tab menu.  The element will be inserted between the highlighted 
line and the next line.
•Repeat this to create the test execution flow.
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Available elements

Program Component

Application Test

Analysis

Classic Test

Miscellaneous

My Favorite

Available elements are shown above.  The Program Component provides the typical program 
statements such as IF, LOOP, FOR, and so on.  They are used to control the test execution flow.  The 
Application Test, Classic Test, and My Favorite are used to define the test setup/test condition.  The 
Analysis provides the elements used to control auto analysis function and data display.  And the 
Miscellaneous provides other useful elements.  For details of elements, see online help or user’s 
guide.
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Available variables

Test Specification
•Device parameters
•Test parameters

Test Output
•Analysis parameters You can connect the 

variables in test setup with
•Local variables
•Device parameters
•Test parameters
•Analysis parameters 

Test Contents
•Local variables

Assign to external variables…

Do not set the same name 
for variables and 
parameters.  The name 
must be unique.

In the test execution flow (program flow), you can use the following variables.
•Variables defined by the Local Variables Definition component
•Device parameters defined in the Test Specification
•Test parameters defined in the Test Specification
•Analysis parameters defined in the Test Output
You may want to read the parameters/variables used in Classic Test setup or Application Test setup 
defined in the Test Contents.  Then use the External Variables Setup dialog box or built-in functions.  
They can connect the test setup internal variables/parameters to the external variables listed above.  
For the example variable connections, see “To Use Test Setup Internal Variables” in Module 9.
Note
Application test internal parameter/variable to be connected to an external variable must be the 
analysis parameter in its test definition.
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Defining local variables
Local Variables Definition

Add Numeric Variable button displays the Numeric Variable area that provides the following fields.
•Name: Numeric variable name
•Value: Initial value of the variable
•Description: Additional information for the variable
Add Vector Variable button displays the Vector Variable area that provides the following fields.
•Name: Vector variable name. Two dimensional array.
•Count: Number of elements, or array size
•Description: Additional information for the variable
This area also provides the following radio button used to specify how to set the initial value of the 
array data automatically.
• Assign Linear Values FROM [value of first element] TO [value of last element]
If Count>1, this sets first value + (N-1) x (last value-first value)/(Count-1) to the N-th element. If 
Count=1, this sets first value(=last value) to the element.
• Assign Linear Values FROM [value of first element] STEP [step value]
This sets first value + (N-1) x step to the N-th element.
Add String Variable button displays the String Variable area that provides the following fields.
•Name: String variable name
•Value: Initial value of the variable
•Description: Additional information for the variable
Add Module Variable button displays the Module Variable area that provides the following fields.
•Name: Module variable name
•Description: Additional information for the variable
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Editing test contents

•Block Selection
•Insert
•Delete
•Copy
•Cut
•Paste 

The Edit tab provides the following buttons:
•Block Selection/Line Selection toggle button selects the edit target selection mode.  In the line 
selection mode, clicking line just selects the line.  In the block selection mode, clicking line selects 
the block the line belongs.
•Insert button inserts the specified element between the highlighted line and the next line.
•Delete button deletes the highlighted line.
•Copy button copies the highlighted line to the clipboard.
•Cut button moves the highlighted line to the clipboard.
•Paste button inserts the line in the clipboard between the highlighted line and the next line.
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Debug menu

•Run
•Abort
•Stop
•Break
•Inspect 

The Debug tab menu provides the following buttons:
•Run button starts the debug (executes the test flow).  During execution, the label changes to Pause.  
Clicking Pause button pauses the execution, and changes the label to Run that is used to continue the 
debug (execution).
•Abort button aborts the debug (execution).
•Step button executes the highlighted line of the test flow.  Clicking the button repeatedly continues 
the execution by a line.
•Break button sets/releases the break point.  For the break point, this button releases the break point 
from the highlighted line.  Program execution will break at the break point automatically.
•Inspect button is available when the debug (execution) is paused or broken.  This button opens the 
Variable Inspector used to monitor value of device parameters, test parameters, analysis parameters, 
local variables, or system variables.
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Class Exercise

Create test definition and perform test.

1. Open test definition editor.

2. Define Test Specification (see previous page)

3. Define Test Contents shown below.

4. Save the definition as Trng idvd idvg.

5. Use debug tools to check the definition.

6. Connect device, and perform test.

SMU4

SMU2

SMU1

SMU3

Test Contents:
Local Variables Definition

BLOCK
IDVD
Message
IF Yes=0

END
END IF
GMMAX

END BLOCK



Module 10
Creating Your Test Definitions

10-18

Test Definition Example

variables

Use IDVD and GMMAX in the Demo preset group (My Favorite Setup) for the test setup.

Use the variables defined in the Test Specification to set the Unit on the Channel Setup, the source 
values on the Measurement Setup, the Min and Max values on the Display Setup, and so on.

For the example definition, open the Trng idvd idvg definition stored in the ¥data folder on the 
Manual CD-ROM.  The Manual CD-ROM stores the example test setup and definition data used in 
this manual.
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Measurement Result Example

This is a test result example displayed on the Data Display window.
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In This Module

• To Control External GPIB Devices

• To Call Execution Files

• To Perform Repeat Measurements

• Prober Control Script
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To Control External GPIB Devices
Miscellaneous: GPIB I/O

Write String to send a string command to GPIB device

Write Value to send a command to GPIB device

Read String to read a string value from GPIB device

Read Value to read a numeric value data from GPIB device

Read List to read a vector data from GPIB device

Read STB to read status byte of GPIB device

GP-IB Control Group Execution Trigger

Device Clear

Go To Local

Local LockOut

You can control external GPIB devices from the EasyEXPERT by using the GPIB I/O statement.  
The GPIB I/O statement provides the write/read functions shown above.  Select a write function and 
enter the necessary parameters to send a command to the GPIB device.  Select a read function and 
enter the necessary parameters to read response from the GPIB device.  For details, see online help or 
User’s Guide.
The followings are the GPIB Control functions.
•Group Execution Trigger: Sends a trigger to the specified GPIB device.
•Device Clear: Sends a device clear to the specified GPIB device.
•Go To Local: Returns the specified GPIB device to the local state.
•Local LockOut: Locks the specified GPIB device.
Note:
Before starting, enable System Controller.  See Module 12.  Also establish the GPIB connection with 
the external GPIB devices.
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To Control External GPIB Devices
Agilent B2200 control example

To send command

Value 1
Value 2
Value 3
Value 4

{0}
{1}
{2}
{3}

Programming image:

*RST
:ROUT:FUNC ACON
(enters “SMU1” to StringPort)
:ROUT:SYMB:PORT {0},”{1}”
:ROUT:SYMB:PORT? {0}
(reads string data)
*OPC?
(reads operation complete flag)
(enters “OUT1” to StringCh)
:ROUT:SYMB:CHAN {0},{2},”{1}”
:ROUT:SYMB:CHAN? {0},{2}
(reads string data)
*OPC?
(reads operation complete flag)

This slide shows an example setup of the GPIB I/O statement.  This is a component of the test 
contents used to control the Agilent B2200 switching matrix.
This example uses the Write Value function to send the following command to the B2200.
:ROUT:SYMB:CHAN {0},{2},”{1}”
where, {0} is CardNo, {1} is StringCh, and {2} is ChanNo.
The followings are the reference of the setup editor.
•Address: GPIB address of the device
•Terminator: EOI, LF, CR/LF, LF+EOI, CR/LF+EOI, or NONE (no terminator)
•Format: Command (header and parameters) sent to the device
•Value 1: Value for {0}
•Value 2: Value for {1}
•Value 3: Value for {2}
•Value 4: Value for {3}
{0}. {1}, {2}, and {3} are variable available in the Format field only.
Note:
Use double quotes to enter a string to a local variable by using the Assign statement.
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To Control External GPIB Devices
Agilent B2200 control example

To read data

Programming image:

*RST
:ROUT:FUNC ACON
(enters “SMU1” to StringPort)
:ROUT:SYMB:PORT {0},”{1}”
:ROUT:SYMB:PORT? {0}
(reads string data)
*OPC?
(reads operation complete flag)
(enters “OUT1” to StringCh)
:ROUT:SYMB:CHAN {0},{2},”{1}”
:ROUT:SYMB:CHAN? {0},{2}
(reads string data)
*OPC?
(reads operation complete flag)

This example uses the Read String function to read the response from the B2200.  This example 
reads the :ROUT:SYMB:CHAN? query command response.  The result (ReturnCh value) must be 
OUT1.
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To Call Execution Files
Miscellaneous: Command Execution

Specifies variables used to receive execution 
results or output data.  This area is deleted 
by Read Type: None.

Specifies vector variable  or 
string sent to the exe file.

You can call the execution file (EXE file) from the EasyEXPERT.  Use the Command Execution 
statement and define the setup editor as shown in this example.
•Command Filename:  Execution file name (command name)
•Argument:  Command parameter or argument
•Write Type:  String or List (vector data)
•Read Type:  String, Value (numeric data), List (vector data), or None (no read data)
If you specify Write String, enter the string sent to the command.
If you specify Write List, enter the name of vector variable sent to the command, and specify the 
format of data element sent to the command.  See next slide.
In the Read String/Value/List area, specify the variables used to receive execution result and output 
data.  There is no entry field for Read Type: None.
•Result:  Numeric variable name.  Used to store the execution result.
•Value:  Numeric variable name for Read Value, or vector variable name for Read List.  Used to 
store the returned data.
•String:  String variable name.  Used to store the returned data.
•Length Actually Read:  Numeric variable name.  Used to store the byte length of the returned data.
The above example calls the sleep.exe file used to insert the wait time for program execution.  The 
WAIT value must be defined in msec.  After the normal command execution, the sleep.exe returns 1 
for Value and 0 for Result.  The sleep.exe file is stored in the following folder.
C:¥Program Files¥Agilent¥B1500A¥EasyEXPERT¥Utilities
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To set Format field

{I[,A][:F]}
• I List data index.  Or index of element.  Integer.

• [,A] Character length of the specified data element.
Positive integer for right-aligned, or negative
integer for left-aligned.  Optional.

• [:F] Format identifier.  C, D, E, F, G, N, P, R, or X. 
Lower case is available.  Optional.

Example: 
{0,5:E} First element, 5 characters, exponential notation.
{1:G} Second element, general.
{2,10} Third element, 10 characters, general.

The Format field is used to specify the data format of List (vector variable).  The strings shown in the 
above example can be defined in the Format field.
In the strings, the list data index is mandatory.  The character length and format identifier are 
omissible.  Then the length is not limited, and the format G is set.
C or c:  Circulation
D or d:  Decimal numeral
E or e:  Exponential notation
F or f:  Fixed point
G or g:  General
N or n:  Numeric
P or p:  Percent
R or r:  Round trip
X or x:  Hexadecimal numeral
For the format, see online help or manual of the Agilent T&M Programmers Toolkit.
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Exercise 12

Try to improve your test definition as you want.

• To Use Built-in Functions

• To Use Read Out Functions

• To Control External GPIB Devices

• To Call Execution Files
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To Perform Repeat Measurements

If Abort is clicked

No

Start (Run)

Start Procedure

Yes

Iteration Procedure

Final Procedure

End

Test Execution

Yes

No

status= 0 ?

No

Yes

Count < limit

status= 0 ?

Count=Count+1

Count=0

A

C:¥Program Files¥Agilent¥B1500¥EasyEXPERT

C:¥Program Files¥Agilent¥B1500¥EasyEXPERT

C:¥Program Files¥Agilent¥B1500¥EasyEXPERT

Abort5     

status limit

Repeat measurement is performed as shown in this flowchart.  The status is a response returned by 
the start/iteration procedure.  The Count is the accumulated number of test executions.  They are the 
stop condition of the repeat measurement.
The repeat measurement stop function is enabled by the following check boxes.
•Counter reaching to
•Procedure return condition
If the first box is checked and the limit value is specified, the repeat measurement will be stopped if 
Count >= limit.  To perform the repeat measurement, set the limit value more than the number of 
devices under test or remove check from this box.
If the second box is checked, the repeat measurement will be stopped if status is not 0.
When the second box is checked, the device ID automatic setup function is available and is 
enabled/disabled by using the following check box.  The function enters the device_id value to the 
Device ID of the test result record.  The device_id is a response returned by the start/iteration/subsite
procedure.
•Automatically fill in Device ID
The Repeat Measurement Setup dialog box provides the following action buttons.
•Run: Starts repeat measurement.
•Abort: Stops repeat measurement immediately.
•Cancel: Closes the Repeat Measurement Setup dialog box.
Start/Iteration/Final Procedure:
Enter the full path name of the procedure.  For example, enter as follows.
C:¥Program Files¥Agilent¥B1500¥EasyEXPERT¥Utilities¥ProberControl¥suss¥Start_suss.exe

Arguments:
Enter the options of the procedure.  See the following pages describing about procedures.  For 
example, enter –a GPIB0::5::INSTR –l C:¥temp¥prb.log.
If you use the sub die move operation (subsite procedure), the flowchart must be changed.  See page 
11-18.
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Subsite move Test Setup

Select

Specify ProberType.
Or specify driver for your prober in 
CustomProber.

Save

If you do not use the sub die (subsite) move operation, skip this page.
Click Application Test tab and open the Subsite move test setup in the Utility category.  On the 
Subsite move setup screen, specify ProberType (Cascade, Suss, or Vector) or driver for your prober 
in CustomerProber, and save it as a setup in your preset group (My Favorite Setup).  Then you can 
use the setup for your quick test.  See next page.
The Subsite move setup moves wafer chuck to the next subsite, reads device ID from the prober, and 
sets it to the Device ID of the test result record. 
For more details of the test setup, open the Test Definition window.
In the Subsite move test definition, an execution file callProbeDvr.exe is used.  This file is used to 
send Subsite_xxxx.exe to the prober specified by the prober_info.ini file and receive the response; 
status and device_id.  The callProberDvr.exe has the following input/output parameters.
Input: Full path of Subsite_xxxx.exe
Output: status; 0 (no error) or 1 (error)
Output: device_id
Note:
The callProberDvr.exe refers to the prober_info.ini file for the GPIB address and log file name.  Do 
not set the Arguments of Subsite_xxxx.exe.
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To Use Subsite move
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If you do not use the sub die (subsite) move operation, skip this page.
To perform the test with the sub die move operation, do as follows.
1. Add the Subsite move test setup to your preset group (My Favorite setup).
2. Set your preset group and test setups in the Quick Test tab screen.
3. Open the Repeat Measurement Setup dialog box.
4. Specify the procedures and the repeat measurement condition.
5. Start repeat measurement.
The Subsite move setup must be entered after measurements for a sub die.
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Prober Control Script
• Prober information file

prober_info.ini

• Start Procedure
Start_xxxx.exe

• Iteration Procedure 
Iterator_xxxx.exe

• Final Procedure 
Final_xxxx.exe

• Subsite Procedure

Subsite_xxxx.exe

xxxx: • cascade

• suss

• vector

Use prober control script in EasyEXPERT
Repeat Measurement Setup window

Prober control script is sample program used for semi-automatic prober control. The Agilent 
EasyEXPERT can call the script by using the Repeat Measurement Setup window.
See page 11-9 to call the script and perform repeat measurement.
See page 11-14 for the prober information file.
See page 11-13 for the start procedure.
See page 11-15 for the iteration procedure.
See page 11-16 for the final procedure. 
See page 11-17 for the subsite procedure.
To use the prober control script, specify the start/iteration/final procedure in the Repeat Measurement 
Setup dialog box (see page 11-9).  And use the Subsite move test setup in your quick test to control 
sub die move.  The Subsite move setup uses the subsite procedure for moving wafer chuck to the 
next subsite.  See page 11-10 and 11-11.
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Start_xxxx.exe
• Arguments: -a GPIB_address

-l log_file_name
Example:
–a GPIB0::5::INSTR –l C:¥temp¥prb.log

• Response: XML format data

status: 0 (no error) or 1
device_id: prefix:coordinate

Example:

<Response>
<Break>status</Break>
<Target>device_id</Target>

</Response>

<Response>
<Break>0</Break>
<Target>waf1a:3 1</Target>

</Response>

Start

End

Displays Device ID Entry dialog box 

Moves to the first position

Gets X-Y coordinate

Chuck up

Returns response

Updates prober_info.ini file

Displays Start Confirmation dialog box

Yes

No

Yes
Prober error?

No

Prober error?

B

To specify the start procedure in the Repeat Measurement Setup dialog box, enter the full path name 
of Start_xxxx.exe into the Start Procedure field.
After the repeat measurement is started, this procedure displays the Device ID Entry dialog box and 
waits for your input.  On the dialog box, enter a string used for the prefix of device_id.  After that, 
you will see the Start Confirmation dialog box that is used to confirm your wafer setup status.  Load 
wafer and perform wafer alignment, then click OK on the dialog box.  The procedure moves wafer 
chuck to the first probing position, checks the prober status, gets the X-Y coordinate of the probing 
position, and sets the wafer chuck to the UP position.  At last, the procedure returns the response.
The status is 0 or 1.  It is used for the EasyEXPERT repeat measurement stop function.  When the 
Procedure return condition box is checked in the Repeat Measurement Setup dialog box, the repeat 
measurement will be stopped if status is not 0.
The device_id is a string for the Device ID of the test result record.  When the Automatically fill in 
Device ID box is checked in the Repeat Measurement Setup dialog box, the device_id will be entered 
to the Device ID of the test result record.
If you use the subsite procedure, the flowchart must be changed.  See page 11-18.
Note:
To ignore the Arguments, set the GPIB address and log file name in the prober_info.ini.
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Prober_info.ini

[Prober]
Address=GPIB::5::INSTR  
LogMode=True
LogName=C:¥temp¥prb.log

[Target]
UseID=True
SubsiteInfo=False
WaferInfo=False
ID=waf1a

<Response>
<Break>0</Break>  
<Target>waf1a:4 1</Target>

</Response>

device_id = prefix:coordinate

GPIB address of prober

Full path name of log file

Prefix you enter in the Device ID Entry dialog box.
ID is automatically recorded in the prober_info.ini file. 
The Device ID Entry dialog box is opened by Start_xxxx.exe.

The prober information file is necessary to execute the prober control script.  Before starting tests, 
open this file, edit it as you want, and overwrite it.  The name must be prober_info.ini.
The prober_info.ini file stores the information shown below.
•Address: GPIB address of prober
•LogMode: Log file creation mode; True or False
•LogName: Log file name (full path)
•UseID: Device ID creation mode; True or False
•SubsiteInfo: Set always False. This is just a place holder.
•WaferInfo: Set always False. This is just a place holder.
•ID: Ignore this variable. This is just a pass parameter.
If the procedures specify the –a option, the Address value is not used.
If the procedures specify the –l option, the LogName value is not used. 
To create a log file, set LogMode=True.
To use the prefix:coordinate format for the device_id value, set UseID=True.  If UseID=False, the 
device_id value will be coordinate, not prefix:coordinate.  The prefix will be the value entered in the 
Device ID Entry dialog box that is opened by Start_xxxx.exe.  This function is available when the 
Automatically fill in Device ID check box is checked.
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Iterator_xxxx.exe
• Arguments: -a GPIB_address

-l log_file_name
Example:
–a GPIB0::5::INSTR –l C:¥temp¥prb.log

• Response: XML format data

status: 0 (no error) or 1
device_id: prefix:coordinate

Example:

<Response>
<Break>status</Break>
<Target>device_id</Target>

</Response>

<Response>
<Break>0</Break>
<Target>waf1a:4 1</Target>

</Response>

Start

End

Chuck down

Moves to the next position

Chuck up

Returns response

Yes

Yes
Prober error?

No

Prober error?

Yes

No

Prober error?

Gets X-Y coordinate
No

B

To specify the iteration procedure in the Repeat Measurement Setup dialog box, enter the full path 
name of Iterator_xxxx.exe into the Iteration Procedure field. 
The procedure is called after the measurement is completed for a die.  This procedure sets wafer 
chuck to the DOWN position, moves it to the next probing position, checks the prober status, gets the 
X-Y coordinate of the probing position, and sets the wafer chuck to the UP position.  At last, the 
procedure returns the response.
The status is 0 or 1.  It is used for the EasyEXPERT repeat measurement stop function. When the 
Procedure return condition box is checked in the Repeat Measurement Setup dialog box, the repeat 
measurement will be stopped if status is not 0.
The device_id is a string for the Device ID of the test result record.  When the Automatically fill in 
Device ID box is checked in the Repeat Measurement Setup dialog box, the device_id will be entered 
to the Device ID of the test result record.
If you use the subsite procedure, the flowchart must be changed.  See page 11-18.
Note:
To ignore the Arguments, set the GPIB address and log file name in the prober_info.ini.
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Final_xxxx.exe

Start

End

Chuck down

• Arguments: -a GPIB_address
-l log_file_name

Example:
–a GPIB0::5::INSTR –l C:¥temp¥prb.log

• Response: none

C:¥Program Files¥Agilent¥B1500¥EasyEXP
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5Stop condition

To specify the final procedure on the Repeat Measurement Setup dialog box, enter the full path name 
of Final_xxxx.exe into the Final Procedure field.
The procedure is called after one of the stop condition is detected.  This procedure sets wafer chuck 
to the DOWN position.
Note:
To ignore the Arguments, set the GPIB address and log file name in the prober_info.ini.
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Subsite_xxxx.exe
Start

End

Chuck down

Moves to the next subsite

Chuck up

Returns response

YesProber error?

Yes

No

Prober error?

Gets X-Y coordinate
No

• Arguments: -a GPIB_address
-l log_file_name

Example:
–a GPIB0::5::INSTR –l C:¥temp¥prb.log

• Response: XML format data

status: 0 (no error) or 1
device_id: prefix:coordinate

Example:

<Response>
<Break>status</Break>
<Target>device_id</Target>

</Response>

<Response>
<Break>0</Break>
<Target>waf1a:3 1</Target>

</Response>

To realize sub die move operation, you need to define Subsite_xxxx.exe in your test definition and 
create your application test setup.  However, you do not need to take care of this procedure by using 
the Subsite move test setup included in the application library. The Subsite move setup moves wafer 
chuck to the next subsite, reads device ID from the prober, and sets it to the Device ID of the test 
result record.
Open the Subsite move test setup and save it as a setup in your preset group (My Favorite Setup).  
Then you can use the setup for your quick test.  
Note:
To use the Subsite move setup, set the GPIB address and log file name in the prober_info.ini.  And 
ignore the Arguments for Subsite_xxxx.exe.
Note:
If you use a Suss prober, the number of Subsite move setups used in your quick test (die test) is 
important.  It must be N-1; N is the number of subsites defined in the prober.
The status is 0 or 1.  It is used for the EasyEXPERT repeat measurement stop function.  When the 
Procedure return condition box is checked in the Repeat Measurement Setup dialog box, the repeat 
measurement will be stopped if status is not 0.
The device_id is a string for the Device ID of the test result record. 
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To Change Execution Flow

A
Subsite Procedure

Yes No
status= 0 ?

Test Execution

B Move to the 1st subsite

If you use the subsite procedure, change the flowchart as follows.
On the page 11-9, replace the box A with the block A shown above.
On the page 11-13 and 11-15, insert the box B shown above to the position B of the flowchart.
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In This Module

• Function Status Indicators

• Automatic Data Export and Data Record

• Data Record ON/OFF

• Calibration

• Configuration

• XSLT Filters

• To Enable System Controller

• To Start Desktop EasyEXPERT

• To Use 415x Setup File Converter

This module describes the above topics.  You will understand what is the status indicator, what is the 
automatic data export function and the automatic data record function, what is the Data Record 
ON/OFF, how to perform selftest and calibration, how to perform SMU zero offset cancel, and so on.



Module 12
Miscellaneous Operations

12-3

Function Status Indicators

Automatic data export OFF

Automatic data record ON

ON

ON

OFF

SMU zero offset cancel OFF

ONStandby function OFF

Status indicators let you know the status OFF or ON of the following functions.  The indicators are 
placed at the bottom of the main screen.
Standby function OFF/ON: Shows the status of the Standby function OFF or ON.
SMU Zero OFF/ON: Shows the status of the SMU zero offset cancel function OFF or ON.
Auto EXPORT OFF/ON: Shows the status of the automatic data export function OFF or ON.
Auto Record ON/OFF:  Shows the status of the automatic data record ON or OFF.
The functions can be set to ON or OFF as shown in the following pages.
For the Standby function, see Module 7.
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Automatic Data Export and Data Record

The automatic data export function and the automatic data record function can be enabled or disabled 
by using the Test Results Data Auto Export dialog box.  This dialog box is displayed by selecting the 
Results > Transport Data > Auto Export Setting… menu.
The automatic data export function is used to export the test result data to the storage device you 
specify.  You can specify the destination (storage device), exported file name, and file type.  To set 
the automatic data export function to ON, check the Enable automatic data export to the specified 
storage device check box.
The automatic data record function is used to save the test result data to the internal HDD 
automatically.  This function can be disabled (set to OFF) if the automatic data export function is 
enabled (set to ON).  To set the automatic data record function to OFF, uncheck the Enable automatic 
data record to the internal storage device check box.
For more information, see online help or User’s Guide.
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Data Record ON/OFF

Data Record ON/OFF toggle button changes the status of the automatic data record function and the 
automatic data export function. It will also display the present data record status (Data Record ON or 
Data Record OFF).

The Data Record ON is the default measurement mode of the B1500A.
If the status is changed to Data Record OFF, both automatic data record function and automatic data 
export function are set to OFF. If a measurement is performed in this state, a button will appear to the 
right side of this toggle button. Clicking the button will save the last measurement data as a test result 
record. Data Record OFF is high speed measurement mode without automatic data record and 
automatic data export and is useful for probe contact check, defect analysis, and so on.
If the status is changed to Data Record ON, both automatic data record function and automatic data 
export function are returned to their previous state which is the state before the data record status was 
changed from Data Record ON to Data Record OFF.
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SMU Calibration Calibration

The Calibration window is opened by clicking the Calibration button. The SMU calibration screen of 
this window is used to perform the calibration of SMUs.  The list area of this screen lists Name, Full 
Range, and Status.
Name: Name of module. To select, check the left check box.
Full Range: For the high resolution SMU (HRSMU) connected to the atto sense/switch unit (ASU). 
Full range calibration on or off.
Status: Calibration status. Pass or fail.
Notes: Error information when calibration failed.
To perform the self-calibration, specify the modules, open the measurement terminals of the 
corresponding modules, and click the Start Calibration button.
Full Range Calibration:
For the HRSMU connected to the ASU. Enables or disables the full range calibration. If this box has 
been unchecked, the B1500 does not use the 1 pA range.
Enable Auto Calibration:
Enables or disables the auto-calibration capability. If this box has been checked (function ON), and 
the B1500 automatically starts calibration for all modules every 30 minutes if the output switches of 
all modules are off for 30 minutes.
NOTE:
To perform calibration correctly, open the measurement terminals.  If auto-calibration is enabled, do 
not forget to open the measurement terminals or disconnect the device under test from the terminals 
after measurement.
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SMU Zero Cancel

1

2

3

Calibration

The SMU Zero Cancel screen is used to perform the SMU zero offset current measurement and set 
the SMU zero offset cancel function.
This function subtracts the offset current from the current measurement raw data, and returns the 
result as the measurement data.  This function is used to compensate the error factor (offset current) 
caused by the measurement path such as the measurement cables, manipulators, or probe card.
To enable this function, perform the following procedure.
1.Check the left box of the Name column to specify the module to enable this function.
2.Click the Measure… button to perform the zero offset current measurement and wait until the 
measurement is completed.  The measurement data will be displayed in the appropriate cell.
3.Click the Close button to enable the zero offset cancel function.
To disable the function, uncheck the left box of the Name column, and click the Close button.
Note:
The offset cancel is not available for measurement over 100 nA range.  For 10 nA range 
measurement, the offset cancel is performed by using the 1 nA range offset value.  For measurement 
by a range less than 10 nA, the offset value measured by each range is used.
For more information, see online help or User’s Guide.
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CMU Calibration Calibration

The CMU Calibration screen is used to perform the measurement data correction of the multi 
frequency capacitance measurement unit (MFCMU).  For the easy way, perform the phase 
compensation and the open correction at least.  The check boxes left of the Open/Short/Load 
Correction and the Phase Compensation are effective after the corresponding measurement is 
performed.
Measure…: Opens a dialog box used to perform correction/compensation data measurement.  To 
perform the measurement, follow the dialog box.
Advanced Options…: Opens the “Advanced Options for CMU Calibration” dialog box used to set 
the frequencies for the correction data measurement and the reference values of the working 
standard.  See the next page.
To perform the open correction and the phase compensation, open the measurement terminals.
To perform the short correction, connect the measurement terminals together.
To perform the load correction, connect your load standard between the high terminal and the low 
terminal.
NOTE:
For a more accurate measurement, perform Open/Short/Load correction at the measurement 
frequency before starting the capacitance measurement.
If the measurement frequency is not included in the list of default frequencies below, click the 
Advanced Options... button and set the measurement frequency on the Frequency area of the 
Advanced Options for CMU Calibration window.
Default frequencies:
1 k, 2 k, 5 k, 10 k, 20 k, 50 k, 100 k, 200 k, 500 k, 1 M, 1.2 M, 1.5 M, 2 M, 2.5 M, 2.7 M, 3 M, 3.2 
M, 3.5 M, 3.7 M, 4 M, 4.2 M, 4.5 M, 5 MHz
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Advanced Options for CMU Calibration

This dialog box is opened by clicking the Advanced Options... button, and is used to set the 
information required to measure the open/short/load correction data and the phase compensation 
data. This dialog box provides the following action button.
OK: Applies the setup changes and closes this dialog box.
Cancel: Cancel the setup changes and closes this dialog box.
Frequency: You can select the measurement frequency setup mode from the following modes.
Measurement frequency setup modes:
Default (Use factory specified frequencies): Usually, select this mode. 23 points are automatically 
set. They are 1 k, 2 k, 5 k, 10 k, 20 k, 50 k, 100 k, 200 k, 500 k, 1 M, 1.2 M, 1.5 M, 2 M, 2.5 M, 2.7 
M, 3 M, 3.2 M, 3.5 M, 3.7 M, 4 M, 4.2 M, 4.5 M, and 5 MHz.
Specifies by list: Select this mode when you want to set the frequencies independently. The 
frequency must be 1 kHz to 5 MHz. The number of frequencies must be 1 to 101.  Click Add to open 
a dialog box, and enter the value.  For the unnecessary value, highlight the value and click Delete.
Specifies by range: Select this mode when you want to set the frequencies sequentially and 
automatically.  Specify the start frequency, the stop frequency, the number of steps, and the scale 
LINEAR/LOG. The start frequency must be less than the Stop value and at least 1 kHz. The stop 
frequency must be more than the Start value and no more than 5 MHz. The number of steps must be 
2 to 1001.
NOTE:
If the device measurement frequency is not equal to the correction data measurement frequency, 
calculation will be performed automatically to get the correction data for the device measurement 
frequency, and the calculated correction data will be used for the data correction of the measurement 
data.
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Advanced Options for CMU Calibration

Integration Time area defines the integration time used for measuring phase compensation data or 
open/short/load correction data.  The number of averaging samples (Mode=AUTO) or the averaging 
time (Mode=PLC) is set.
Mode: A/D converter operation mode, AUTO or PLC.
Factor: Factor for the initial value.  For details, see online help or user’s guide.
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Advanced Options for CMU Calibration

Reference Standard Values area provides the following entry fields used to set the reference values 
of the open/short/load standard.  If you use the standard, enter the reference values to the entry fields.
OPEN Reference: Capacitance and Conductance.  If you do not use the reference, enter 0 in the both 
fields.
SHORT Reference: Inductance and Resistance.  If you do not use the reference, enter 0 in the both 
fields.
LOAD Reference: Inductance and Resistance
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Main Frame Configuration

The Configuration window is opened by clicking the Configuration button, and is used to display the 
system information and event log, as well as to perform diagnostics and self-test.
The Main Frame screen is used to display the system information and perform diagnostics.
Model Identification: Displays the instrument ID. B1500A.
Line Frequency: Sets the power line frequency, 50 Hz or 60 Hz.
EasyEXPERT Rev.: Displays the revision number of the EasyEXPERT.
Firmware Rev.: Displays the revision number of the B1500 firmware.
Main Frame Diagnosis: This area lists Item and Status.
Item: Name of diagnostics item. To select, check the left check box.
Status: Diagnostics status. Pass or fail.
To perform diagnostics, specify the items to perform and click the Start Diagnosis button.  A dialog 
box is opened.  Follow the dialog box to perform the diagnostics.  Some items need your judgement, 
pass or fail.  Also you will need to connect an adapter, press keys, check LEDs, and so on.
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Modules Configuration

The Modules screen is used to perform self-test of modules.
Slot: Slot number where the module is installed. To select, check the left check box.
Module Type: Module model number
Name: Module name
Status: Self-test status, Passed, Failed, Recovered, or ---- (self-test has not been performed)
SCUU: Specifies if the module is connected to the SCUU.
Notes: Error information when the module self-test failed.
To perform self-test, specify the modules, open the measurement terminals of the corresponding 
modules, and click the Start Self Test button.
Recover Module button is for the service use only.  This button makes the failed modules respond 
again.  This button does not solve the problem that causes the Failed status.
Status LED: Enables (ON) or disables (OFF) the status indicator (LED) of the ASU (Atto Sense and 
Switch Unit) and the SCUU (SMU CMU Unify Unit).
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Switching Matrix Configuration

The Switching Matrix screen is used to establish the GPIB connection with Agilent B2200A/B2201A
switching matrix and define the B2200A/B2201A input port connections.
Switching Matrix Type: Displays the type of the switching matrix.  B2200A Femto Leakage Switch 
Mainframe, B2201A 14ch Low Leakage Switch Mainframe, or No Switching Matrix.
GPIB Address: Specifies the GPIB address of the B2200A/B2201A. 1 to 30.
Poll: Confirms if the B2200A/B2201A with the specified GPIB Address is connected to the B1500A.
Start Self Test: This button starts the B2200A/B2201A selftest.
SWM IN: SWM IN1 to SWM IN14 mean the B2200A/B2201A input ports 1 to 14 respectively.
Enter the label used to specify the input port to the right entry field.  The port name and the 
connected module name can be the label. : (colon) cannot be used.
If the Kelvin check box is checked, the coupled even number port is grayed out.
If the CMU check box is checked, the SWM IN14 is grayed out.
Kelvin: Check this box if this port is used for the Kelvin connection.
CMU: To perform capacitance measurement, check this check box and set SWM IN13 to 
CMU1:MF.  And connect MFCMU to B2200A/B2201A Input 13 and 14. To perform capacitance 
compensation, see User’s Guide.
Extended Configuration: This button opens the Extended Configuration dialog box.
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Extended Configuration Configuration

This dialog box is opened by clicking the Extended Configuration button in the Configuration 
window Switching Matrix screen.
Save as Hardware Profile is used to save the hardware profile that is the B2200A/B2201A hardware 
configuration and the measurement module connection.  Click the Save button to save the present 
hardware profile.  The hardware profile can be made for each workspace individually.
CMU Compensation is used to select the compensation mode of the capacitance measurement using 
the B2200A/B2201A.  Click one of the radio buttons, No Compensation, Select, and User 
Compensation.  For the capacitance compensation, see User’s Guide.
• No Compensation:
Select this radio button if you do not need the capacitance compensation. The raw data without 
compensation is displayed and saved.
• Select:
Select this radio button to perform the capacitance compensation for the path from the 
B2200A/B2201A input ports to Agilent 16495F/G connector plate or Agilent B2220A probe card 
interface. The data after compensation is displayed and saved.
DUT I/F field is used to specify the model number of the path you use.  The selections are the 
16495F/G and B2220A.
Cable field is used to specify the model number of the cable from the B2200A/B2201A output to the 
DUT I/F.  The selections are the 16494A/B/C-001/002/005.  This mode cannot perform the 
capacitance compensation for the cables to positioner/manipulator or the probe card.
• User Compensation Data File:
Select this radio button to perform the capacitance compensation for the path from the 
B2200A/B2201A input ports to the end of positioner/manipulator or probe card.  See User’s Guide.  
The data after compensation is displayed and saved.
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Event Log Configuration

The Event Log screen displays the event log.
Date/Time: Displays date and time of the event.
Message: Event message
ID: Process ID of the event
Process: Process name
User: User name. Windows login name.
Host: Host name of the B1500
The Refresh button refreshes the event log.
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ASU Configuration

The ASU screen is available if the B1500A installs the HRSMU connected to the ASU (Atto 
Sense/Switch Unit), and shows the ASU information.
Slot: Slot number
Module Type: Type of module
Name: Module name or SMU name
ASU Serial Number: Serial number of the ASU connected to the HRSMU. This cell does not show 
the serial number if no ASU is connected or unpaired ASU is connected.
ASU I/O Path: ASU input to output connection, SMU or AUX
If the ASU I/O Path field is set to SMU, the ASU makes the path from the ASU Force input to the 
ASU output.
If the ASU I/O Path field is set to AUX, the ASU performs automatic switching in every test. The 
ASU makes the path from the AUX In input to the ASU output for the test without the HRSMU and 
makes the path from the ASU Force input to the ASU output for the test with the HRSMU.
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XSLT Filters

Highlight this line

Click this button

The XSLT (XSL-Transformation, eXtensible Stylesheet Language Transformation) filter files are 
used to export test records. The fifteen filter files listed below are stored in the 
C:¥Program Files¥Agilent¥B1500¥EasyEXPERT¥Utilities¥XSLT folder.
Filter files that contain csv in the file name export test record in the format that uses a comma (,) as 
data separator. 
Filter files that contain tab-sv in the file name export test record in the format that uses a tab as data 
separator. 
Filter files that contain xmlss in the file name export test record in the XML Spread Sheet format. 
Three filter files for exporting the measurement data only
meas-csv.xsl, meas-tab-sv.xsl, meas-xmlss.xsl
Three filter files for exporting the measurement data with the index
meas-index-csv.xsl, meas-index-tab-sv.xsl, meas-index-xmlss.xsl
Three filter files for exporting the measurement data with the meta data
meas-meta-csv.xsl, meas-meta-tab-sv.xsl, meas-meta-xmlss.xsl
The meta data contains the test name, the setup name, the record time of the test results, the device 
ID, the counter number, the flag of the test results, and the remarks on the test results.
Three filter files for exporting the measurement data with the index and the meta data
meas-index-meta-csv.xsl, meas-index-meta-tab-sv.xsl, meas-index-meta-xmlss.xsl
Three filter files for exporting all data including the test setup
csv.xsl, tab-sv.xsl, xmlss.xs
For more information, see online help or User’s Guide.
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To Enable System Controller
Agilent IO Library Connection Expert

To control external GPIB devices, the B1500A must be set to system controller.  Exit the EasyEXPERT, and 
close the Start EasyEXPERT window.  After that, launch the Agilent Connection Expert by clicking Start, All 
Programs, Agilent IO Library Suite, and Agilent connection Expert.
On the Agilent Connection Expert, change the GPIB configuration of the B1500A.
•Select GPIB0.
•Click Change Properties… button.
•Change GPIB address to 21 that is the typical address number for the system controller.
•Check System controller box.
•Click OK button.
•Reboot the B1500A.
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To Start Desktop EasyEXPERT

Database Backup Creation Wizard
Database Restoration Wizard

¥Documents and Settings¥All Users¥Application Data¥Agilent Technologies, Inc¥EasyEXPERT¥UnitConfigB1500A.xml

Important:
To set the same configuration as the B1500A, 
copy the following file from B1500A to your PC. 
The location must be the same.

To open the Start EasyEXPERT window, click Start > Programs > Start EasyEXPERT menu.  The 
Option menu provides the functions used to open the following dialog box.
Gpib Configuration:
Select Online if the B1500A is connected to your computer and you want to control the B1500A via 
GPIB.  Or else select Offline.
Database Backup Creation Wizard:
Use this function to create the EasyEXPERT database backup (xdb file).
Database Restoration Wizard:
Use this function to restore the EasyEXPERT database backup.  The wizard can restore the xdb file 
or the backup which is a copy of the folder that contains the EasyEXPERT database.
EasyEXPERT Database:
Specify the EasyEXPERT Database path if you want to move the database to the other folder.
After that, click the Start EasyEXPERT button to launch Desktop EasyEXPERT.
Note:
Desktop EasyEXPERT supports most B1500A/EasyEXPERT functions.  However, some functions 
are not supported on an external computers due to differences in hardware and so on.
Note:
For the installation procedure, see the readme file stored in the Desktop EasyEXPERT CD-ROM.
Note:
To use the same module configuration as the B1500A, copy the UnitConfigB1500A.xml file to your 
PC which the Desktop EasyEXPERT runs.  The file is stored in the B1500A hard disk drive.  The 
location is shown in the slide.  The file must be copied to the same location in your PC.
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415x Setup File Converter

4155/4156 setup file
(file extension: MES)

B1500A setup file
(file extension: XTS)

Execution example:
C:¥Mydata>SetupFileConverter.exe setup1.mes
C:¥Mydata>SetupFileConverter.exe *.mes

SetupFileConverter.exe Import

To control the B1500A, you can reuse the 4155/4156 setup file (.MES file) by converting the .MES 
file to the EasyEXPERT setup file (.XTS file).  The file conversion can be done by the 
SetupFileConverter.exe file.  To execute the file conversion, see Module 12.
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To Use Setup File Converter

To convert the 4155/4156 setup file (.MES file) to the EasyEXPERT setup file (.XTS file), use 
SetupFileConverter.exe, and perform the following procedure. The SetupFileConverter.exe file is 
stored in the following folder.
C:¥Program Files¥Agilent¥B1500A¥EasyEXPERT¥Utilities
1.Create your working folder (for example, C:¥415xdata).
2.Copy your .MES files to this folder.
3.Copy SetupFileConverter.exe file to this folder.
4.Launch the DOS Prompt window.
5.Go to your working folder (for example, C:¥> cd 415xdata).
6.Execute SetupFileConverter.exe as shown below.
Example:
C:¥415xdata> SetupFileConverter.exe *.MES
All .MES files in your working folder will be converted to the EasyEXPERT setup file format.  And 
the .XTS files will be created in this folder.
If you do not specify the parameter, help message will be displayed by executing the file.  For more 
information, see the setup converter readme file, online help, or User’s Guide.
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